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Introduction
The topics in this section give information about the capabilities of ATOMS, what
information is needed to draw a structure, general procedure for starting up, and a description
of the calculations.
See:
Types of Windows for more information about the windows which are used;
Menus and Dialogs for detailed help on input;
Reference for general topics;
Tutorials for some simple examples of input.

1.1

Capabilities of ATOMS

ATOMS is a program to display atomic structures of all types, including molecules,
polymers and crystals, and combinations of any of these.
If symmetry is used, the coordinates of only one atom of each equivalent set need to be
entered. The symmetry elements for all 230 space groups and 32 crystallographic point
groups are on file and can be called up by number or with their standard symbols. Noncrystallographic symmetry - such as pentagonal or icosahedral - can also be used. An
auxiliary program SYMGRP is provided to derive complete symmetry matrices for any
point group. ATOMS also supports Shubnikov symmetry for illustration of magnetic or
other vectorial aspects of structures.
The boundaries for drawings of crystals and polymers can be specified in several ways.
First, the contents of any given number of unit cells can be shown by setting limits to
translational repetition. Second, any crystal faces, at any distance from the origin, may
form the boundaries. Third, there is an option to show a slice of the structure parallel to a
specified face with thickness equal to the d-spacing. Different boundary levels may be
specified for different atoms if necessary. Fourth, a sphere about any atom or arbitrary
point may be shown. Fifth, all molecules or other bonded units may be identified and
shown in their entirety.
Molecules, polymers or other bonded groups may be isolated (independently of the fifth
boundary option above). The generated atoms may be converted to input atoms, so that
individual atoms may be deleted, removed or otherwise modified without affecting
symmetry- or lattice-equivalent atoms.
Individual structure fragments may be combined to model twinning, epitaxy and
crystalline defects.
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There are several ways of displaying atoms and bonds in the Standard display mode: (1)
spherical atoms and stick or line bonds; (2) line bonds only; (3) interpenetrating spherical
atoms; (4) coordination polyhedra. Any of these types of representation may be
intermixed in a single drawing. The same representations are available in the 3D display
mode. In addition, there is a thermal ellipsoid mode which draws atoms and bonds in the
manner of ORTEP (by Carroll K. Johnson).
Shading, according to angle of illumination, can be automatically applied to atoms, bonds
and polyhedra in the Standard display mode. The 3D display mode, which uses OpenGL
(Windows) or QuickDraw3D (Macintosh) provides additional options for lighting and
material properties. The 3D mode can display thermal ellipsoids in a variety of ways.
The Cavities display mode shows a surface enclosing the possible center locations of a
given-size spherical particle within the unit cell.
The drawing may be shown in strict projection, or in perspective at any given perspective
distance. Exact scales may be specified in terms of inches or centimeters per Angstrom
for the hard-copy output.
Atom labels and bond distances may be automatically added, drawn in proper location for
stereopair views.
Hard copy can be made with dot-matrix printers, laser printers, inkjet printers or pen
plotters. Also, you can write raster or bit-image files in several formats as well as vector
files, for use in other software. Files can also be written in 3D formats (3DMF, VRML).
1.2

Information Needed to Draw a Structure

The first three categories of information listed below are intrinsic to a given structure, and
do not change in the course of a calculation. These categories require very specific data
from some source, if the structure is not theoretical or imaginary. Some sources of
structural information are listed at the end. Categories 4 and 5 are somewhat arbitrary,
but are generally fixed by chemical or geometric considerations. Categories 6 and 7
describe not so much intrinsic information about the structure, as attributes which are
assigned for display purposes.
1. Reference Axes/Coordinate System/Unit-Cell Parameters.
The natural coordinate system for crystals is the crystal axes, which give the length
and direction of the lattice translations. These are specified by as many as three axis
lengths and three interaxial angles (a fourth redundant axis which is frequently used in
hexagonal and trigonal crystals is ignored in ATOMS). The axis types fall into seven
different crystal systems, depending on the constraints of symmetry on the equality in
length of the axes and the interaxial angles. The coordinates of atoms and indices of
face (if present) in the crystal system are eventually converted to coordinates in a
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Cartesian system with a standard orientation (z = c, x = a*; see section IV-6), but
space-group symmetry operations (reproduction of atoms within the unit cell) are
most easily carried out on the original crystal coordinates.
Coordinates of atoms in molecules are usually given in a Cartesian axial system. There
are complications, however, if the molecule has one 3-fold or 6-fold axis of symmetry,
i.e. has trigonal or hexagonal symmetry. The method of symmetry input most
conveniently used for crystals in ATOMS assumes that the reference axes also have
this symmetry (which is not true for Cartesian axes). In this case two alternate
approaches may be taken: (1) choose trigonal or hexagonal "crystal" axes (a1 and a2
axes at 120 degrees, c axis at 90 degrees to a1 and a2) and give fractional atomic
coordinates in terms of these axes (section IV-5.1); or (2) generate Cartesian
symmetry matrices with the program SYMGRP and use Cartesian coordinates.
2. Atom Coordinates.
Any structure must be specified by the locations of the atoms. In the case of crystals,
this is normally done in terms of fractional coordinates on the structure axes. If
symmetry is used, only one atom of each equivalent set need be entered. Atoms may
be grouped by types (e.g. all Si atoms, all C atoms, etc.) to facilitate location of bonds
and polyhedra.
When drawing magnetic or other vector structures, the coordinates or indices of the
vector on each input atom is required.
3. Space- or Point-Group Symmetry.
This describes the way the atoms are repeated by the symmetry operators. The
combinations of symmetry operators fall into a limited number of groups called space
groups for crystals, and point groups for molecules. At a minimum, it is necessary to
know which of these groups the crystal or molecule belongs to. The standard
reference for space groups is the International Tables for X-ray Crystallography,
published by Kluwer (4th edition). All of the 230 space groups are listed by number in
Volume A, or Volume I in older editions (all references to the Tables will assume
Volume I or A), and it is only necessary to give this number, or the standard HermannMaughin (International) or Hall symbol of the space group.
For molecules, ATOMS can also use the data from the Tables to provide the pointgroup symmetry given the standard symbol for the group (either the International
symbol or the Schoenflies symbol), subject to some orientation restrictions, and to the
limitation that the point group is crystallographic, that is that it belongs to one of the
seven crystal systems.
If a structure is described in a crystallographic space- or point group in which the
orientation or choice of origin is non-standard, it is still possible to enter the symmetry
by essentially copying the information in the Tables or other source, provided the
symmetry is described in the standard format.
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Point groups containing n-fold axes with n equal to 5 or larger than 6 are theoretically
possible for molecules or one-dimensional polymers but not crystals. For such cases,
the symmetry must be entered in the form of Cartesian matrices; these matrices, for
any point group, can be prepared with the auxilliary program SYMGRP.
4. Boundaries of the Structure.
For a molecule, it may be presumed that all atoms entered, and usually all those
generated by symmetry, are to be shown in the drawing, although selected individual
atoms can be hidden or "deleted" after generation of the structure (see
Deleting Atoms). Crystals and polymers, however, are ideally infinite structures, in
which the unit cell is repeated by translation in as many as three directions, and some
limitations must be placed on the extent of this repetition by translation. In some
crystals it may be desirable to isolate molecules or other units. There are several
different ways that such limitations can be imposed in ATOMS — see
Boundary Options.
5. Definitions of Bonds and Coordination Polyhedra.
To specify bonds, you only need to give the types of the two atoms involved, and
minimum and maximum bond distances between the two atoms; all bonds with these
specifications are automatically located. These bond specifications can also be derived
automatically from a set of atomic radii. To specify polyhedra, you need to give the
type of the central atom, the coordination number, the types of the coordinating atoms
or ligands, and the maximum distance between central atom and ligands. Normally, all
polyhedra will be identified except incomplete polyhedra, i.e. those in which some of
the atoms are not within the specified structure boundaries. If the coordination number
and/or bond distances are not known, they can be determined with preliminary runs in
which incomplete polyhedra are also accepted.
6. Sizes and Colors of Atoms, Bonds and Polyhedra.
In the Standard display mode, atoms are shown as spheres if they are shown at all; the
radius (in Angstroms) must be specified. Bonds can be represented as single lines, or
as "sticks" or cylinders with a given radius. If atoms interpenetrate, there is no size
parameter, but a bond between the two atoms must be identified (item I-3.5 above) if
the junction is to be handled properly in the Standard display mode (this is not
necessary for the 3D mode). If a color screen display is used, colors may be assigned
to the atoms and bonds according to several schemes. For the dot-matrix plot
(including laser printer) and black-and-white screen displays, different shades of gray,
normally represented by dot-patterns, may be specified for atom or bond colors. For
pen plots, different pen numbers or colors may be specified for different atoms, bond,
and polyhedra.
For drawing in the thermal ellipsoid mode, temperature factors are required for each
atom, although default isotropic values are used if the temperature factors are not
available for a given atom.
© 2002 Shape Sof tware
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7. Orientation, Projection, Scaling.
These things all have defaults, but can be changed after initial input, and it may require
some thought and experimentation to find the best settings. See Coordinate Systems.
The projection may be orthographic (straight down the x-axis) or perspective.
Perspective generally gives the most realistic appearance, while orthographic retains
strict geometric relations and scaling. The drawing may be on some fixed scale (in
inches or centimeters per Angstrom) or expanded automatically to fill the plotting
area.
Sources of Structure Information. The two principal journals for crystal and molecular
structure information are Acta Crystallographica and Zeitschrift fur Kristallographie,
although many other chemical, biological and mineralogical journals publish structure
determinations. Structure information is periodically summarized in Structure Reports.
Most of the important structures are described by R.G. Wyckoff, in Crystal Structures (7
Volumes).
There are many sources of structure data in the form of computer files. See the
Import Files option in the File menu for details on the formats supported by ATOMS.
1.3

Starting Up

When ATOMS is started, you see the Startup Window, which has buttons for the usual
ways to input data. The same choices are in the File menu. There is a choice of starting
a new file (New), opening an old file (Open), or importing a file (Import File). Also, a
list of files recently worked on is shown in the File menu - single-clicking on one of these
will open the file.
When you double-click on an ATOMS data file (.STR file) instead of the program icon
the file is read in and you see a message box giving you the choice of calculating the
structure or cancelling (see below).
The first time you run ATOMS you may want to check the dialogs in the Settings menu,
especially the Preferences dialog. If you intend to use a pen plotter [Windows only], you
should select the Pen Plotter Settings command, and verify or change the settings as
needed. Likewise, you many need to change or verify the PostScript Settings.
Opening a sample file or an old structure file. You can read in one of the sample files (in
the SAMPLES sub-directory) or folder, using the Open command or the most-recentlyused list in the File menu. Alternatively, when ATOMS is not active, you can double click
on one of the ATOMS data files (.STR files).
Entering a new structure. You can enter a new structure with the New item in the File
menu. This will step automatically through all the categories of information necessary.
Between each of the main dialogs in this sequence there will come a dialog titled "Enter
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New Data Set". This dialog gives you a chance to back up to the last dialog completed,
or to abort the New data entry. You can cause this dialog to be omitted with Preferences
in the Settings menu.
The first part of the input is commands in the Input1 menu. The first three categories,
Title/Axes, Symmetry, and Boundary, are all mandatory. The next three categories,
Crystal Forms, Atoms, Polyhedra and Bonds are optional, although all structure
drawings must have either atoms or a crystal shape (forms). If the data entry is aborted
during this first sequence, the entire file is abandoned.
At this point, you have the option of stepping through the remaining items, which are
from the Input2 menu and mostly control the way the structure is displayed, or of
accepting default values. (You can cause the current values and settings in the Input2
menu to be used as the defaults with the Save Defaults item in the Settings menu.) The
data entry can be aborted at any point during this sequence and the new data set will be
preserved.
Importing a file. This refers to files from other software. New formats are frequently
added, so see on-line help for details.
After an old ATOMS data set or an import file has been read in or a new data set entered,
you are asked if you want to "..calculate now". If you reply Yes, the structure is
calculated and should appear in the Graphics window in a short time. If you reply No, the
Graphics window is blank when it opens; you can then modify the data for the structure
or the display parameters using the menus and dialogs, as described in Chapter III. When
corrections or additions have been made, use the Calculate command in the File menu.
While the structure is plotting in other than the 3D display mode, pressing any key will
temporarily halt the plot. Pressing Escape will then abort the plot, while any other key
will continue the plot. The plot cannot be halted if double-buffering is in effect
(Preferences dialog, Settings menu).
The Calculate command in the File menu and the Replot command in the Display menu
are two of the most important and frequently-used in ATOMS. Calculate constructs
crystal faces for boundaries (if used), reproduces atoms with symmetry and lattice
translations, identifies atoms in bonds and polyhedra, and then plots the structure in the
Graphics window. You must use this command if you change anything which determines
the number and location of atoms, or the atoms involved in bonds and polyhedra. This
includes many parameters in the dialogs of the Input1 menu, although there are are also
some parameters, such as atom, polyhedron and bond colors and atom and bond radii,
whose changes do not require recalculation. Replot simply redraws the structure without
changing the lists of atoms, polyhedra or bonds. Changes in any of the parameters in the
dialogs of the Input2 menu can be put into effect with Replot.
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The Calculate and Replot commands are also in the Dialog Bar - Left, which are both
controlled in the Display menu.
1.4

Description of the Calculations

It is impossible to give a complete description of the calculation methods, but some
account of the procedures should be helpful to guide the use of the program.
Locating Atoms, Bonds, Polyhedra and Vectors
If crystallographic symmetry is present, symmetry operations in the form given in the
International Tables for X-ray Crystallography are converted to matrices. For noncrystallographic symmetry (e.g. pentagonal, icosahedral) the matrices, generated by the
auxilliary program SYMGRP, are read in directly. The atom coordinates are multiplied by
these matrices, and translations are added if there are screw axes or glide planes in the
space group, to find all the atoms in the unit cell or molecule. The coordinates of the
atoms are then converted to a Cartesian system if necessary.
If the structure is a molecule, then no further location of atoms is necessary, but for
polymers or crystals, the lattice translations must be applied, subject to one of several
types of boundary. In some cases, especially for polymers, it may be sufficient to take all
atoms in unit cells related to the initial one by specified numbers of lattice translations in
each of the three crystal or polymer axis directions — one or two of the translations may
be disabled, leading to two- or one-dimensional polymers, respectively.
For crystals a more general and powerful method of determining the structure boundaries
is by means of crystal faces. The crystal faces are specified by their standard MillerBravais indices (the reciprocals of the intercepts on the three crystal axes), and by a
central distance, which is the perpendicular distance from the center of coordinates to the
face. If the crystal has symmetry, this can used in specifying faces; i.e. only one face of
each symmetry-equivalent set, or form, need be entered. Symmetry equivalents of the
faces are derived similar to that used for atoms. However, if desired the symmetry used in
the generation of faces can be lower than that used in the generation of atoms.
A special case of boundary faces is a slice, which is a slab of the structure bounded by a
given face and its negative, with a thickness determined by the crystallographic
interplanar or d-spacing — the limits to the extent of the structure in the two dimensions
parallel to the given face are arbitrary and may be specified.
To identify the the corners and edges defined by the crystal faces, all possible
intersections of triplets of faces are located; those which are further from the center than
any face are rejected as crystal corners. Edges are defined by pairs of corners which have
two faces in common.
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Atoms within the specified face boundaries are simply those which are not at a positive
distance from any face. Starting with atoms in the central unit cell (fractional coordinates
0 to 1), lattice translations are added or subtracted until all possible atoms have been
tested for inclusion. The algorithm which does this is rather complex, as finding the
starting and ending unit-cell limits for the atoms search in the general case of face
boundaries is not trivial.
If coordination polyhedra are to be shown, the atoms involved must be located. ATOMS
will identify all polyhedra consisting of specified types of ligands within a given distance
of a central atom. The ligand atom locations (points) form the corners of opaque
polyhedra. Edges and faces of each polyhedron must be identified, which requires some
rather complex calculations. Because of possible variation in coordination number, data
on corners, edges and faces of polyhedra must be packed into special arrays, and
unpacked each time they are used.
In the Thermal Ellipsoids mode, at the start of the calculation the temperature factors for
each input atom are converted to the principal axes of a thermal ellipsoid. During
generation of the atoms within boundaries, the number of the symmetry matrix used is
saved, to be used later in plotting.
If atomic vectors are present, they are represented by pseudo-atoms (at the ends of the
vectors) and by pseudo-bonds. This simplifies the geometric relations for plotting in
Non-3D modes. These pseudo-atoms and pseudo-bonds are generated in a special loop.
The atom locations, identity of bonds and data on polyhedra if present, constitute a
"permanent'' set of parameters for each structure. The atom coordinates may be rotated in
any of several ways to obtain a suitable view.
Plotting - Non-3D Modes
Whenever a drawing is made for the screen, dot-matrix plotter or pen plotter, the actual
elements which appear in the drawing, that is arcs of circles representing spherical atoms
and lines representing bonds and polyhedra, must be recalculated, since their
interrelations depend on the viewing angle. Each polyhedron must be examined to classify
edges as to whether they are front, back or boundary.
For screen or dot-matrix drawings, the procedure is somewhat simplified since it is
possible to blank out or draw over elements which lie underneath others. The atoms,
polyhedra and bonds are sorted according to their height, or distance from the viewer.
The elements are then plotted in sequence from the most distant to the nearest. Atoms are
represented in the sorting process by their centers, bonds by their midpoints, and
polyhedra by the central atom. This sorting process is a simplification of the true
relationships, and conceivably could lead to error, but only if the bonds are unusually
long. In fact the drawing method relies on displaying only normal chemical bonds, not
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arbitrary connections between atoms. If desired, atom labels are drawn during the
process of plotting atoms from back to front.
If crystal edges are also shown, the "back'' edges, i.e. those that would be invisible in an
opaque crystal, are plotted before the atoms, bonds, etc., and the "front'' edges are
plotted after. Sorting the crystal edges is not practicable because of their length. There is
no attempt to solve for interpenetration relations of edges with atoms, bonds or
polyhedra and errors will usually result if the edges are not completely outside the
structure.
For pen plots actual blanking or overlaying is impossible, and it is necessary when
drawing a given element to consider every other element which lies higher (closer to the
observer), find all the possible intersections and remove the segments which are obscured.
Insofar as possible, intersections of structure elements (bonds and atoms, polyhedra) are
considered as intersections of two-dimensional figures (circles, lines, ellipses), rather than
computing the intersections in three dimensions and then finding the projections. One
approximation which is made here is to represent ellipses (which only arise as junctions of
atoms and stick bonds, and junctions of interpenetrating atoms, and thus cannot overlie
other elements) by means of line segments for purposes of locating intersections; they are
actually drawn as ellipses, but slight errors in locations of intersections involving ellipses
may occasionally result.
For perspective drawings, the atom locations (and crystal corners if present) are projected
from a given perspective distance onto a plane passing through the center of the
structure. Overlay relationships with other elements (for pen plots) are then determined
on the basis of circular projections for spherical atoms, again making calculations in two
dimensions as much as possible. This is not true perspective, but the difference is not
likely to be noticed unfavorably in the normal case. In fact, when true perspective is used
and the drawing is viewed at other than the (scaled) perspective distance specified in
making the projection, the distortion of the projected atom shapes from circles can be
very disturbing - this can be verified in the 3D display mode.
For shading of atoms, the given illumination vector and the number of shading zones are
used to set up outlines for each zone, consisting of circle and ellipse segments. The angle
with the illumination vector gives a shade for each zone. The zones need to be set up
only once for a given illumination vector, since all atoms are identical except for scaling
by the radius. Zones can also be set up for stick bonds, but since the bonds make various
angles with the illumination vector, the shade can only be determined at plot time. For
polyhedra, the shade of each face is determined at plot time.
In the Thermal Ellipsoid mode, at plot time, atoms are sorted and plotted from back to
front as for ball-and-stick, but as each atom is drawn the principal axes are transformed
using the appropriate symmetry matrix, and the ellipsoid is drawn. Bonds are located in
the same way as for standard ball-and-stick, but because the algorithm for finding the
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intersection of stick bonds with ellipsoids is completely different from that used for
spheres, thermal ellipsoids and ball-and-stick cannot be intermixed.
Atomic vectors, which are represented as pseudo-bonds, are in fact drawn much like
normal bonds, except that cones (arrowheads) are substituted for the atom on the positive
end of the vector (if it is two-ended) for all types of display and output aside from pen
plots.
The Anaglyph display mode is a very special case. Because each view is drawn in only
one color, it is not necessary to sort objects from back to front, and rotations (for
example) may be even faster than the similar skeletal mode.
Plotting - 3D Modes.
In this type of drawing, the surfaces of three dimensional objects such as spheres and
cylinders are converted to an assemblage of planar polygons. Then each polygon is
drawn essentially independently pixel by pixel. The critical difference with non-3D modes
is that a depth buffer is used in 3D imaging. This is an array of integers, one for each
pixel in the display or output (or that portion which is currently being drawn, when
banding is being used). Each element, representing a pixel, holds the relative x
coordinate (in the ATOMS observer coordinate system - this is more often the z-axis and
the buffer may be called the z-buffer) of the foremost object or polygon. The color for
this object is retained in the color buffer, which is a similar array representing pixels; this
array is actually the image itself. Whenever a polygon is drawn, each pixel which it
contains is compared against the depth buffer; if the x coordinate of the pixel is greater,
or closer to the observer than what is in that element of the depth buffer, the color for this
pixel in the new polygon replaces the value in the color buffer. That is, the depth buffer
keeps track of the front surface of the drawing, and ensures that only this front surface
(not any hidden surfaces) are kept in the color buffer or image itself.
Typically, each corner of each polygon is assigned a vector normal, which is not the same
as the normal to the polygon itself. For example for a sphere the normals are simply
directed from the center outward through the corners of the polygons (triangles). Color
is assigned to each corner according to the light equation (see 3D Lighting in the Input2
Menu), and interpolating between the corners at each pixel gives a smooth curved
appearance, rather than a collection of flat polyhedra.
When translucency is in effect, it is necessary to blend the color of a new object with
what is already in the color buffer. It is normally necessary to plot translucent objects in
sequence from back to front, although opaque objects in the same drawing do not have to
be sorted. Translucency always requires increased plotting time.
The "double buffer" method is normally used, the "color buffer" being kept in an area of
memory and then copied to the screen memory when the drawing is completed. This is
usually faster than drawing directly to the screen.
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The standard display mode of ATOMS does not use a depth buffer: the atoms, bonds and
polyhedra are sorted from back to front and drawn in that order. When necessary, the
intersections of objects are solved analytically and only the required portions of each are
drawn.
Using a depth buffer has the advantages that it is not necessary to solve analytically for
intersections, nor to sort the objects with respect to depth. This may save considerable
time, especially for complex drawings, since the time for sorting tends to increase
exponentially with the number of objects. Since analytical solution of intersections is not
necessary, it is possible to place essentially any objects into the drawing. in any location.
This overcomes the problem in ATOMS non-3D drawing modes of sometimes-incorrect
drawing of crystal edges or unit-cell edges which intersect with atoms, bonds and
polyhedra. The 3D method allows more complex shading and lighting effects, such as
specular highlights and multiple light sources. It also allows translucent objects. For a
completely 3-dimensional image, on a computer which has sufficient memory, the 3D
display mode is superior to the ATOMS Standard display mode.
Without special hardware for 3D drawing, it is about as fast as fully-shaded Standard
display mode drawing with about 16 shading zones.
However, there are disadvantages to the 3D method. The depth buffer may result in
excessive memory requirements even for the screen (but some 3D accelerator cards may
have special memory for the depth buffer). The 3D method is not very suitable for blackand-white drawings, which typically are simplified, showing mutual intersections of atoms
with bonds and polyhedra as lines or curves; such intersections simply are not drawn in
the 3D method. Both Windows and Macintosh implementations currently have some
severe limitations in terms of printing. It is necessary to draw each image into a bitmap
and then copy that bitmap to the printer. Because printers have much higher resolution
than the screen, this causes even higher memory requirements, and for reasonable sized
printed drawings it is usually necessary to do the printing in bands or segments.
ATOMS itself uses "Immediate mode" to draw atoms, bonds, etc. - that is, it draws each
object and then discards the memory associated with that object. On the other hand,
many 3D applications, especially the standard viewers for VRML and 3DMF files, use
"Retained mode". In this mode every vertex of every object is read into memory before
drawing. This allows simple drawings to be redrawn and rotated rapidly, but it may take
a long time to load large drawings initiallyand uses enormous amounts of memory
(typically 16 MB for 300 atoms in a ball-and-stick model).
3D files (VRML, and 3DMF for Macintosh) contain the locations and material properties
(especially color) of such common objects as spheres, cylinders, disks and lines, and their
orientation where appropriate. Polyhedra are represented as assemblages of polygons.
The viewers for these files then use methods similar to those used by ATOMS to draw
the objects. As explained in the previous paragraph, beware of viewers using Retained
mode - they may crash or take forever to draw a complex crystal or molecular structure.
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Types of Windows used in ATOMS
ATOMS uses four types of windows besides dialogs and alerts: the Startup window; the
main Graphics window; secondary (Powder and Precession) Graphics windows; and
Text windows. Each type of window has its own menu bar. The Help system also has its
own windows and menus.
Note that under the Windows operating system the ATOMS windows are not confined
to reside within a framework window, as in pre-V6.0 ATOMS.
All the current windows are listed in the Windows menu, and this menu can be used to
switch between windows if some are not visible.
When starting up ATOMS, the menus displayed in the Startup window include only a
File menu, a Settings menu and a Help menu. Use the commands in the File menu to
start a new ATOMS data set, read an old one from a file, or import data from a file with
an external format.
After you have entered or read in the data for an ATOMS file, the main Graphics window
opens and the Startup window disappears; if you have elected not to Calculate, the
Graphics window may be blank, otherwise it will show the current ATOMS drawing.
Only one data set at a time is allowed in ATOMS, and there is only one main Graphics
window. When this window is active, there is a File menu and various other specialized
menus such as Input1 for data input and modification and graphics output.
The secondary Graphics windows appear only when you have selected
Powder Diffraction (Graph Option) or Precession Pattern from the Display menu.
These windows have their own menu bars, with only a File menu, a Windows menu and a
Help menu. When a secondary window is active, output, such as Print, Raster File, etc.
in the File menu, is for the Diffraction results, not the atomic structure in the main
Graphics window.
The File menu of the main Graphics window has four commands, List Input, List
Generated Atoms, List Generated Faces and List Totals, each of which lists the
relevant data to a separate Text window. When any of these Text windows is active, the
menu bar contains standard menus for saving, printing and editing the contents. Each
window actually displays the contents of a file, called respectively INPUT.ATD,
GENATOMS.ATD, FACES.ATD and TOTALS.ATD. These files are written over
again for each new ATOMS data set, so if they are to be preserved they should be saved
with the Save As command in the File menu, using a different name.
A Text window is also generated when Calculation Output is selected in the Input2
menu. The output is written to the file infile.ATD, where infile (.STR) is the name of the
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ATOMS data file. Similarly, the Coordination button in the Input Atoms dialog of the
Input1 menu writes a file called BONDS.ATD, and the Powder Diffraction (List option)
dialog writes output to the file LIST.ATD. The List Coords button in the
Cavity Parameters dialog lists the fractional coordinates of all grid points which can
accomodate the sphere of the specified Particle radius in the file CAVVAL.ATD.
Secondary Graphics windows and Text windows are "children" of the main Graphics
window, since their contents pertain only to the current structure, and they are destroyed
if the main Graphics window is closed.
An output Text window or a diffraction Graphic window may sometimes come up behind
the main Graphics window. If the new window is invisible, use the Window menu to
bring it to the front.
2.1

Startup Window

This window appears when ATOMS is first started, or when a data set (Graphics
Window) is closed.
The structure image at the bottom of this window is from a file called default.png. You
may save a new version of this file (Raster option, File menu) - the image should be about
300 pixels wide by 200 pixels high.
It has its own menu bar Startup Menu Bar, and the following buttons for getting a data
file into ATOMS.
New - Step-by-step input of a new ATOMS data set.
Open - Open an old ATOMS data file.
Import File - Shows a pop-up menu with the file types currently supported. This
includes:
----------------------------------

CCDC FDAT files from the Cambridge Crystallographic Data Centre.
SHELX.INS files from the program system of Prof. G. Sheldrick.
CIF - Crystallographic Information Files.
DBWS/LHPM Rietveld input files.
ICSD Inorganic Crystal Structure Database files.
ORTEP Original or ORTEP II atom information.
XTLVIEW Drawing program.
VIBRAT (.MOT) Graphic output files from VIBRATZ.
PDB Protein Data Bank files.
RIETAN Rietveld program files.
GSAS Data files (.EXP) files from the Los Alamos Lab system - may include
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magnetic vectors.
---- AM MINERAL. Data files from the American Mineralogist structure data base.
---- FULLPROF. All-purpose refinement program - may include magnetic vectors.
---- Free-form (.inp). This allows input of atomic coordinates and other information
from almost any source.
Exit/Quit - Quit the ATOMS program.
2.2

Graphics Window

This is the main window which shows the current structure drawing. When it is active,
most menus are available, allowing modification of the data and other operations.
Also, the controls or commands in the Dialog Bar - Left and Dialog Bar - Right are
active (if selected in the Display menu), and they operate on the drawing or on the main
ATOMS data set.
To switch to another window, such as a text window or the Powderor Precessionwindow
(see Types of Windows), click on that window if it is partially visible, or use the
Windows menu.
2.3

Powder Diffractogram Window

This graphics window (see Types of Windows) shows the results from the
Precession Pattern dialog (Display menu). It has its own menus, which essentially allow
only input of a new data set or saving of the current data set, and graphics output of the
Powder diffractogram to the printer or files (EPS, raster, metafiles).
Use the File menu for this window for Print, Raster, PICT or Metafile output.
To access the menus which allow modification of the ATOMS data (and even
recalculation of the Precession Pattern), click on the main Graphics Window if it is
visible, or use the Window menu. The main Graphics Window has the title of the current
ATOMS data file (.STR).
2.4

Precession Pattern Window

This graphics window (see Types of Windows) shows the results from the
Precession Pattern dialog (Display menu). It has its own menus, which essentially allow
only input of a new data set or saving of the current data set, and graphics output of the
Precession Pattern to the printer or files (EPS, raster, metafiles).
Use the File menu for this window for Print, Raster, PICT or Metafile output.
To access the menus which allow modification of the ATOMS data (and even
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recalculation of the Precession Pattern), click on the main Graphics Window if it is
visible, or use the Window menu. The main Graphics Window has the title of the current
ATOMS data file (.STR).
2.5

Text Window

Text windows are generated by several commands (below). When a text window is
active, there is a special menu bar which allows modification and saving of the particular
output file (.ATD) which is being edited - the commands in these menus do not pertain to
the current ATOMS data file. To return to the main Graphics Window for modification,
saving etc. of the ATOMS data file, click on that window if it is visible, or use the
Window menu.
The File menu of the Graphics window has four commands, List Input, List Generated
Atoms, List Generated Faces and List Totals, each of which lists the relevant data to a
separate Text window. When any of these Text windows is active, the menu bar contains
standard menus for saving, printing and editing the contents. Each window actually
displays the contents of a file, called respectively INPUT.ATD, GENATOMS.ATD,
FACES.ATD and TOTALS.ATD. These files are written over again for each new
ATOMS data set, so if they are to be preserved they should be saved with the Save As
command in the File menu, using a different name.
A Text window is also generated when Calculation Output is selected in the Input2
menu. The output is written to the file infile.ATD, where infile (.STR) is the name of the
ATOMS data file. Similarly, the Coordination button in the Input Atoms dialog of the
Input1 menu writes a file called BONDS.ATD, and the Powder Diffraction (List option)
dialog writes output to the file LIST.ATD.

3

ATOMS Menus and Dialogs
ATOMS Menu Bars
Startup Menu Bar - This menu bar appears when starting ATOMS, or when all
windows (Graphics or Text) have been closed.
Graphics Window Menu Bar - This is the main menu bar for entry, alteration and
display of atomic structure data sets.
Text WindowMenu Bar - This menu bar is used for text windows produced by the
Listings group in the File menu of the Graphics window, and by the Calculation Output
command in the Input2 Menu, or by the Powder Diffraction listing option. The Text
window is a more-or-less standard edit window.
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Startup Menu Bar

File menu - Use the commands in this menu to start a new ATOMS data set, open a file
for an old data set, or import a data set from a data base.
Settings menu - This contains settings for hardware, palettes and preferences for modes
of operation.
Help menu - On-line help
3.1.1

File Menu (Startup Window)

To start up ATOMS, you must select either New to enter an all-new data set; Open to
open a previously-saved ATOMS data file; or Import File to open a data file written by
other software.
New - Step-by-step input of a new ATOMS data set.
Open - Open an old ATOMS data file.
Recent File List (Windows only) - The last four ATOMS data (.str) files can be opened
by selecting here.
Import File - Shows a pop-up menu with the file types currently supported. This
includes:
----CCDC FDAT files from the Cambridge Crystallographic Data Centre.
----SHELX.INS files from the program system of Prof. G. Sheldrick.
----CIF - Crystallographic Information Files.
----DBWS/LHPM Rietveld input files.
----ICSD Inorganic Crystal Structure Database files.
----ORTEP Original or ORTEP II atom information.
----XTLVIEW Drawing program.
----VIBRAT (.MOT) Graphic output files from VIBRATZ.
----PDB Protein Data Bank files.
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----RIETAN Rietveld program files.
----GSAS Data files (.EXP) files from the Los Alamos Lab system - may include
magnetic vectors.
----AM MINERAL. Data files from the American Mineralogist structure data base.
----FULLPROF. All-purpose refinement program - may include magnetic vectors.
----Free Form (.inp). This allows input of atomic coordinates and other information
from almost any source.
Page Setup - Set the page size and select the printer.
Exit/Quit - Quit the ATOMS program.
---------Windows Only -------------------------------

Note that you can also start ATOMS for Windows from the DOS command line, reading
in an ATOMS data file or an import file.
3.1.1.1

New Command

New Command [ File menu (Startup) or File menu (Graphics)]
If there is a data set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.
When you use this command to start a new data set, ATOMS first steps through most of
the dialogs in the Input1 menu, which involve parameters which are considered to be
intrinsic to the structure in question. After you click OK in each dialog, a dialog appears
(Entering New Data) giving you the choice of continuing or aborting the data entry. You
can eliminate this dialog with the Confirmatory alerts checkbox in the Preferences
dialog in the Settings Menu. At the end of the dialogs in the Input1 menu another
dialog appears (End of Mandatory Input) giving you three choices: 1) you can continue
with the non-mandatory part of the input, which consists of the dialogs in the
Input2menu, involving mostly display aspects of the structure; 2) you can stop here and
accept the display parameters currently in memory; or 3) you can read in the default
display parameters from a disk file (the current display parameters can be saved as the
defaults with the Save Defaults command in the Settings menu. If there is no data set in
memory, option 2) will give the default values.
If there is a data set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.
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3.1.1.1.1 Entering New Data Set
Dialog Box: Entering New Data Set [During New input]
This dialog comes up in between the main categories of data during input of a New data
file. Usually you can just click on Continue (or hit Enter), but you can Abort the input,
or Revise the category you have just finished.
The appearance or non-appearance of this dialog is controlled by the Confirmatory
alert... checkbox in the Preferences dialog in the Settings menu.
3.1.1.1.2 End of Mandatory Input
Dialog Box: End of Mandatory Input [During New input]
The mandatory input for a New data file consists of the commands in the Input1 menu,
through the Bonds item, although you do not necessarily have to specify all of them. The
non-mandatory input consists of the display parameters, or most commands in the Input2
menu (3D parameters are omitted). If you elect not to continue with these display items,
the display parameters will be taken from a) a set of default parameters, if you click on
Default or if this is the first file in your current ATOMS session; or b) from the display
parameters of the current file if you click on Quit. You can save the current display
parameters (including mostly parameters in the dialogs of the Input2 menu but also some
from the Display menu) as the default parameters with the Save Defaults command in
the Settings menu.
3.1.1.2

Import Files Submenu

Sub-Menu: Import File [File menu (Startup) or File menu (Graphics)]
This offers a selection of file types to import, including CCDC FDAT, SHELX-93, CIF,
DBWS/LHPM Rietveld, ICSD, ORTEP, XTLVIEW, VIBRAT, PDB, RIETAN, GSAS,
AM MINERAL, FULLPROF and Free-Form.
The boundary option in most cases can either be Default Unit Cell, suboption as selected
with the Default radio button, or Locate Molecules in Crystal.
Multiple occupancies are not permitted in ATOMS, and when more than one atom is
found to be in the same position (same fractional x, y and z coordinates) the second and
subsequent occurences will be deleted.
There is a limit of 500 input atoms in most cases.
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3.1.1.2.1 Import File
Dialog Box: Import File [ File menu (Startup) or File menu (Graphics)]
If there is a data set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.
If there is more than one data set or phase in the file, the Data Sets...in Import File dialog
will present you with a list. The name of the ATOMS data file will be taken from the
name of the file, and the title (Title/Axes dialog in the Input1 Menu) will be taken from
the data set or phase. The extension.STR will be appended to the structure file.
If the Generate bonds box is checked, the Generate Bonds from Atomic Radii dialog
will come up as soon as the file is read in.
Read default display parameters. If this box is checked, the display parameters last
saved (Settings menu) will be read for the new data set.
Read temperature factors. This option may not be available for all types of import file.
In some file formats, such as ICSD RETRIEVE, the temperature factors are in a separate
list from the atomic coordinates. In order to assign the temperature factors to the atoms,
the atom labels in these two lists must match exactly. For this reason, "OH" and "OH2"
in the atom lists in RETRIEVE files are changed to "O", since the labels in the
temperature factor lists use only "O". If you get the message "Temperature factor atom
label not identified", you may need to edit the atom labels in the original file so that the
two lists agree.
File Extension. The three-letter extension (.xxx) which identifies the file type under
Windows (see below for Macintosh) may be specified here - only files of that type will be
shown in the Open File dialog. To show all files, enter ".* ".
Atomic Radii . You can choose standard ionic or covalent radii, which will be multiplied
by the factor in the edit box. For a ball-and-stick drawing, a factor of 0.5 or less is
appropriate. For interpenetrating atoms (space-filling), a factor of greater than 1.0 is
usually necessary. All radii can later be multiplied by a given factor in the Atoms-Global
command in the Input1 menu. The radii, as well as default colors, are obtained from the
selected version of the ELEMENTS file (either ELEMENTS.ION or
ELEMENTS.COV) supplied with ATOMS (these files can be modified by the user).
Boundary Option. The boundary option can either be Default Unit Cell, using the
default suboption selected in that dialog, or Locate Molecules in Crystal. If the
Locate Molecules in Crystal option is used, the Generate bonds box will be considered
to be checked, as bonds (or polymers) must be defined.
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Source of symmetry (some formats lack this option). If you select Use positions as
xyz, in which symmetry operators are given in the form of positions in the general
equipoint as in the International Tables, the symmetry option (Input1 Menu) will be
Custom Symmetry. After import, you may need to check the Symmetry option to be
sure the centric/acentric choice and the Bravais lattice type are correct (some formats
include a center of inversion and/or lattice centerings in the operators and some do not).
If you select Space group symbol, the Space Group symmetry option will be used. The
Hall symbol, the Hermann-Maughin symbol, and then the International Tables number
will be used in that order if present. If you select Use positions as xyz and the
information on operations is not present, the symmetry option will default to Space
group symbol. The H-M space-group symbol, Hall symbol, and space-group number are
always read if present.
If symmetry is present in the "xyz" or operation form, this is usually the safest option
However, this option does not give information on systematic extinctions or true dspacings, which may be required for the Slice boundary option. It is usually possible to
derive the correct space-group symbols from the operations using the Get Symbol option
in the Custom Symmetry dialog.
Atom types (some formats lack this option). ATOMS will try to assign an atomic
number to each input atom either from the first one or two characters of the atom label
itself, or from a separate atom type label if that is present. In diffraction refinement file
formats, this separate atom type label typically identifies the scattering factor, and it it is
your choice whether this or the atom label (if either) will identify the element.
Note that in the case of multiple occupancies for a site, ATOMS ignores all but the first
atom.
For more information about the specific file types, see one of the following
CCDC FDAT
SHELX-93
CIF
DBWS/LHPM Rietveld
ICSD
ORTEP
XTLVIEW
VIBRAT
PDB
RIETAN
GSAS
AM MINERAL
FULLPROF
Free-Form (.inp)
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---- Macintosh only ----

You can show all text files, or only those with the specified extension (.xxx) in the File
Open dialog - make this choice, which applies to most types of files, in the Preferences
dialog in the Settings menu.
-------------------------------

3.1.1.2.2 Data Sets... in Import File
Data Sets...in Import File [ Import File Command - File menu (Startup) or File menu
(Graphics)]
When you open a CIF, DBWS/LHPM or other type of import file, ATOMS will search
through it to find all the data sets or phases within it, up to a limit. If there is more than
one, this dialog will present you with a list. The name of the ATOMS data file will be
taken from the name of the file, and the title (Title/Axes dialog in the Input Menu) will
be taken from the data set, phase or crystal selected. The extension.STR will be
appended to the structure file.
3.1.1.2.3 Free-Form (.inp) File
Import Free-Form (.inp) File [File menu (Startup) or File menu (Graphics)]
See the Import File dialog for general aspects of importing atomic-structure data files.
This imports files in the free-form format described elsewhere ( Atom Parameter Files ).
Note that this format has been expanded since earlier (pre-V4.1) version of ATOMS, so
that essentially all relevant data for a crystal may be entered.
3.1.1.2.4 CCDC FDAT File
Import CCDC FDAT File [ File menu (Startup) or File menu (Graphics)]
See the Import File dialog for general aspects of importing atomic-structure data files.
Most of the FDAT files have a "connection table" which specifies the bonds defining a
single molecule, while the unit-cell may contain several molecules. Thus the radio
buttons give you a choice of importing the file as a molecule or as a crystal.
When imported as a molecule, the structure will use the No Boundaries (Molecule)
boundary option, and no symmetry. The files normally contain a unique set of input
atoms, which are the same as those required for input of a crystal in ATOMS, plus in
many cases some extra symmetry-derived atoms necessary to complete the molecule; all
these atoms are used as input atoms when importing as a molecule. With the Atomic
radii radio buttons, you can choose to use either the radius values in the CCDC files, or
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those in the ELEMENTS file; in any case, the type number (atomic number), colors and
patterns will be obtained from the ELEMENTS file using the elemental symbol which is
in the first one or two characters of the FDAT atom. The radius values in the CCDC files
typically are covalent radii, slightly smaller than those required for contact of bonded
atoms. For a space-filling or interpenetrating atoms model, they may need to be
increased, and for a ball-and-stick model they may need to be decreased. The radii of all
atoms can be changed by a factor with the Atoms - Global dialog in the Input1 menu. All
bonds between atoms will be the same; the radius, colors and patterns can be defined with
the Define Bonds for Molecule button; this will call up a dialog which is similar to that
which comes up for individual bonds (Bond Data in the Input1 menu); however, atom
types and distance limits are not used and are omitted from this dialog. After calculation,
the radius, colors and patterns can be changed with the Bonds command in the Input1
menu. There will be only one bond type in the list.
Note that importing a CCDC FDAT file as a molecule uses a different procedure from the
Locate Molecules in Crystal boundary option, which is used in most other cases when
importing a crystal structure as molecules. The Locate Molecules in Crystal boundary
option uses the bond and polymer specifications entered in ATOMS to isolate the
molecules, whereas the FDAT files usually already contain the linkage information which
defines molecules. If you wish to use the Locate Molecules in Crystal option, you must
import the FDAT file as a crystal, then change the boundary option.
When imported as a crystal, the structure will use only the unique set of atoms, omitting
the extra ones. The boundary option will be Default Unit Cell, current default suboption.
3.1.1.2.5 SHELX .INS File
Import SHELX.INS-93 File [ File menu (Startup) or File menu (Graphics)]
See the Import File dialog for general aspects of importing atomic-structure data files.
ATOMS is programmed only for SHELX-93 files, although it may also be possible to
read SHELX-76 files.
Atom type numbers from. The Type labels radio button will use the SHELX SFAC
(scattering factor) number which is the number which follows the atomic label and
preceeds the atomic coordinates in the SHELX file. The numbers correlate with elements
through the SFAC instruction, which must be in the SHELX file. These elements will be
used to determine the atomic radii and colors using the ELEMENTS files supplied with
ATOMS (which can be modified by the user). The SHELX atomic radii are not used; if
an element is not in the current ELEMENTS file, the correct radius will not be supplied.
Symmetry. The Custom point or space group option will be used. Typically the true
symbol can be recovered from the title. ATOMS will read the SYMM lines in the
SHELX file only if they are in standard International Tables format - the translational
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part must precede the positional part (i.e. 1/2+x, not x+1/2). If the symmetry was copied
from the Tables, there should be no problem. You can edit the symmetry operators after
they are read in with the Symmetry command in the Input1 menu.
Multiple occupancy of sites. If there is an EXYZ instruction, ATOMS will use only the
first atom - all others will be deleted.
FRAG instruction. Atoms listed between this instruction and the FEND instruction will
be ignored.
RESI instruction. Atoms listed after this instruction will be included, but not treated in
any special way.
Hydrogen atoms. SHELX has several sophisticated ways of locating hydrogen atoms
which are not duplicated by ATOMS. Frequently, the positions of the hydrogen atoms
are not in the.INS file, and must be taken from the output. There are several ways to do
this. First, the output lines giving the hydrogen positions can be copied into the.INS file.
If this is done, a type or SFAC number must be inserted after the label and before the
coordinates. The hydrogen lines can also be put into a separate file and read in with the
SHELX +filename include-file instruction. Second, the hydrogen lines can be put into a
file of their own and read in with the input-file provision of the Input Atoms dialog in the
Input1 menu, after the SHELX.INS file has been imported. Since the label and
coordinates are in the default order, no modification is necessary, and a FIELDS line is
not needed - only the lines with the labels and coordinates (any other fields following on
the same line will be ignored). If you do this, do not check the Generate bonds box.
You can generate bonds after the SHELX and the hydrogen input files have been read in,
with the Bonds dialog in the Input1 menu.
Most of the instructions in a SHELX file will be ignored. However, ATOMS may not
know all the current instructions. If it cannot identify an instruction, it tries to read the
line as an atom line (this is the way SHELX works). If this fails, you are asked if you
want to add the first four letters of the line to the list of instructions to be ignored. These
instructions-to-be-ignored are at the end of the SCRPTR setup file, separated by spaces
and preceeded by the number of instructions. You can edit this list if necessary.
You should scan the atom list (Input Atoms dialog in the Input1 menu) to be sure
nothing has been included by mistake.
3.1.1.2.6 CIF File
Import CIF File [File menu (Startup) or File menu (Graphics)]
See the Import File dialog for general aspects of importing atomic-structure data files.
ATOMS uses only a small number of the possible data items in a CIF file and recovers
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only the most basic information. The dictionary file, CIFDIC.SHT (a shortened version
of the complete CIF dictionary), must be in the home directory (the directory containing
the CPATOMS.EXE file).
Cell setting. If a cell setting (crystal class) is not present or is undecipherable, ATOMS
will try to recover the crystal class from the unit-cell parameters.
Errors in CIF files. Many CIF files which are written by databases and other software
violate one or more of the CIF syntax rules (Acta Cryst. 1991, A47, 655) and are
therefore unreadable without modification. Some common errors:
1) Line length greater than 80 characters.
2) Failure to enclose character fields in single quotes
3) Fields ("data names") too long - for example "data_" field longer than 32 characters.
The "data_" line should be truncated to 36 characters. Many of the lines in a typical file
are not used by ATOMS and may simply be deleted.
3.1.1.2.7 DBWS/LHPM Rietveld File
Import DBWS/LHPM Rietveld file

[File menu]

See the Import File dialog for general aspects of importing atomic-structure data files.
The DBWS or LHPM formats are very similar.
In the Atom type numbers from: box, the Type label option will select the NTYP field
which usually contains the elemental symbol for recovery of the scattering factor.
ATOMS can read three revisions of the DBWS format - 1990, 1994, and 1998 - but
there is no version number or other direct indication of the revision in the file itself, so
some trial and error may be involved. 1990 files will probably fail on the first attempt at
reading, and you are then given a chance to try again.
3.1.1.2.8 ICSD File
Import ICSD File [ File menu (Startup) or File menu (Graphics)]
See the Import File dialog for general aspects of importing atomic-structure data files.
Five types of ICSD file are supported, classified according to source:
1) Files from the CD-ROM database, accessed by the program RETRIEVE (see below
for the CD-ROM program FINDIT). The RETRIEVE files must be written from the
DATA window using the PRINT option, not as export files (if there is sufficient demand,
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export files may be supported). That is, the file should be a copy of what is shown on the
screen in the RETRIEVE program.
2) Files from the CD-ROM database, accessed by the newer program FINDIT (see
above for the CD-ROM program RETRIEVE). As for RETRIEVE, the exported file
must be a copy of what is in the results window. FINDIT can also write CIF files.
3) Files from the Canadian Scientific Numeric Database System (CAN/SND ). This
service may no longer be available. The files are referred to as CRYSTIN, but are
different from original 4) CRYSTIN files.
4) Original CRYSTIN files, available from the Netherlands CAOS information system,
from ETH (Switzerland) and perhaps other sources.
5) Files from the the ICSD World Wide Web site (barns.ill.fr/dif/icsd/). The "raw"
(ICSD) data format for this source is unreliable and is not shown in the menus. The data
should be exported in one of the formats which is supported by ATOMS. Unfortunately
again, these exported files may be incorrect - certainly the exported CIF files often violate
many of the CIF rules and may be unreadable without modification (see CIF files).
In CAN/SND files, ATOMS will use the "NA:" line for the title; in RETRIEVE and
original CRYSTIN files, ATOMS will use the first "MINR" line if present, otherwise it
will use the "NAME" line.
Although ATOMS actually distinguishes among the four different file types by reading
part of the main title or "Collection" line, which gives the ICSD index number:
1)

RETRIEVE -

2)

FINDIT -

3)

CANSND -

4)

ORIGINAL -

5)

WWW -

" COL Collection Code " or " COL ICSD Collection Code"
"*data for ICSD #"
"ID: "
" **** COLLECTION CODE COL= "
" COL ICSD Collection Code " with "DATE=" in the same line

In each case the index number follows the above excerpt. Note that in all file types
except CANSND and FINDIT there is always a blank character in the first column.
Please contact Shape Software if you have ICSD files which cannot be read by one of
these options. The best procedure is to send samples of the files by email or on a floppy
diskette.
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3.1.1.2.9 ORTEP File
Import ORTEP File [File menu (Startup) or File menu (Graphics)]
See the Import File dialog for general aspects of importing atomic-structure data files.
This imports the unit-cell parameters, symmetry, atomic positions and thermal data from
original or ORTEP II files. It does not read the boundary and plotting instructions - one
of the two ATOMS boundary options Default Unit Cell or Locate Molecules in Crystal is
used.
Most of the ORTEP ellipsoid and bond plotting parameters are read from the file, and can
be accessed in the Ellipsoid Parameters dialog in the Input2 Menu. See
Thermal Ellipsoids for more details on display modes, etc.
3.1.1.2.10 XTLVIEW File
Import XTLVIEW File [File menu (Startup) or File menu (Graphics)]
See the Import File dialog for general aspects of importing atomic-structure data files.
ATOMS may need to shift the fractional coordinates to insure that the origin is placed on
a center of inversion.
3.1.1.2.11 PDB File
Import Protein Data Bank (PDB) Files
See the Import File dialog for general aspects of importing atomic-structure data files.
These files can be imported and displayed in all the methods available in ATOMS, i.e. as
ball-and-stick, interpenetrating (space-filling), skeletal, anaglyph and even polyhedra.
Special constructions such as ribbons are not yet supported.
Other specialized programs such as RASMOL can display protein structures faster and
with more protein-specific options. However, ATOMS may have an advantage over
some of these programs in the quality and flexibilityof the printed output, for example in
using the full resolution of the printer, either directly or as EPS files, Metafiles or PICT
files
In order to isolate the protein itself, there is an option in the Input2 menu which allows
omission of all hetatoms, or just water hetatoms.
Symmetry specified in the PDB file itself is not supported directly, as the specifications in
use prior to V2.0 are not adequate for computer input (often being simply verbal
descriptions). MODEL statements, greater than 99,999 atoms and temperature factors
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are not supported. In most cases you will be able to display only the atoms in the file,
although it is certainly possible to use point-group symmetry if applicable.
ATOMS is able to use the information on residues which is present in the file, as well as
CONNECT records, to greatly decrease the time required to locate bonds, compared to
standard ATOMS methods for crystals. However, if some bonds are missing from the
drawing it may be necessary to uncheck the PDB quick bonds box in the Bonds dialog
(Input1 menu), and generate a complete set of standard ATOMS bonds..
3.1.1.2.12 GSAS (.EXP) File
Import GSAS (.EXP) File

[ File menu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure data files.
The General Structure Analysis System can give magnetic moment vectors, and the
results for magnetic structures can be given in terms of Shubnikov black/white symmetry.
Unfortunately the information on magnetic reversals by symmetry is not given in an
intelligible form in the.EXP file, and if the magnetic space group differs from the
conventional space group it will be necessary to determine the Shubnikov space group
and enter it in the Space Group Symmetry option.
3.1.1.2.13 American Mineralogist File
Import American Mineralogist Structure Database File [ File menu]
See the Import File dialog for general aspects of importing atomic-structure data files.
The American Mineralogist structure database is currently available on the Internet at
www.geo.arizona.edu/xtal-cgi.test. This may change, but the database should be
locatable by searching for American Mineralogist.
3.1.1.2.14 FULLPROF File
Import FULLPROF file

[ File menu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure data files.
The "User-supplied" non-magnetic and magnetic options (JBT = +4 or +5) are not
directly supported - crystallographic and magnetic parameters in files using these options
will be read as if one of the standard options were used. Magnetic information is always
read as vectors in the crystallographic axes (not as polar or other coordinates), and
FULLPROF-specific magnetic symmetry is not currently used. It may be necessary to
select the Shubnikov symmetry, if the magnetic symmetry is different from the
conventional symmetry. Non-commensurate magnetic models are not currently
supported (they may be supported if there is interest).
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3.1.1.2.15 VIBRATZ Files
Import.MOT or .VBR (VIBRATZ) Files [ File menu (Startup) or File menu
(Graphics)]
Both the.VBR main data files and the.MOT vibrational displacement files from
VIBRATZ can be imported. The.VBR files simply contain standard crystallographic
information. The remainder of this topic pertains to the.MOT files.
The.MOT vibrational displacement files are written by the VIBRAT program (Dowty,
Phys Chem Minerals, 1987, 14:67) or the Windows version VIBRATZ (available from
Shape Software). ATOMS converts the infomation in the.MOT file into a standard.STR
ATOMS data file, and also a special.MDT file which contains the atomic displacements
and other information for each vibrational mode. When the.MOT file is imported, the
first vibrational mode in the list is selected and displayed (after calculation). When you
re-read the.STR file, it will contain the information for the vibrational mode in the list
which was selected when the file was saved. To see other modes, you must select the
Vibrational Modes option in the Input1 menu. You must recalculate after changing the
mode, since new pseudo-atoms and bonds representing vectors need to be generated.
To see on the screen or output which vibrational mode is being displayed, select the Print
title on plot option in the Title/Axes dialog in the Input1 menu.
The atoms will be given the default colors specified in the ELEMENTS file, as for other
types of import file. However, you have the choice of using radii in the ELEMENTS file
(or some fraction thereof - see the Preferences dialog in the Settings menu), or of using
constant radii.
Crystal import mode. VIBRATZ.MOT data for a crystal can be displayed in either of
two ways; showing the atoms in the primitive unit cell as a molecule; or using the normal
ATOMS boundary options for crystals. If the choice is a "molecule", there will usually be
both primary and secondary atoms (next paragraph). Lattice translation will be disabled.
If the choice is to show as a crystal, there will be no secondary atoms, and every
translationally equivalent atom will be the same. The boundary option will be Unit Cell,
current default, but this can later be changed. The atom list (Atoms in the Input1 menu)
will include all atoms in the Bravais (not primitive) unit cell. With either option, there
will be no non-translational symmetry, that is all atoms in the unit cell will be in the atom
list.
Secondary atoms (applicable only to crystals imported in molecule mode). VIBRAT
uses two types of atoms for crystals or infinite polymers: primary atoms, which are just
those in the primitive unit cell; and secondary atoms, which are those required to
complete the bonds and angles of the complete set of internal coordinates (force
constants). Often there are more secondary than primary atoms. If you choose to show
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the structure as a molecule (last paragraph), you have the option to show the secondary
atoms in just the same way as the primary atoms; to mark the secondary atoms with a
triangle; or to omit the secondary atoms altogether. If you omit the secondary atoms, the
bonds to them will also be omitted. Molecules do not require secondary atoms.
The Vector button calls up the Atomic Vectors dialog (Input1 menu), for specification
of the details of the vectors which represent the atomic displacements, including the scale
factor.
3.1.1.3

Page Setup

This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins (except Macintosh). Margins will only be used in
Text Windows.
---Macintosh only -----Use the Page Margins dialog to set margins.
3.1.2

Settings Menu (Startup Window)

Preferences - Sets parameters for modes of operation.
PostScript Settings - Hardware settings for direct PostScript output.
Pen Plotter Settings - Hardware settings for the pen plotter.
Palette - Modify, save or read the RGB values for the main 16-color palette.
Read Defaults - This reads structure display parameters, mostly those in the Input2
menu, from a setup file. These will replace those currently in memory.
Save Defaults - This saves structure display parameters, mostly those in the Input2
menu, for use when inputting a new structure with the New command in the File menu,
or when a standard set of parameters is desired.
3.1.2.1

Preferences, Operation Tab

Dialog Box: Preferences - Operation Tab [ Settings Menu]
See also Preferences - Constants Tab .
Sounds. This turns on or off the sounds emitted by ATOMS, for example at the
beginning and end of calculation and/or plotting (some system sounds are unaffected).
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Draw into buffer. If this box is checked, the image is drawn into an off-screen memory
buffer, and then copied to the screen. If not, the drawing is made directly to the screen,
and then copied afterwards into the buffer. Drawing into a buffer is usually faster, but the
difference may be small. No memory is saved by not checking the box, since the buffer is
always used anyway for refreshing the window after another window is draw over it.
Confirmatory alerts in New input. If this box is checked, during input of a New
structure file (File menu), after every input dialog there is an alert or dialog box
(Entering New Data Set) giving the choice of proceeding to the next dialog, aborting
data input, or revising the last dialog. Without these dialogs, there is no escape from the
sequence of Input1 dialogs, and no escape from the sequence of Input2 dialogs.
Calculate query on file open. If this box is checked, you are asked if you want to
calculate the structure - if not, the structure is calculated as soon as it is read in.
Scale lettering to screen. If this box is checked, in printed output or output to a file,
the labels in that output will be scaled to approximately the same relation to the drawing
itself as on the screen. This is a very approximate process, and trial-and-error adjustment
will still be necessary to get the desired label sizes in output. This option should be
thought of as adjusting the labels on the screen to look similar to those in the output,
rather than the other way around.
Screen start-up. This sets the color/black-and-white state of the screen at start of
ATOMS. It can be changed with the Color command in the Display menu.
Mark selected atoms. This refers to selecting atoms in the screen plot with the mouse.
If Show last is selected, the last atom selected is outlined in a contrasting color, but this
marking disappears when another atom is selected, or an empty area is clicked. If Show
all is selected, all markings remain until a Replot.
Skeletal mode during interactive rotation. When rotating using the mouse cursor,
ATOMS can switch to a Skeletal mode so as not to slow down the motion. When
starting in 3D mode, the 3DSkeletal mode is used. This is not usually necessary when the
number of atoms is small as the redraw is usually fast enough, so the best choice may be
"If more atoms than". The number of atoms may be 100 or so, but this will depend on
the speed of your system.
Skeletal mode choice. Starting with V5.1 of ATOMS there are two possible methods of
drawing in Skeletal mode. In the Bond colors or "old (pre V5.1)" mode, all atoms are
shown as small dots, except those in polyhedra; all bonds are shown as lines using bond
colors (either fill or edge colors as selected in the next item), and polyhedra are shown by
lines joining the corners (outlining the faces). The lines indicating polyhedron edges use
the polyhedron fill colors. In the Atom colors or "new" mode the bonds are shown in the
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colors of the two atoms (fill color), half-and-half. Polyhedron edges are not shown;
instead the central-ligand bonds are shown.
Color for line bonds. When in the Skeletal drawing modes (Bond colors option above),
and when bond radii are 0.0 in the Standard drawing mode, the colors for lines
representing bonds may be either the rim or fill colors given in the Bond Data dialog.
3.1.2.2

Preferences, Constants Tab

Dialog Box: Preferences - Constants Tab [ Settings Menu]
See also Preferences - Operation Tab.
Increment for drawing circles (degrees). Arcs of circles are drawn with line segments
at specified angular increments (full circles are drawn with system routines). Ellipses are
also drawn with proportionate line segments, although the increments are variable. The
default circle increment of 12.0 degrees has been found to give satisfactory results for
laser and pen-plotting, provided atoms are not too large. Making the increment smaller
may improve the appearance, at a penalty in plotting time, especially if your computer has
no math coprocessor or you are using lines of finite width.
On-screen rotation increment (degrees). This is the amount by which the image is
rotated in the Dialog Bar - Left. This is the value which exists when ATOMS is started;
this value and not the latest value in the dialog bar itself is saved on quitting ATOMS.
On-screen displacement increment (Angstroms). This is the default amount by which a
structure fragment is translated in the Dialog Bar - Fragments (Display menu). This is the
value which is in the dialog when it is first called; this value and not the latest value in the
dialog itself is saved on quitting ATOMS.
On-screen rescaling factor (%). This is the default amount by which the drawing is
rescaled with the Scale button in the Dialog Bar - Right (Display menu). This is the
value which is in the dialog when it is first called; this value and not the latest value in the
dialog itself is saved on quitting ATOMS.
Default radius for atom location (Angstroms). When identifying atoms with the
cursor, the given atomic radius is used for deciding when the mouse is clicked "on" an
atom. However, if the input radius is zero or negative (denoting either polyhedral atoms
or wire-frame atoms), this default radius is used instead.
Factor for scaling to screen or frame. In either the Maximize or Universal scaling
modes (Scaling dialog, Input2 menu), the image is scaled to almost fill the screen or
frame. This factor specifies how close the image comes to the edges. This scaling is not
precise when Perspective projection is used, so a relatively smaller factor may be
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necessary if the perspective distance is small.
Dash length and dash ratio. The dashes are used for back edges of crystals
(Crystal Edges and Faces) and in display of Crystal Axes and Unit Cell. Length or repeat
distance is in inches/centimeters, and the length factor is the actual length of the solid part
divided by the repeat distance. Note that when using Frames in output the dash length
remains the same - it may be desirable to decrease the length for very small plots.
Atomic radii. One or the other of the two files, ELEMENTS.ION,ionic radii, or
ELEMENTS.COV, covalent radii, is used during input of Import files and input of
atomic parameters through the Input Atoms dialog (see ELEMENTS files). The Factor
multiplies the full radius values during this input. Values of around 0.5 are appropriate
for ball-and-stick display, while values well over 1.0 may be required for interpenetration
(space-filling).
Scaling units. This sets either inches or centimeters as the units for overall use in
ATOMS. This choice may be locally overridden for printing or other output by the Units
setting in some of the dialogs involved.
3.1.2.3

PostScript Settings

Dialog Box: PostScript Settings [ Direct Postscript Output Dialog] [ Settings Menu]
The page size, page margins and dots per inch/centimeter should be determined by the
actual printer used for final output; if these are not correct, the drawing may not be scaled
and/or placed on the page correctly.
The Transfer Function is analogous to the PostScript function of the same name. The
linear option is standard; modify the function to get lighter or darker shading in
PostScript print-out.
Preview Color. If you select a screen preview (TIFF bitmap or PICT sub-file) in the
Direct PostScript Output dialog, and if color output is selected, you can specify either a
color or black-and-white bitmap. The Screen option uses the color depth of the the
current screen display. Black-and-white PostScript output always uses a 1-bit or blackand-white screen preview.
Background color. If this option is on, the color selected in the Background Color
dialog of the Input2 Menu will be applied in color output only. Background in b/w
output is always white.
Atom algorithm. ATOMS shows shading for atoms by computing concentric zones
around the point of emergence of the illumination vector. This can be done in two ways:
1) For non-PostScript display and output, points are calculated on lines radiating outward
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from the point of emergence. This means that the curves defining atoms and atom shade
zones are defined by a large number of short line segments - this is called the "lengthy"
algorithm. 2) The default algorithm for Postscript, called the "compact" algorithm, simply
sends the parameters for the circle and ellipse segments which make up these curves (this
cannot be done for normal drawing because the system drawing routines do not deal with
general ellipses). The lengthy algorithm typically requires twice the disk space as the
compact algorithm for shaded atoms. The compact algorithm is also more precise in its
drawing of curves, and it allows all illumination vectors (for the lengthy algorithm, the
point of emergence of the illumination vector must be within the atom outline, which may
be truncated by interpenetrating atoms or large stick bonds). The only case in which the
lengthy algorithm might be necessary is when three or more atoms interpenetrate, so that
the segments removed from the outline of an atom overlap. This condition in principle
could also arise if two stick bonds to an atom overlap.
---- Windows only ----

If you are using direct output to a printer you must select the Port; this will be either
"LPTn" or "COMn". Also, if you are using a serial port for the printer, you must set or
verify the data transmission parameters, such as baud, parity, etc., even if the port
currently shown is the correct one. This is done in the Ports item of the Windows
Control Panel (not in ATOMS).
3.1.2.4

PostScript Transfer Function

Dialog Box: PostScript Transfer Function [ Postscript Settings dialog]
The Transfer Function is analogous to the PostScript function of the same name. It
changes the nominal gray values (0.0-1.0 for black-white) calculated by ATOMS as true
illumination to values actually output. (Note that the PostScript gray scale, 0.0-1.0 for
black to white, is in the opposite direction to the ATOMS gray scale, 0-15 for whiteblack; the transfer function applies to the Postscript gray scale.) If your printer gives gray
shadings that are too dark (this is common, especially for lighter shades), you can
increase the output values. Values in between the listed values are linearly interpolated.
The actual gray values output to the printer or EPS file are changed; the transfer function
itself is not part of the EPS file. Note that the gray-scale conversion also applies to lines
of greater than single-dot width (single-dot lines are always black).
3.1.2.5

Pen Plotter Settings

Dialog Box: Pen Plotter Settings [ Pen Plot dialog] [ Settings Menu]
Current plotter radio buttons. There are several pre-programmed plotters; clicking on
the Get Data button reads the pen-plotter data file (PPLOT) and obtains the commands
and parameters. Even if your plotter is not listed here, you may be able to input the
commands through the Other option. In this case, click on the Commands button to set
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or revise the commands and parameters.
Pen-change mode radio buttons. If you have a multiple-pen plotter, you can elect to run
in the Use single pen mode with the pen number entered in the edit field, and conversely
if you have a single-pen plotter you can draw with multiple colors, but you will have to
change the pens manually. If you choose the Change pens manually mode, the plotter
returns to the zero position after drawing all lines of each color, and a message box
appears, prompting you to change pens.
Blank border. A blank border can be added to atoms, bonds and polyhedra in the pen
plot in order to increase the illusion of depth. Lines which are part of atoms, etc.,
"behind" the atom in question are cut off when they get within the specified distance of
the atom, etc. which is in "front". This option may add considerably to the plotting time,
since it involves much recalculation. If the width of the border is set to 0.0, there is no
recalculation.
Speed number. This is the parameter (see Commands ) which controls velocity of the
pen - for example for the Comrex, speed number 1 is slowest and 15 is fastest. Although
some plotters, like the HP7475A, allow decimal speeds, you must use an integer here.
---- Windows only ----

Port. This should be either a serial or parallel port: "COMn" or "LPTn". Even if this box
shows the correct port, if it is a serial port you should verify the baud, parity, stop bits
and data bits in the Ports item in the Windows Control Panel. These parameters should
be set to match the settings on your pen plotter (which are usually controlled by DIP
switches).
3.1.2.6

Pen-Plotter Commands and Parameters

Dialog Box: Pen-Plotter Commands and Parameters [ Pen Plotter Settings dialog ]
This allows you to enter or revise the pen-plotter commands and parameters, for nonstandard pen-plotter types.
It is assumed that the plotter accepts ASCII commands that follow a simple syntax of
"command, parameters, terminator''. For example, the Hewlett-Packard command for
moving the pen, raised, to the coordinates x,y is "PUx,y;''. "PU'' is the command, which
should be entered (without parentheses) in the text box Move - pen up: x and y are the
parameters, which are always supplied internally by ATOMS; and the semicolon is the
terminator required in the Terminator text box. Commas between parameters are also
supplied by ATOMS. Move - pen up means move to the new coordinates with the pen
up (not marking).
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You must enter or edit the commands in the text boxes on the left of the dialog. If more
than one command is required to perform the operation requested, give all the commands
with any intermediate parameters and terminators required, but omit the last terminator.
If your plotter does not use a command, just leave that field blank.
Following are comments on the plotter inputs. The type of variable required, and the
maximum number of characters in case of a character variable, are given in parentheses.
View samples by clicking on the selections in the Current Plotter group in the
Pen Plotter Settings dialog.
Commands
Move - pen up. (6 chrs) Move to the new coordinates with the pen up.
Move - pen down. (6 chrs) Move to the new coordinates with the pen down.
Raise pen. (6 chrs) Raise the pen without movement.
Pen speed. (6 chrs) This is the command which causes pen speed to be set or changed;
the parameter is entered as a separate item in the Pen Plotter dialog menu.
Change pen. (6 chrs) This is required only for multi-pen plotters.
Start plot. (12 chrs) Initialize the plotter. May require no commands, or several.
End plot. (12 chrs) Terminate plotting. Like (12).
Terminator. (2 chrs) The character which signals the end of a command. In most cases
the semicolon.
Parameters
Maximum x/y. (Decimal) Maximum x and y coordinates. These values establish the
centering of the plot. Increments on the x and y axes are assumed to be equal.
x/y at finish. (Decimal) The "base'' coordinates, in plotter units, to which the paper or
pen will be returned at the end of the plot, or when pens are to be changed manually.
Units/inch(or centimeter). (Decimal) This establishes the resolution of the plotter and is
used in scaling. If your plotter instructions do not give this number, divide the maximum
x or y coordinate (item 1 above) by its length in inches.
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Palette

Dialog Box: Palette [ Settings Menu]
The Palette is used to set up a 256-color palette for 8-bit screen display or raster output,
and also to set the primary choices for color in all cases (you can always select other
colors using different RGB values). See Colors, Palettes and Dot Patterns for more
detail. The default Main palette has the same RGB values as the "alternate" palette used
in DOS versions of ATOMS, but rearranged to a more logical order.
You can read and write values to palette (.PAL) files. Two palettes are provided on file:
STANDARD.PAL and ALTERNATE.PAL, which are respectively the standard IBM
palette and the default alternate palette used in DOS versions of ATOMS. It is easy to
write or modify the.PAL files directly; they simply contain the RGB values, from 0 to
255, separated by spaces (or commas).
The Default button will reset the palette to the current default values.
3.1.2.8

Read/Save Defaults

Read and Save Defaults Commands [ Settings Menu]
When inputting data for a drawing with the New command in the File menu (Startup) or
File menu (Graphics), you can elect to use default values for display parameters, rather
than set these in the dialogs of the Input2menu . If no data set is in memory, the default
display parameters are always read from disk; and if there is a data set in memory, you
can use the current values or read the defaults from disk.
Also, when importing a file (File menu (Startup) or File menu (Graphics)), you have the
choice of reading in the saved parameters or using the current ones.
Also, if you desire to convert the current parameters, which may have been read in from
a.STR data file, to the standard set, you can use the Read Defaults command at any
time.
The Save Defaults option saves the current display parameters, i.e. most values in the
dialogs of the Input2 Menu and some in the Display Menu.
3.2

Graphics Window Menu Bar

File menu - In addition to the usual New, Open, Print etc., this menu has commands
for listing input and generated data, and for for PostScript, pen plotter, raster or bit-map
and Metafile or PICT output.
Modes menu - This allows setting the Display mode, and the Cursor mode.
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Input1 menu - This contains dialogs involving mostly the basic data for the structure,
such as axes (unit cell), atom coordinates, etc.
Input2 menu
structure.

- This contains dialogs setting display parameters specific to each

Display menu - This contains commands and dialogs which set the overall display
attributes of ATOMS, and modeless dialogs for rapid rotation and displacement of the
structure.
Rotation menu - This contains several options for rotating and aligning the structure.
Transform menu - This contains specialized options for converting generated to input
atoms, locating groups and dealing with multiple structure fragments.
Settings menu - This contains settings for hardware, palettes and preferences for modes
of operation.
Window menu - This contains commands relating to the display or activation of the
different kinds of windows - the main Graphics window, diffraction Graphics windows
and Text windows.
Help menu - On-line help.
3.2.1

File Menu (Graphics Window)

New - Step-by-step input of a new ATOMS data set.
Open - Open an old ATOMS data file.
Close - Close the current graphics window.Startup Menu Bar
Save - Save an ATOMS data file.
Save as - Save an ATOMS data file with a new name
Open Recent File Select from most-recently-used files.
Import File - Shows a pop-up menu with the file types currently supported. This
includes:
---- CCDC FDAT files from the Cambridge Crystallographic Data Centre.
---- SHELX.INS files from the program system of Prof. G. Sheldrick.
---- CIF - Crystallographic Information Files.
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---- DBWS/LHPM Rietveld input files.
---- ICSD Inorganic Crystal Structure Database files.
---- ORTEP Original or ORTEP II atom information.
---- XTLVIEW Drawing program.
---- VIBRAT (.MOT) Graphic output files from VIBRATZ.
---- PDB Protein Data Bank files.
---- RIETAN Rietveld program files.
---- GSAS Data files (.EXP) files from the Los Alamos Lab system - may include
magnetic vectors.
---- AM MINERAL. Data files from the American Mineralogist structure data base.
---- FULLPROF. All-purpose refinement program - may include magnetic vectors.
---- Free-form (.inp). This allows input of atomic coordinates etc. from almost any
source.
Export File - This will write a file in one of several molecular formats, containing labels
and Cartesian coordinates of the generated (not input) atoms. Some files may also have
bond tables and other information
Calculate - Reproduce atoms within specified boundaries and locate bonds and
polyhedra.
Print - Print out the graphics image; see List... commands below for listing data and
calculation results, and Calculation Output in the Input2 menu for listing results of the
calculation.
Page Setup - Set the page size and select the printer.
Listings group - the following four commands are in a secondary pop-up menu
List Input - List all input data parameters to the file INPUT.ATD and to a Text
window.
List Generated Atoms - List all generated atoms to the file GENATOMS.ATD and to
a Text window.
List Faces - List all generated faces to the file FACES.ATD and to a Text window.
List Totals - List various totals, such as generated atoms, bonds, etc., to the file
TOTALS.ATD and to a Text window.
Output group
PostScript Direct output to a PostScript printer (Windows only
) or to an EPS file.
Pen Plot - Output to a pen plotter or HPGL file.
Raster Files - Writes raster or bit-map files in.BMP,.PCX,.TIF or.PNG (Windows)
or.PNG (Macintosh) format.
Metafiles (Windows ) or PICT (Macintosh ) - Writes metafiles or PICTs to the
clipboard or disk files.
Save Graphics Window - Dumps the exacts contents of the Graphics window to the
clipboard or a file (.BMP format for Windows or PICT for Mac).
VRML Files - Writes output in the Virtual Reality Modeling Language 3D format.
POV-Ray Files - Writes output for the ray-tracing program POV-Ray.
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Exit - Quit ATOMS.
3.2.1.1

New command

The New command in the File Menu of the Graphics Window is identical to the
New command in the File menu of the Startup Menu.

3.2.1.2

Open command (Graphics)

Open command ( File menu (Startup) or File menu (Graphics))
If there is a data set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.
Use this command to open an existing ATOMS data file. After the file has been read in,
you are asked if you want to calculate immediately (this query can be eliminated with a
checkbox in the Preferences dialog, Settings menu). If you reply OK, the structure will
be plotted in the Graphics window. If you decline to calculate immediately, you can
modify the structure or display parameters. When finished, use the Calculate command
in the File menu.
You can create a new ATOMS data set with the New command, or import various kinds
of files from
other software with the Import command.
3.2.1.3

Save command (Graphics)

Save command ( File menu, Graphics window)
When called from the Graphics window, this saves the active data set to its current name
and directory. If you have changed the orientation from that specified in the
Initial Orientation dialog in the Input2 menu, you are asked if you want to save the
current orientation. If you choose to do this, the current orientation will be converted to
initial orientations on the observer x, y and z axes
When you save a data set for the first time, ATOMS displays the Save As dialog box so
you can name your data set. If you want to change the name and directory of an existing
data set before you save it, choose the Save As command.
3.2.1.4

Save As command (Graphics)

Save As command ( File menu, Graphics window)
When called from the Graphics window, this saves the active data set. ATOMS displays
the Save As dialog box so you can name your data set.
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If you have changed the orientation from that specified in the Initial Orientation dialog in
the File2 menu, you are asked if you want to save the current orientation. If you choose
to do this, the current orientation will be converted to initial orientations on the observer
x, y and z axes
To save a data set with its existing name and directory, use the Save command.
3.2.1.5

Close Command (Graphics)

Close Command [ File menu (Startup) or File menu (Graphics)]
When exiting ATOMS, closing the graphics window, reading another file or starting a
new file, ATOMS tries to determine if you have made any changes in the structure
currently in memory; if so, you are asked if you want to save the file.
First, it checks whether the orientation has changed from the Initial Orientation
established during calculation. If so, you can save the current orientation as initial
rotations. It also checks whether any dialog in the Input1 and Input2 menus have been
opened, or whether there has been any change in the status of atoms marked for nonplotting (see Deleting Atoms ).
3.2.1.6

Import Files Submenu

The Import Files submenu in the File Menu of the Graphics Window is identical to the
Import Files submenu in the Startup Menu.
3.2.1.7

Export Atom Data File

Dialog Box: Export Atom Data File [ File menu]
This exports the current generated atom data, with Cartesian coordinates, to a choice of
molecular file formats.
ATOMS does not necessarily write a complete file for any particular format since it may
not have all the information required - manual editing may be necessary. If an elemental
symbol is written it assumes that the type number (modulo 100) is the atomic number.
Export: As drawn/All generated atoms. If you choose As drawn, the atoms in the file
will be just those shown on the screen, excluding atoms in incomplete polyhedra, atoms
marked for non-plotting, etc. All generated atoms will export all atoms within the
current boundary.
Strip non-alphabetic characters from label. This will end the label string at the first
non-alphabetic character. Some programs are not able to identify the element from labels
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like "C1", "O12", which are common in crystallographic files.
Convert polyhedra to bonds. This will export bonds between the central atom and the
ligands of any polyhedra. Not all export formats have bond specifications.
PDB files. The space-group symbol in the CRYST1 record is not necessarily in the form
required by PDB and may need to be edited. The standard crystal-Cartesian orientation
in PDB files is a = x and c* = z, whereas in ATOMS it is a* = x and c = z. If the
crystallographic orientation is important it may be wise to reorient the crystal in ATOMS
to the standard PDB orientation. This can be done in the Align Face or Vector option in
the Rotation menu. Orient on vector [100], with alignment face (001).
ATOMS does not directly export crystallographic file formats. However, the shareware
program Cryscon
(Shape Software - www.shapesoftware.com) can convert among several crystallographic
formats, and write files such as CIF from ATOMS data.
3.2.1.8

Calculate Command

Calculate Command [ File menu]
This command must be used whenever an "intrinsic" or "input" parameter of the
structure, including most items in the Input1 menu, is changed. For parameters which
affect display only, such as atom, polyhedron or bond colors and items in the Input2
menu, use the Replot command in the Display menu or the Replot button in the
Dialog Bar - Left. Changing atomic radii does not require recalculation as long as stick
bonds are not changed to interpenetration or vice-versa.
3.2.1.9

Print Graphics Image

Dialog Box: Print Graphics Image [ File menu]
------- Windows only-------------

This command is for normal printer output through the printer driver (see below). If you
have a PostScript printer, you should probably use the PostScript command in the File
menu rather than this one for non-3D images; that command sends PostScript language
commands directly to the printer, bypassing the printer driver. The PostScript language
has a few capabilities which are missing from the system routines. Using
Direct PostScript output may give somewhat different, and usually more correct colors,
than using the Print option (although color inaccuracies may possibly be fixed by
changing the settings of the printer driver in the Page Setup command).
In the case of 3D images (that is printing while in the 3D Display mode), ATOMS does
not send drawing commands to the printer - rather the entire drawing (or sections
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thereof) must be imaged in memory, and this raster or bitmap image is sent to the printer.
------ Macintosh only ------------

Three different Print Modes may be used, depending on the settings in this dialog and
the ATOMS display mode - 1) Standard or QuickDraw, 2) Direct PostScript or 3)
Bitmap.
Option 1) sends standard QuickDraw graphics commands (the same as those used for the
screen) to a printer driver, which may be supplied by Apple or the printer manufacturer.
The printer then makes the image in its own memory. You select the printer or printer
driver in the Chooser option in the Apple menu (OS 8/9) or in the Print Center (OS X).
This option sometimes results in poor quality output, with too-thick or irregular lines,
patterns at a scale of 72 dpi instead of the true printer resolution, or incorrect colors. If
this happens try one of the other options.
If you have a PostScript printer, for non-3D output you should probably select the Direct
PostScript option - this causes ATOMS to send PostScript language commands to the
printer instead of the QuickDraw drawing commands, although these commands are
transmitted through the currently-selected printer driver. Some printer drivers, especially
the standard LaserWriter drivers, may not print at the maximum resolution of the printer
without this option. Note that direct PostScript printer output is only supported through
this option, not through the PostScript item in the File menu. The Pattern Series
selection is ignored - patterns are determined by the Printer.
Option 3) forms the image in memory, then sends it as a bitmap to the printer. This
option is always used for 3D Display modes. This method may be very slow, but often
gives higher quality than option 1).
------- End Macintosh/Windows only ----------

If the Standard printer dialog on OK box is checked, the Print dialog supplied by the
operating system or the printer driver comes up after you click OK. Use that dialog to
set the number of copies or in some cases the resolution. The orientation (portrait or
landscape) can also be set in the Page Setup dialog in the File menu.
If you have a color printer, you may need to make a choice between color and black-andwhite printing in one of the printer dialogs as well as with the Color printing checkbox
in this dialog. This choice may be an option in the standard printer dialog above, or you
may need to set it in the Page Setup option in the File menu. Background applies only to
color printing; for black-and-white printing the background is always white (although you
could print on black paper).
See Frames for details of the frame and frame units.
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In this print option, for non-3D images, ATOMS sends standard graphics commands to
the operating system, which passes them on to the printer driver, a piece of software
which is normally written by the printer manufacturer (but sometimes by Microsoft in the
case of Windows). For color printing, it is standard to send RGB values to specify colors
for lines and files, and for black-and-white printing, it is standard to send gray-scale
values (actually, RGB values with all three components equal). The printer driver
interprets these values in terms solid areas and/or dot patterns of ink on the paper. No
color printer can print all colors as solid areas; traditional printing uses as few as three or
four colors, most commonly cyan, magenta, yellow and black, intermixed or dithered in
dot-patterns to produce a full range of colors. Microcomputer printers may use more
colors, but the principle is the same, and dot density is typically lower than in traditional
printing, so it may be important to select colors which are as simple as possible in terms
of red, green and blue or cyan, magenta and yellow (see Colors, Palettes and DotPatterns
).
Use ATOMS b/w patterns - Pattern Series. Black-and-white printer drivers must
interpret the gray values for fills as dot patterns of varying density. The patterns supplied
by the printer driver may or may not be satisfactory for the ATOMS user. Rather than
send gray-scale values for fills, ATOMS can also send its own dot patterns, which have
been carefully designed for its purposes. The Fine series is appropriate for small
drawings which will not be reproduced photographically. The Coarse series simulates
halftone screening and is appropriate for photographic reproduction. To be precise, at a
printer resolution of 300 dots per inch, most of the patterns have a screen density of 53
lines per inch, at 45 degrees; this is about half the density of typical standard printing, so a
reduction of about a factor of two is generallly satisfactory. Of course, different printer
resolution would dictate different reduction factors. Note that this coarse/fine setting is
the same as that in the Raster and Metafile or PICT files dialogs in the File menu.
------ Macintosh only ------------

ATOMS patterns are always used for b/w printing, but they may be rescaled or otherwise
changed by the printer driver.
------- End Macintosh/Windows only ----------

Actually, different printer drivers may interpret the standard gray-scale commands in
terms of patterns which are similar either to the fine or coarse series supplied by ATOMS.
Some may convert the ATOMS patterns to their own patterns, and some may not accept
the ATOMS patterns at all. Some may offer their own choice of pattern types or
densities (typically in the printer dialog above or the Page Setup dialog in the File
menu). Thus some experimentation may be necessary to find the best choice for patterns
(i.e. printer-driver patterns, fine ATOMS patterns; or coarse ATOMS patterns). Gray
lines of greater than one-dot width are always drawn by filling an outline with one of the
ATOMS patterns - gray-scale values are not used because many printers will not print
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gray lines. Thus the coarse/fine setting is always used for wide b/w lines.
Maximum memory. This is used only when printing in bitmap mode, which is always
used for the 3D display mode. Operating system support for printing in 3D mode is
incomplete, and ATOMS itself must therefore draw raster or bitmap images and send
these to the printer, rather than relying on the printer driver. Memory considerations
similar to those involved in Raster Files therefore come into play.
Both Macintosh and Windows operating systems use virtual memory, which means that
they pretend that a hard disk can be used in place of actual hardware memory chips. For
some purposes this is useful, but when writing raster files it usually results in "disk
thrashing", or constant reading and writing of data to the hard disk.
ATOMS is capable of imaging and writing raster files in segments or bands to avoid this
problem. This requires repeating the entire drawing process for each band, but this
usually is much faster than the reading/writing to disk involved in using virtual memory.
To do this requires knowing how much actual chip memory is available. Unfortunately,
at present the operating systems do not provide this information in a useful way. Thus
the user may need to determine this by trial and error using the Maximum memory
parameter. This is the same parameter which is set in the Raster Files dialog.
When the Maximum memory parameter is set to zero, ATOMS will simply ask the
system for a block of memory large enough to image the entire drawing at once. If this
amount of memory is greater than the amount of chip memory which is made available by
the system (and this may be considerably less than the actual amount of chip memory in
the computer), the operating system will use virtual memory, which is typically
manifested by disk thrashing. If you change the Maximum memory to some amount
less than that require for the image (say half), ATOMS will only request this amount of
memory from the system, and virtual memory may not come into play. A Maximum
memory setting should be good for a given session, regardless of the size of the raster
file; larger files will use more bands. However, the amount of memory available may
depend on whether other applications are active.
The amount of virtual memory is determined by the available space on the hard disk. If
this is insufficient, ATOMS will automatically use bands, but since virtual memory is
being used, it may still be advantageous to use a Maximum memory value which will
increase the number of bands.
3.2.1.10

Page Setup

The Page Setup dialog box in the File Menu of the Graphics Window is identical to the
Page Setup dialog in the File Menu of the Startup Window
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Listings Group

This submenu allows listing, in Text Windows, of Input Data (below), Generated Atoms,
Generated Faces and Totals with memory usage.
Dialog Box: List Input Data [File menu]
This lists out the input data to a Text Window (see Types of Windows). The categories
selected by the check boxes correspond to the various dialogs in the Input1 and Input2
menus.
3.2.1.12

Direct Postscript Output

Dialog Box: Direct Postscript Output [ File menu]
---- Windows only ----

This option can be used to write Encapsulated Postscript (EPS) files for transmission of
graphics to other software, as well as for direct output to a Postscript printer. This direct
output is generally superior to, as well as faster than, the output from the normal
Print Graphics command in the File menu if your printer is PostScript. The Destination
option sends output either directly to a printer or to a file in standard EPS (Encapsulated
Postscript V3.0) format.
Screen Preview.
Most word-processing and publishing software cannot display an EPS file on the screen
unless the file has a special bitmap attached, called the screen preview. This is actually a
sub-file in the TIFF format. The pixel depth of this file can be set in the
PostScript Settings dialog (Settings button). The pixel depth of the preview is set to that
of the screen, and the pattern series is set to fine (see Raster Files).
---- Macintosh only ----

This option can only be used to write Encapsulated Postscript (EPS) files for transmission
of graphics to other software. For direct output to a Postscript printer, use the Print
option.
Screen Preview.
Most word-processing and publishing software cannot display an EPS file on the screen
unless the file has a special attachment, called the screen preview. This is actually a PICT
in the resource fork of the file.
---- End Windows/Macintosh only ----
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In 3D Display modes, ATOMS always writes data (or sends it to the printer) in the form
of a bitmap (or "image" in PostScript terminology). Because of the facts that PostScript
files must be ASCII (text), and that efficient data-compression schemes (other than the
copyrighted LZW) are not supported in PostScript level 2, PostScript files for 3D
drawings tend to be much larger than the best Raster formats, especially PNG. Thus the
PNG Raster format is generally preferable for all 3D Display mode drawings.
The Maximum memory setting limits the amount of memory used for bitmap buffers
when in the 3D mode - see the Raster section for further details. The number of pixels on
each raster line must be divisible by four - the image width will be increased if necessary
to achieve this.
Settings button (PostScript Settings dialog). On or before first using the Direct
PostScript Output command, you should set or verify the settings in this dialog,
especially the port to which the printer is attached. Fonts in PostScript output. Depending
on your system configuration (Windows or Macintosh, printer type and driver), the
PostScript fonts supported by a PostScript printer may or may not appear in the dialog
for selecting fonts which may be called from the Title/Axes, Atom Labels, Bond Labels,
Axes/Unit-Cell or Magnetic Labels dialogs. Furthermore, you may want to write EPS
files for a printer which is not even connected to your computer. These dialogs thus have
an option to specify a character string for the PostScript font. This string specifies the
typeface, and includes the weight (normal, bold) and other attributes (italic or oblique),
but does not include the size - the size is specified in the font dialog. There are certain
standard PostScript typefaces which are present on most PostScript printers.
See Frames for details of the frame and frame units.
3.2.1.13

Pen Plot

Dialog Box: Pen Plot [ File menu]
---- Windows only ----

This option can be used to send commands directly to a pen plotter, provided the plotter
is connected to one of the standard parallel or serial ports, or to write files such as HPGL
which may be read by other software.
---- Macintosh only ----

This option writes pen-plotter-language files such as HPGL which may be read by other
software.
---- End Windows/Macintosh only ----
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On first using this command, be sure to click on the Settings button to set or verify the
characteristics of the plotter.
To write HPGL files, click on the Settings button and make sure that the plotter selected
is "HPGL plotters".
See Frames for details of the frame and frame units.
3.2.1.14

Raster (Bitmap) Files

Dialog Box: Raster (Bitmap) Files [ File menu]
--Windows Only ----------

This command can write files in four different formats (File type): Windows deviceindependent format (.BMP); PC-Paintbrush (.PCX); Tag-image-format (.TIF); and
Portable Network Graphics (.PNG) files.
--Macintosh only---------

This command can write files in the Portable Network Graphics (.PNG) format. The
Clipboard/PICT option (File menu) can also write raster or bitmap files, in the PICT
format.
--End Windows/Macintosh only----

See Selection of File Format below for information on choosing the format.
The drawing may be either black and white or color. If black and white, the pixel size is
1-bit. For color files the pixel size may in some cases be selected. In Windows, 16-bit is
only available for.bmp files. In Macintosh, 8-bit (256-color) is only available if the screen
is currently set at this color depth.
Using colors other than white, black or gray for background may result in increased size
of raster files or PostScript files in 3D modes. In some cases a simple run-lengthencoding method is used for compression of these files (see below), and this fails for 24bit RGB (true color) files when the three components are not identical. That is, for a row
of white pixels the sequence of bytes is 255, 255, 255, 255... whereas for a row of red
pixels it is 255, 0, 0, 255, 0, 0...
The images will look much the same as a screen image, except that for black-and-white
files gray shades are always rendered as dot patterns, and there is a choice of coarse or
fine patterns, as for printing (see the Print dialog in the File menu). Fine patterns are
appropriate for small images which will not be reproduced photographically, or for
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images which will be shown on the screen only; coarse patterns mimic halftone screens
used in printing, and generally reproduce better photographically, especially when the
image is reduced in size. Note that this coarse/fine setting is the same as that in the Print
and Metafiles or PICT files dialogs in the File menu.
If the Compress box is checked,.TIF files are compressed with run-length encoding,
which is one of the required formats under the TIFF 6.0 standard. However, some
applications may not support this type of compression, or may reject.TIF files for other
reasons. Also, if the Compress box is checked, 4- and 8-bit.BMP files are compressed.
1-bit and 24- bit.BMP files are never compressed. Owing to a Windows system bug,
compression of 4-bit.BMP files may not work when banding is used (see below). .PCX
files are always compressed. with their own format. 24-bit.PCX files can compress well,
whereas 24-bit.TIF files are only partially compressed (and then only if there are large
areas of black, white or grey), and 24-bit.BMP files are not compressed at all. PNG files
also are always compressed.
See Frames for details of the frame and frame units.
Maximum memory. Windows and Macintosh both use virtual memory, which means
that they pretends that a hard disk can be used in place of actual hardware memory chips.
For some applications this is useful, but when writing raster files it usually results a form
of lingering death involving "disk thrashing", or constant reading and writing of data to
the hard disk.
ATOMS is capable of imaging and writing raster files in segments or bands to avoid this
problem. This requires repeating the entire drawing process for each band, but this
usually is much faster than the reading/writing to disk involved in using virtual memory.
To do this requires knowing how much actual chip memory is available. Unfortunately,
at present Windows does not provide this information in a way that can be used for both
16- (standard Windows 3.1) and 32-bit (Windows 95 or NT) systems. Thus the user may
need to determine this by trial and error using the Maximum memory parameter.
When the Maximum memory parameter is set to zero, ATOMS will simply ask the
system for a block of memory large enough to image the entire drawing at once. This
amount of memory is printed out in the dialog which appears after starting the raster
imaging: "nnnn bytes required, mmmm bytes available - will require 1 bands". If this
amount of memory is greater than the amount of chip memory available, Windows will
use virtual memory, which is typically manifested by constant running of the hard disk for
long periods (disk thrashing). If you change the Maximum memory to some amount
smaller than nnnn (say half), ATOMS will only request this amount of memory from the
system, and virtual memory may not come into play. A Maximum memory setting
should be good for a given session, regardless of the size of the raster file; larger files will
use more bands. However, the amount of memory available may depend on whether
other applications are active.
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The amount of virtual memory is determined by the available space on the hard disk. If
this is insufficient, ATOMS will automatically use bands, but since virtual memory is
being used, it may still be advantageous to use a Maximum memory value which will
increase the number of bands.
Selection of File Format. The choice of format depends first of all on what formats are
supported by the target software (paint program; publishing program; etc.). Beyond this
the first choice should be PNG, second choice PCX, and then PICT, TIF or BMP
depending of what is supported and how much memory or disk space is available.
As of 1997, the preferred graphics file types for the internet were GIF and JPEG.
However, GIF uses the LZW compression scheme copyrighted by Unisys Corp., which in
principle charges a license fee for every application using it. JPEG files are compact but
involve losses and degradation of the image and are thus not suitable for ATOMS files.
The PNG format is intended to be a replacement for GIF, and in fact is superior to most
other formats, being lossless and giving very good compression for the type of images
generated by ATOMS (although 3D images do not compress as well as standard-mode
images). Essentially all major software vendors have subscribed to the PNG convention
and releases from 1998 onward should support it.
Most TIF files also use LZW compression, but ATOMS does not use this type of
compression because of the copyright problem. The run-length-encoding which ATOMS
does use is supposed to be supported by all TIF readers, but in fact some do not support
it, and this algorithm does not work well for 24-bit (RGB) images.
PICT bitmap files on the Macintosh are compressed by the system software and the
algorithm may vary. PNG files are usually smaller.
There are dozens of raster graphics formats and it will never be possible for ATOMS to
support all of them. ATOMS users who work with raster files should consider investing
in a conversion program - there are many such programs which are not expensive. The
PNG home page (www.cdrom.com/pub/pnp) has links to many shareware and
conventional commercial conversion packages.
3.2.1.15

Clipboard/PICT (Mac)

Dialog Box: Clipboard/PICT [ File menu]
------ Macintosh Only ----------

Note that this type of output may be referred to elsewhere as Metafile output. This
option can write images either to the Clipboard or to PICT files, in either of two formats:
(a) a rescalable 2-dimensional Picture or metafile, or (b) a raster image or bitmap. For
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the 3D Drawing mode, this option writes a two-dimensional image and only bitmaps are
available, but see the VRML Files and POV-Ray options for files which actually contain
three-dimensional data
Macintosh Pictures, as used here, are images containing lines or vectors and fills of
regions defined by lines, that can be rescaled without necessarily losing resolution. They
record the drawing commands that are used for the screen or standard printer output, but
the result may depend on the software or device in which they are used.
Bitmaps or raster images record every pixel, so they are not susceptible to undesirable
modification by other software. Although most "painting" software can resize bitmaps,
this usually causes a loss of quality, so it is best to save a bitmap in exactly the desired
size. Note that you can also save bitmaps in the PNG file format (File menu), which is
superior is some respects to PICT files.
If color output is selected, you can choose either 16- or 32-bit color depth - 8-bit (256color) files cannot be written.
You can select the nominal dots per inch/centimeter, but note that programs which read
the file may ignore this and show the image at 72 dots per inch.
Background color. If this option, which applies only to PICT output, is on, the color
selected in the Background Color dialog of the Input2 menu will be applied in color
output only. Background in b/w output is always white.
In the 3D drawing mode PICT (bitmap) output always has 32-bit pixel depth.
See Frames for details of the frame and frame units.
3.2.1.16

Metafiles (Windows)

Dialog Box: Metafiles [ File menu]
--- Windows Only ----------

Windows metafiles are basically vector images (but including fills) that can be rescaled
without necessarily losing resolution. They record the drawing commands that are used
for the screen or standard printer output, but the result may depend on the software or
device for which they are intended. You can write.EMF files or send the image to the
clipboard. ATOMS no longer supports the 16-bit.WMF format. Enhanced metafiles
(.EMF) are 32-bit format files which also contain scaling information. They are the
preferred type of metafile for use in 32-bit Windows systems, but cannot be used in
standard 16-bit Windows 3.1or Win32s.
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The type of image written by this option is strictly two-dimensional. It is also possible to
write files containing three-dimensional images with the VRML Files and POV-Ray
options.
To prevent loss of resolution, ATOMS writes metafiles with a standard scaling of 2540
dots or pixels per inch (1000/cm).
Background color. If this option is on, the color selected in the Background Color
dialog of the Input2 menu will be applied in color output only. Background in b/w
output is always white.
Use ATOMS b/w patterns. Rather than use gray-scale values for fills, ATOMS can also
send its own dot patterns, which have been carefully designed for its purposes in two
series, Coarse and Fine. Note that this coarse/fine setting is the same as that in the Print
and Raster dialogs in the File menu.
Gray lines of greater than one-dot width are always drawn by filling an outline with one
of the ATOMS patterns - gray-scale values are not used because few printers will directly
print gray lines, at least under Windows 95. Thus the coarse/fine setting is always used
for wide b/w lines.
See Frames for details of the frame and frame units.
3.2.1.17

Save Graphics Window

Dialog Box: Save Graphics Window [ File menu]
This command writes a bitmap giving exactly what is shown inside the current graphics
window.
This option is appropriate for applications which will use the image on the screen. For
applications which will use a printed or other high-resolution image, either the
Raster Files or Metafiles (Windows) or PICT (Macintosh) options will usually give better
results.
---Windows Only ---------

This will save a Device-Independent-Bitmap (DIB) either to the clipboard or to a.BMP
file.
You can also copy the current window to the clipboard with the Print Screen key (this
is a standard Windows function). However, this includes the window title bar and border
and parts of overlapping windows, whereas the Screen to Bitmap command only copies
the graphics part or the client area.
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---Macintosh Only --------

This will save a PICT file as raster, or put the image in the clipboard.
---End Windows/Macintosh Only --------

3.2.1.18

VRML Files

Dialog Box: VRML Files [ File menu]
Virtual Reality Modeling Language files were intended for exchange of virtual reality data
on the Internet. However, they have become a de facto standard for interchange of 3D
data of all types.
ATOMS currently supports V1.0 ascii files.
VRML files can be viewed with Internet browsers for either Windows or Macintosh,
using plug-ins such Cosmoplayer (www.cosmosoftware.com). Since the files are text,
they can also be viewed on SGI and other UNIX systems. 3D Exploration
(www.righthemisphere.com) is a stand-alone viewer for Windows which is independent
of Internet browsers.
Most of the settings for 3D display mode (3D Parameters dialogs, Input2 menu ) apply to
VRML files, although there is little control of lighting (the viewer application or plug-in
usually controls this, although most viewers offer few choices). Thermal ellipsoids may
be drawn in VRML files, as selected in the 3D - General dialog or the
Ellipsoid Parameters dialog, Input2 menu. Thermal ellipsoids are always solid, without
the cut-out octant which is possible in direct screen or print drawing, and bonds are
always cylindrical, not tapered.
If the buttons in this dialog are used to change 3D settings, these changes will also apply
3D Display mode on screen and in output.
For the latest information on crystallographic and molecular-modeling applications of
VRML see http://193.49.43/dif/3D_crystals.html or http://fluo.univlemans.fr:8001/vrml/intvrml.html.
3.2.1.19

POV-Ray File Output

Dialog Box: POV-Ray File Output

[ File menu]

POV-Ray is a program which draws a 3D image pixel-by-pixel, calculating all possible
light-ray paths. It allows for much more elaborate lighting effects than the OpenGL
software used in the 3D mode in ATOMS. Some obvious effects are shadows and
refraction but there are many possibilities. Backgrounds and other objects may be added
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as well. The files are text (ASCII) and may be edited.
Since the calculation is much more elaborate than that done by OpenGL, this is not a
method that can be used for real-time display on the screen - POV-Ray images may take
many minutes to complete.
The POV-Ray package, with instructions, samples, etc., may be obtained from
www.povray.org.
While adding shadows to ball-and-stick or space-filling structure drawings may make
them more "realistic", it also may tend to complicate things. Shadows are usually most
beneficial to Cavities mode drawings of crystals. The default output from ATOMS has
shadows, but this can be changed by adding the keyword "shadowless" after the color
definition in the "light_source" definition near the beginning of the file.
See Frames for details of the frame and frame units.
3.2.1.20

Exit/Quit command

Exit [Windows] or Quit [Macintosh] command [ File menu (Startup) or File menu
(Graphics) ]
Use this command to end your ATOMS session.
If you have changed the orientation from that specified in the Initial Orientation dialog in
the File2 menu, you are asked if you want to save the current orientation. If you choose
to do this, the current orientation will be converted to initial orientations on the observer
x, y and z axes. If clinographic viewing is in effect at the time of saving, the initial
clinographic viewing flag will be turned on. The initial rotations can be changed or
deleted in the Initial Orientation dialog in the Input2 menu. See also
Coordinate Systems.
ATOMS also checks whether any dialog in the Input1 and Input2 menus have been
opened, or whether there has been any change in the status of atoms marked for nonplotting (see Deleting Atoms).
3.2.2

Input1 Menu (Graphics Window)

Note: if the screen is narrow, this may be a submenu in the Input menu.
Title/Structure Axes - Title and axial system (unit cell for crystals).
Symmetry - Symmetry of the structure.
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Boundary - Boundaries for limiting the reproduction of atoms by lattice vectors.
Display Faces - The optional crystal faces for display surround the structure - they can
be the same as boundary faces, or different.
Atoms - The coordinates and other attributes of input atoms.
Polyhedra - Specifications for locating polyhedra, and display attributes.
Bonds - Specifications for locating bonds, and display attributes.
Atoms - Global - This allows changing the radius, colors etc., of all input atoms, or
specified subsets, at once.
Atomic Vectors - This specifies general attributes of vectors for magnetic spins or
vibrational displacements or other purposes.
Vibrational Modes - For data sets originating from the VIBRAT program, this allows
selection of individual vibrational modes..
Cavity Parameters - This sets the parameters for showing "open spaces" in the Cavities
display mode.
3.2.2.1

Title/Axes

Dialog Box: Title/Axes [ Input1 Menu]
The title may have up to 80 characters of identifying information.
The axial system determines the type of coordinate axes for crystal faces (if present) as
well as atoms. If you are drawing a molecule you will probably want to choose Unit
Cartesian axes unless the symmetry is trigonal or hexagonal - see sections IV-5 and IV6 of the instructions.
If you choose a crystal system you must supply the axis lengths and interaxial angles
appropriate to the crystal system you selected. Axis lengths should be in Angstroms, and
angles in degrees and fractions (not minutes and seconds). If you are entering a new
structure, the unique angle for the monoclinic system is always called beta at this point.
However, in the Symmetry options the selection of space or point group may change this,
and if you return to the Title/Axes dialog the correct angle should be shown. If the
angles are still incorrect you can use triclinic axes.
Although standard crystallographic nomenclature gives the same letter (usually a) to
symmetry-equivalent axes, after the initial input ATOMS may call all axes, whatever the
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system, "a, b, and c" and angles "Alpha", "Beta" and "Gamma".
If the Print title on plot box is checked, the title will be shown in the lower left on all
display and output (of the structure, not the Powder or Precession patterns). If the Scale
box is checked, the lettering on print and file output will be scaled to approximately the
same relative size compared to the drawing as it is on the screen.
Use PostScript font. This allows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and slant (italic, oblique) of the font, but not the size, which is specified in
the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.
3.2.2.2

Symmetry

Dialog Box: Symmetry [ Input1 Menu]
The authority and source of information for crystal symmetry is normally the
International Tables for X-ray Crystallography. However, any point- or space-group
symmetry may be used for the atoms. There are several options for selecting or entering
symmetry information.
Space group from table

- Choose a space group by symbol or number.

Point group from table - Choose a crystallographic point group.
Cartesian matrices - Use non-standard or non-crystallographic point symmetry.
Custom point or space group - Enter all the individual operators.
Use no symmetry - Use no symmetry at all. Check Crystal to enable lattice
translations - the space group will be P1.
Except for the last option, Use no symmetry, each choice calls up a sub-dialog.
3.2.2.2.1 Space-Group Symmetry, Basic Tab
Dialog Box: Symmetry - Space Group from Table: Basic Tab [ Symmetry dialog]
Starting with V4.0 of ATOMS, space-group symmetry is obtained using licensed excerpts
from the SGInfo program of Ralf Grosse-Kunstleve. This allows more complete selection
of alternate orientations and origins than in previous versions of ATOMS, and also
Shubnikov black-and-white symmetry.
You can specify the space group in any of three ways: 1) the Hermann-Maughin (H-M)
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or International symbol; 2) the Hall symbol (S.R. Hall: Acta Cryst., A37, 517, 1981); or
3) the number of the group in the International Tables for X-ray Crystallography.
International Tables Volume. You have the option of using the older version of the
Tables (called the Second Edition: various revisions and reprints from 1952 to 1979) in
which the symmetry information was in Volume I, or the newer version (1983 onwards)
in which it is in Volume A. The principal difference between the two versions is that in
the older one the unique axis of a monoclinic group is assumed to be the c-axis, whereas
in the newer one it is assumed to be the b-axis. Thus entering the symbol P2/m gives two
different orientations depending on the volume selected. You can always specify the
orientation by entering the long form of the symbol, i.e. P 2/m 1 1, P 1 2/m 1 or P 1 1
2/m.
The H-M symbol can be typed into the edit box in either short form or long form, with or
without spaces between positions. However, it is usually safer to select the symbol from
the list box at the bottom, which gives the standard-form symbols for all the spacegroups. Clicking the Select button copies the relevant data to the edit boxes at the top; it
does not actually generate the symmetry. Symmetry generation is done after you click OK
- this may take a few seconds. If the space group you select does not appear to be
consistent with your choice of axes, a warning box appears, but in most cases consistency
is not required. However, if you selected trigonal rhombohedral axes in the Title/Axes
dialog, only a rhombohedral space group may be selected. This is done by adding :R to
the end of the symbol in the case of H-M symbols, or asterisk (*) in the case of Hall
symbols. This is a change from versions of ATOMS previous to V4.0, in which the
orientation of the space group was automatically determined from the Title/Axes dialog.
If you select the rhombohedral setting and then switch to the Custom symmetry option,
the lattice type will be P; it will be R if the axes are hexagonal.
Origin of coordinates. In the International Tables, 24 space groups in the
orthorhombic, tetragonal and cubic systems are given with a choice of origin: 1) not on a
center of inversion or 2) on a center of inversion. These two origins are selected by
adding :1 or :2 respectively to the end of the H-M symbol or the number. Although the
origin on the center is second in the Tables and in the list, if the number is omitted this
will be the default. This difference in origin is explicit in the Hall symbol, and other
choices of origin may be specified for any space group with the Hall symbol.
--------------------------------------Shubnikov Symmetry. You can use Shubnikov black-and-white symmetry to show
magnetic or other properties of crystals. If you choose this option you must enter at least
some of the relevant parameters in the Shubnikov Tab. You enter the Shubnikov spacegroup symmetry using modified versions of either the H-M or Hall symbols. After
entering the Shubnikov symmetry in the Basic Tab, you can check the Shubnikov lattice
type and basis operations in the Shubnikov Tab after clicking OK or Apply. The H-M
symbol is modified in the standard way, by a) adding a subscript (actually a postscript) to
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the lattice symbol; or b) adding a prime or apostrophe to the individual "positions" or
basis operations in the symbol. To enter a Shubnikov symbol you must separate the lattice
symbol and the individual positions by at least one space or underscore. The entries in the
list box already have these separations, so it is advisable to select one of these and then
edit it. The Hall symbol is modified in a similar way, but instead of using a prime you
must use the "^" character. An initial minus sign on the Hall symbol signifies a center of
inversion - if you want to assign Shubnikov inversion to this center, add "^" to the lattice
symbol, not to the minus sign.
Standard H-M Shubnikov lattice symbols use both lower- and upper-case subscripts A,
B, C for "color" face centering, and a, b, c for edge centering. In ATOMS a capital letter
will always indicate face centering, and either lower-case a, b, c or x, y, z (or X, Y, Z)
will indicate edge centering. Note that there is little checking for self-consistency, either
for input through the symbol or explicit operators in the Shubnikov Tab. The user is
responsible for entering a valid Shubnikov space group.
Shubnikov inversion is considered to apply to the spin of a magnetic atom, rather than
directly to the vector which shows the magnetic direction. This means that improper
operations, including a center of inversion, planes of symmetry and improper (bar) axes,
result in inversion or reversal of the magnetic spin vector when the operation is not
primed or Shubnikov, and no inversion when the operation is primed or Shubnikov. Of
course, the resulting spin-vector orientation depends also on the orientation of the spin
with respect to the symmetry operator - when the vector is parallel to an axis or plane the
result is completely different from when it is perpendicular. ATOMS can apply Shubnikov
symmetry in this way, or in certain other ways - see the Shubnikov Tab.
Magnetic or other Shubnikov symmetry normally involves entries in three different
places:
1) The Space Group from Table symmetry option (this dialog), including the
Shubnikov Tab;
2) The Atomic Vectors dialog (Input1 menu), to set the display parameters of the
vectors; and
3) the Revise Atom dialog, Vector Tab for individual input atoms, to set the orientation
of the vectors on the atoms.
-----------------------------------------------------------------Molecules. It may sometimes be desirable to use the Space Group symmetry option for a
molecule rather than the Point Group option because in some point groups you can select
different orientations of the symmetry operators with respect to the coordinate axes by
choosing the operations from different space groups. Space-group operations are
applicable to point groups, provided there are no translations - that is, you cannot use
space groups with screw axes, glide planes, or non-primitive lattices. For example, in
number 111, P42m - D2d1 the mirror planes are 45 degrees from the structure axes,
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whereas in no. 115, P4m2 - D2d5, the mirror planes are parallel to the axes. If you
choose the Point Group symmetry option and enter the point group 4m2 - D2d, the first
of these orientations, as in number 111, will always be used. These two space groups
actually differ in other ways than the 45 degree rotation, but this is irrelevant if the
operations are used without lattice translations. The choice between the two space groups
depends on the relative orientation of coordinate axes and symmetry elements. In this
case, if an atom lies on a 2-fold axis it will belong to a set of four (rather than eight if it
does not lie on any symmetry elements). For no. 111, such atoms will have coordinates
like x,0,0, whereas for no. 115 they will be like x,x,0.
In the trigonal, hexagonal and tetragonal systems several space groups have alternate
orientations at 30 or 45 degrees from each other as in the case of D2d. If the symmetry
for a molecule is specified with the Point Group option, the "standard" orientation is
generated. One may access the alternate orientation by the Space Group option and
giving the alternate space group as follows (a B before a number indicates a "bar" or
inversion axis:
Standard Orientation

Alternate Orientation

42m - D2d

PB42M (no. 111)

PB4M2 (no. 115)

32 - D3

P321 (no. 150)

P312 (no. 149)

3m - C3v

P3M1 (no. 156)

P31M (no. 157)

32/m - D3d

PB3M1 (no. 164)

PB31M (no. 162)

6m2 - D3h

PB6M2 (no. 187)

PB62M (no. 189)

You can also use this symmetry option to select a non-standard setting for monoclinic or
orthorhombic point groups as
discussed in the previous section. For example, you can cause the unique axis of groups 2
- C2, m - Cs or 2/m - C2h to be either a, b or c (the standard setting for ATOMS is
unique axis b). You can also cause the 2-fold axis of mm2 - C2v to be parallel to any of
the three structure axes. If you do choose this option, using space-group operations for a
molecule, be sure that the space group has no screw axes or glide planes, and has a
primitive Bravais lattice.
3.2.2.2.2 Space-Group Symmetry, Shubnikov Tab
Dialog Box: Space-Group Symmetry: Shubnikov Tab [ Symmetry Dialog]
ATOMS uses several tools for description and depiction of magnetic structures, loosely
gathered in the "Shubnikov" tab.
These tools include 1) constant vector orientation for all atoms in a site; 2) full Shubnikov
symmetry in that the vectors themselves obey the full specified symmetry; 3) Shubnikov
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symmetry with vector orientations remaining constant except for inversion; and 3) lattice
inversion or magnetic supercells independent of Shubnikov symmetry.
Magnetic or other Shubnikov symmetry may involve entries in three different places: 1)
The Space Group from Table symmetry option, including the Shubnikov Tab (this
dialog); 2) The Atomic Vectors dialog (Input1 menu), to set the display parameters of
the vectors; and 3) the Revise Atom dialog, Vector Tab for individual input atoms, to set
the orientation of the vectors on the atoms.
In the upper part of this dialog, the methods of Display and Application of the
Shubnikov symmetry are selected.
Display:
1) Labels +/-. In this mode, only the two "colors", signified by the +/- symbols, are
shown. Select the size and other properties of the symbols with the dialog called up by
the Labels button. Caution : this option may not be suitable for showing Shubnikov
magnetic symmetry. Whether or not an atomic vector is reversed or inverted by the
combination of ordinary and Shubnikov symmetry depends on the orientation of that
vector with respect to the symmetry operator. Most published diagrams of magnetic
structure using black and white or + and - atoms are not actually showing the Shubnikov
inversions, they are showing symbolically the reversals of spin vectors which are typically
in special orientations. If you want to show arbitrary black/white inversion which does
not conform to Shubnikov symmetry, you can simple draw up a normal structure, convert
Generated to Input (Transform menu) and recolor individual atoms as desired.
2) Vectors - reversal only. In this mode, each input atom has a vector, but the
orientation is constant except that the direction may be reversed by the Shubnikov
operators. This is not what most workers seem to understand by Shubnikov symmetry
applied to atomic spin vectors, but it can be useful in illustrating many magnetic
structures or in non-magnetic applications. Especially, it can be used to align all atoms in
a particular site in the same direction, regardless of space-group symmetry. To do this,
you should also uncheck the Shubnikov box in the Space-Group Symmetry: Basic Tab.
Virtually any commensurate magnetic structure can then be illustrated by converting
Generated to Input (Transform menu) and reversing or otherwise reorienting the vectors
manually. When in the Input=generated mode, clicking on a magnetic atom brings up a
dialog which has a button for vector reversal or inversion.
3) Vectors - full symmetry. In this mode, the orientation of the vector on each
generated atom is subject to all symmetry operations, both standard and Shubnikov
reversal.
Application :
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1) Magnetic. Shubnikov inversion is considered to apply to the spin or electric current
loop of a magnetic atom, rather than directly to the vector which shows the magnetic
direction. This means that improper operations, including a center of inversion, planes of
symmetry and improper (bar) axes, result in inversion or reversal of the magnetic spin
vector when the operation is not primed or Shubnikov, and no inversion when the
operation is primed or Shubnikov. Of course, the resulting spin-vector orientation
depends also on the orientation of the spin with respect to the symmetry operator - when
the vector is parallel to an axis or plane the result is completely different from when it is
perpendicular.
2) Dipole or Black/White. In this case the inversions are applied directly to the vectors,
not to the spin or electric current loops. Thus improper operations result in no inversion
or reversal of the vector when the operation is not primed, and inversion when the
operation is primed. This type of symmetry could be applied to atomic dipoles, or to
displacements, for example.
See the table below for the various combinations of Display and Application.
Set the overall properties of atomic vectors with the Vectors dialog called up by the
Vectors button; set the orientation of the vector for each input atom in the
Revise Atom: Vector Tab. Whether each input atom has a Shubnikov reversal at all is
also set in the Revise Atom: Basic Tab. In general, not every input atom is Shubnikov or
even can be Shubnikov in display modes 1) and 3). The orientation of vectors in special
positions may be restricted. Black-white reversal itself may be forbidden in some special
positions. Such positions should be identified during the calculation and marked as nonShubnikov.
Shubnikov Operators. This section of the dialog summarizes the information obtained
from the Shubnikov symbol in the Basic Tab. The possibilities for the Shubnikov lattice
type or Lattice centering are lower-case a, b, or c, indicating translation reversal in the
respective axis direction, or S, indicating reversal on all three directions; or upper-case A,
B, or C indicating a Shubnikov centering of the respective faces, or I, indicating
Shubnikov body centering.
For non-translational Shubnikov symmetry, the possibilities are Inversion, and either
Rotation parallel to, or Reflection perpendicular to any of the three axis directions. If
present, rotation and reflection are indicated by capital letters A, B and/or C. The face
diagonal [110] direction, indicated by AB, is also possible in high-symmetry crystals. The
body diagonal [111] direction is not a possible Shubnikov operator orientation as it can
only have a three-fold axis.
Note that there is little checking for self-consistency of Shubnikov operators. The user is
responsible for entering a valid Shubnikov space group.
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Table showing possibilities for Display and Application of Shubnikov symmetry
+/-

Reversal Only

Full Symmetry

Magnetic

bc

bc

abc

Dipole

bd

bd

abd

a) Operate on vector with ordinary space-group symmetry
b) Proper operators (lattice and non-bar axes) - reverse if primed, do not reverse if
unprimed
c) Improper operators (inversion, reflection, bar axes) - reverse if unprimed, do not
reverse if primed
d) Improper operators (inversion, reflection, bar axes) - do not reverse if unprimed,
reverse if primed
Reverse means to change vector direction by 180 degrees, or to change + to - or viceversa. The ordinary space-group symmetry operations are always applied to the positions
of the atoms.
Lattice Inversions or Magnetic Supercell. This option is not actually part of
Shubnikov symmetry, but it offers a simple means of describing many magnetic
structures, either by itself or in combination with Shubnikov operators, often without
changing the unit cell and overall symmetry from what describes the non-magnetic
structure.
Checking one of the boxes causes all magnetic vectors to reverse with each translation on
that axis. This normally results in a doubled magnetic axis or cell edge in that direction.
When more than one lattice inversion is selected, the operations are applied successively.
For example if there is inversion on a and b axes, the 100 and 010 unit cells have
inversion, but the 110 unit cell does not.
If the unit cell is non-primitive you can use inversion on either the Bravais axes or the
primitive axes, but not both.
Note that the Default Unit Cell boundary option uses the non-magnetic Bravais axes, not
the doubled magnetic axes. To show the reversals adequately it may be necessary to
select the -1 to 1 inclusive option in the Default Unit Cell boundary option, or to use the
Translation Limits boundary option.
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This option is definitely not the same as using non-primitive Shubnikov lattices, and is
apparently equivalent to specifying a magnetic "wave vector". Compare the samples
FCCMAG, FCCMAGR, and FCCFULL_II for different ways of showing Type II FCC
(MnO) magnetic structure - the most concise is FCCFULL_II which uses inversions on
all three primitive (face-centering) lattice translations, with the full Fm3m X-ray
symmetry of MnO.
See also the CRCL2MAGD sample, which uses magnetic lattice inversions on two axes
in combination with a Shubnikov space group Pnnm' which is simply related to the nonmagnetic group Pnnm.
Irreducible Representations. ATOMS could in principle be programmed to use the
method of description of magnetic structures by means of the irreducible representations
of space groups, as pioneered by Bertaut and others and described in the book by
Izyumov, Naish and Ozerov (Neutron Diffraction of Magnetic Materials). This has
obvious theoretical advantages over the ad hoc methods now used in ATOMS, but there
are practical difficulties in that the representations are numbered in an arbitrary way and
and must refer to an essentially arbitrary order of symmetry operators. A description of
this type can be concise but it may convey little without reference to a standard
compilation such as that of Kovalev.
If there is sufficient interest, using irreducible representations might be attempted in
ATOMS.
3.2.2.2.3 Magnetic Labels
Dialog Box: Magnetic (Shubnikov) Labels [ Space-Group Symmetry Dialog]
The only characters which will be shown are the symbols + and -. The choice between
showing these symbols and atomic vectors is made in the Space-Group Symmetry
dialog, Shubnikov tab.
If the Background is opaque, each symbol will lie on a small block of the designated
color; this usually makes the labels easier to read. Some other programs may not be able
to reproduce these opaque blocks in Metafiles or PICT file output.
Sequence. The labels may be plotted immediately after each atom, or all at once after all
atoms have been plotted. The first usually looks better, but some labels will usually be
partly or completely obscured.
Use PostScript font. This allows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and slant (italic, oblique) of the font, but not the size, which is specified in
the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.
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The label positions are correct for stereopairs, and labels for central atoms of polyhedra
will appear suspended in the interior of the polyhedra.
Use the color options in this dialog, not the color options in the Font dialog to set the
color of the letters. Letters are always solid black in black-and-white display or output.
See Input Colors/Patterns/Pens for general aspects of color input.
Labels are not supported for Pen Plot output.
3.2.2.2.4 Point-Group Symmetry
Dialog Box: Symmetry - Point Group from Table [ Symmetry Dialog]
This is the simplest symmetry option for a molecule, provided the symmetry is
crystallographic and atomic coordinates conform to standard orientations. It is not
applicable if the symmetry is icosahedral, pentagonal or other non-crystallographic type,
or trigonal or hexagonal if Cartesian axes are used; choose the Cartesian matrices
symmetry option in any of these cases. If the symmetry is crystallographic, but the
orientation is non-standard, it may be possible to use the Space group option.
To use this option, click on the point group symbol; symmetry operations will then be
taken from a space group belonging to the given point group in the International Tables ;
the space group chosen will have a primitive lattice, no screw axes or glide planes, and
the standard orientation of axes. Usually, but not always, this is the one with superscript 1
on the Schoenflies symbol. In the case of monoclinic groups (2 - C2, m - Cs or 2/m C2h), the first setting (unique axis parallel to c) is standard: this is different from the
standard for settings of monoclinic crystals in the Title/Axes dialog in the Input1 menu,
but when you select the point group the unique angle will be applied to the proper axes.
For group mm2 - C2v the 2-fold axis is parallel to c. For groups with 3-, 4- or 6-fold
axes, the unique axis is c, but there may be alternate orientations at 30 or 45 degrees from
one another: see the Space group option for the standards and how to access the
alternate orientations using space-group operations.
3.2.2.2.5 Cartesian Symmetry
Dialog Box: Symmetry - Cartesian Matrices [ Symmetry Dialog]
This symmetry option, for point symmetry only, assumes that Cartesian axes are in use,
although it will work in any structure with axes at right angles. It is the only option
applicable to non-crystallographic symmetry, and it can be used if desired in any other
case. However, it is usually easier to use one of the other options for crystallographic
symmetry, with the possible exception of trigonal and hexagonal molecules if the given
coordinates are on Cartesian axes.
This option requires a file containing the Cartesian symmetry matrices. The auxiliary
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program SYMGRP writes files which are normally given the suffix.SYM. If you type the
name into the edit box, give the full name of the symmetry file, including the.SYM suffix.
Some such files, namely those for pentagonal (C5, S10, D5, C5v, C5h, D5h and D5d)
and icosahedral (I and Ih) point groups, have already been provided. For other point
groups, it will be necessary to run the auxilliary program SYMGRP to generate the file
before running ATOMS; see section IV-7 of the Instructions.
The Get Symmetry button reads the file and fills out the symbol, number of matrices and
centric/non-centric state, which are printed out below the file name.
The file name as entered in the edit box is saved in the data file for the structure. If the
complete path is not given, the Cartesian symmetry file should be in the same directory as
the data file. If the file cannot be found when the structure is calculated, you will get an
error message and a chance to locate the file with a standard file dialog. The complete
path name, as determined in this way or with the Browse button, will then be saved in the
data file.
3.2.2.2.6 Symmetry - Custom
Dialog Box: Symmetry - Custom [ Symmetry Dialog]
ATOMS can access all the standard orientations for space groups in the International
Tables but there are still a few possibilities for alternate settings of symmetry elements
with respect to structure axes which are not listed in the Tables. In some cases
displacement, rotation or permutation of atomic coordinates may not be convenient, and
it may be easier to enter the symmetry operations for the non-standard setting. These are
sometimes given in reports on structures (e.g. Wyckoff, Crystal Structures). Note
however that often only the operations for special positions are given: ATOMS needs all
the operations for the general position.
The Symbol is for your reference only - it is not used by ATOMS, unless you click the
Get Symbol button (below).
Get Symbol. This button will attempt to identify the space group from the operations,
the lattice type and the centric/acentric setting. If the operations contain an inversion
center or lattice centerings, they should be identified and can be removed at your option.
If you specify centric, rather than acentric, you must enter only half of the symmetry
operations, related to any others by the center. The two sets or halves of the operations
related by the center will have opposite signs on the x, y and z coordinates.
The Bravais lattice type is in most cases the capital letter which begins the space-group
symbol. However, ATOMS uses a somewhat different convention from the standard for
trigonal crystals: if you are using hexagonal axes for a rhombohedral crystal (whose
standard space group symbol will always begin with "R"), enter "R" - if you are using
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the primitive rhombohedral axes, enter "P". Enter "P" for a molecule.
If the group is monoclinic, you should specify which is the Unique axis. This is normally
c for a molecule and b for a crystal. The angle specified in the Title/Axes dialog will then
be applied correctly, the other two interaxial angles being set to 90 degrees.
In the Operations group, you must enter all the "symmetry operations" for the most
general position in the structure. Click on the Add Operation button to add an operator,
or Delete to remove an operator. The operation which is selected in the Operations list
box is available for editing in the box to the right. Note that earlier versions of ATOMS
allowed several operations per line; currently, there should be only one operation per line.
Semicolons at the end of each operation (line) are optional.
It is assumed in the following that you will be using data listed in the International
Tables, but this is only for purposes of illustration; if you find it necessary to enter the
operations through this dialog, you will very likely be using data from another source.
Reports on crystal structures, especially older ones, often list the relevant operations in
the same format as the Tables.
In the Tables, the "Co-ordinates of equivalent positions" can be regarded as operations
(or at least the operations can be easily derived from them). These coordinates occupy
the middle of the page in each space-group entry in the Tables, and the general position is
the uppermost group. The general position has the point symmetry 1, and the list of
operations for this position always begins with "x,y,z;". The individual operations are
separated in the Tables by semicolons.
Copy these operations, including the commas (semicolons optional), one per line. They
are entered just as given in the Tables, except that a negative sign, indicated by a small
bar over the letter in the Tables, must be indicated with a minus sign in front of the letter.
The first operation, "x,y,z;" is present in all symmetry groups and must always be entered.
Ignore the translations for non-primitive lattices (e.g. 0,0,0; 1/2,1/2,1/2) which may be
listed in the Tables above the operations; these are taken care of if you enter the proper
Bravais lattice symbol. Some older structure reports may include lattice-centering in the
equivalent positions.
Important: if you have specified a centric space group with origin on the center of
inversion, you should omit half the operations, which are related to the other half by the
center (opposite signs for x, y and z coordinates). If you have difficulty making this
separation, you can specify non-centric and enter all the operations. The Get Symbol
button should detect a center of inversion on the origin, and remove it if desired.
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Boundary Option

Dialog Box: Boundary Option [ Input1 Menu]
For crystals and polymers, some limitations must be applied to the repetition of atoms by
means of the lattice translations. Ten choices are available, as listed below. Note that the
first three are not usually applicable to molecules, while the fourth, No Boundaries, is
not applicable to crystals. There is an additional boundary option and operating mode,
Input atoms = generated atoms, which is only accessible by choosing
Generated to Input in the Transform menu.
-------------------------------------Options applied to individual atoms :
Default Unit Cell - Offers five sub-options to outline a volume with the same faces as
the unit cell.
Enter Forms - Use specified crystal faces for the boundaries.
Slice - Isolate a slab of the structure parallel to a given face, with thickness equal to the
d-spacing (or multiple thereof).
No Boundaries (molecule) - Use no boundaries at all. This option is primarily for a
single molecule not in a crystal structure, not isolation of molecules in a crystal structure
(see below).
Translation Limits (polymer) - Use integral numbers of unit cells.
Sphere - Include all atoms within a given distance of a given point (or atom).
The Unit Cell and Slice options always use lattice translations in all three axis directions,
and the No Boundaries option never uses lattice translations. The Translation Limits
option, primarily intended for polymers, allows you to specify which axis directions use
lattice translations. The Enter Forms option also allows disabling of any of the lattice
translations.
---------------------------------------Options applied to groups of atoms (molecules) in crystals.
In all these options, molecules or other bonded groups within the unit cell are located,
and the center point of each group is found by taking a non-weighted average of the
atomic positions. Then the selected boundary method is applied to these molecular
centers.
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Atoms within molecules or groups must be connected by Bonds or Polyhedra, and there
must be no standard bonds or polyhedra connecting atoms of different molecules.
However, bonds can be specified as inter-molecular, so that they will not be used in the
molecule-locating algorithm but will be displayed.
Note that these options are not applicable to 1- and 2-dimensionally continuous groups
(polymers) - bonding must be discontinuous in all three lattice directions. In order to
isolate polymers, it is necessary to first use one of the six options above, then click on an
atom in the polymer and use the Find button in the Generated Atom Data dialog, or use
the Locate Groups option in the Transform menu. See
Dealing with Molecules, Groups and Fragments for more information about handling
groups of atoms.
Unit Cells - Molecules - This will find any and all symmetry-unique bonded groups, and
can also show groups in additional unit cells. This option starts with a seed atom inside
the unit cell and finds all atoms bonded to it including those outside the central unit cell thus the bulk of a molecule may be outside the unit cell.
The other options below are actually identical to the options of the same name above,
except that they are applied to the centers of molecules instead of individual atoms. The
center, which is the average of all atoms in the molecule, is always within the given
boundaries (this is not guaranteed in the Unit Cells - Molecules option).
Enter Forms - Molecules - Use specified crystal faces for the boundaries.
Slice - Molecules - Isolate a slab of the structure parallel to a given face, with thickness
equal to the d-spacing (or multiple thereof).
Sphere - Molecules - Include all molecules within a given distance of a given point (or
atom).
3.2.2.3.1 Boundary - Unit Cell
Dialog Box: Boundary - Unit Cell [ Boundary Dialog]
This option (not intended for molecules) locates the faces of the unit cell, at various
choices of central distance.
Each of the sub-options may be chosen as the Default, which is the boundary option
used when importing a file (Import File command in the File menu).
You can choose either the primitive or Bravais cell if the lattice is non-primitive. If the
Bravais lattice is primitive, or if you elect not to use the primitive cell, the faces will be
(100), (010) and (001) and their negatives. If you choose to show the primitive unit cell
for non-primitive lattices, the faces will be {110} and {001} for a C-cell, etc.
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The central distances for the faces depend on which Sub option is chosen. The central
distance is the perpendicular distance from the face to the center of the crystal.
If you choose the -0.5 to 0.5 cell contents sub-option, the faces are at central distances
of 0.5009 of the dimensions of the unit cell if the h index is positive, or 0.499 if negative;
if h is zero, k is used; and if k is zero, l is used. Thus the volume enclosed is essentially
that of the unit cell, with the origin at the center. This is the only option which gives the
correct number of atoms for one unit cell.
The 0.0 to 1.0 inclusive sub-option gives you faces at the full d-spacing for positive
indices, and zero for negative indices, plus a small increment in both cases. Thus the
"unit cell" in this case includes atoms with fractional coordinates 0.0 to 1.0 inclusive.
The 0.0 to 1.0 plus bonds sub-option adds to the central distances of the preceeding suboption the largest bond distance or coordination distance entered in bond and/or
polyhedron input. This allows for completion of the coordination of all atoms in the unit
cell. Note that atoms may be included which are not considered to be coordinated to the
atoms in the cell, and that the distances used are the limits entered in the bond and
polyhedron dialogs, not the actual bond distances.
The -1 to 1 inclusive sub-option gives faces at the full d-spacing, plus a small increment,
for both positive and negative indices. While all the previous options give one unit cell or
somewhat more, this option gives eight unit cells and somewhat more. Using this option
insures that at least one complete molecule, or any other non-polymerized unit, will be
included.
The Central Distance sub-option sets all the faces of the unit cell at the given central
distance. Atoms "on" the faces are included.
The Get Faces button will calculate d-spacings and list the faces.
A single unit cell will not necessarily include a complete molecule or polymer; see the
Locate Groups command in the Transform menu for information on isolating groups.
If you select this boundary option, you can later switch to the Enter Forms option; this
preserves the forms and the symmetry (i.e. no symmetry for the faces).
Note that the Translation Limits option, with all limits set to zero, will include atoms with
fractional coordinates 0.0 to 0.99999, or in other words the same volume as sub-option 0.5 to 0.5 cell contents, but displaced by half a unit cell on all axes.
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3.2.2.3.2 Boundary - Enter Forms
Dialog Box: Boundary - Enter Forms [ Boundary Dialog]
This dialog may apply either to individual atoms, or to molecules (in which case the
dialog title will be Enter Forms - Molecules). In the latter case, bonded groups in the
unit cell will be identified and the center of each taken as the non-weighted average of
atomic positions. Then the boundaries will be determined with respect to the molecular
centers.
With this option, the most powerful of the boundary options, you can set the boundaries
of a crystal structure to be any rational faces consistent with the axial system defined in
the Title/Axes dialog. You do not need to enter every individual face; you can enter any
one of the faces of a form (symmetry-equivalent set), and the remainder will be supplied
by symmetry. You can use the full symmetry of the crystal class (point group), but you
may also elect to use a lower symmetry (center of inversion only, or no symmetry at all)
to have more flexibilityin the volume defined.
The Revise or Add Forms buttons call up the Add/Revise Form dialog for actual entry
of indices and central distance.
The Use individual atom distances option allows the boundary surfaces to be nonplanar with respect to the centers of the atoms. If you use this option, the actual central
distances for each boundary form are then entered (actually revised) during input for each
atom (Revise Atom: Central Distance Tab). However, the distance entered for each form
in this dialog is still necessary - it will be used: 1) As the default distance for the boundary
faces for each atom. You will need to revise the actual boundary face distances for each
form during atom input. 2) As the default for display of the crystal edges. The display
forms can be given new distances or changed completely with the
Crystal Forms for Display dialog in the Input1 menu. 3) For the initial boundary search
limits while locating atoms. The distance entered here in the boundary option should
therefore not be too different from the distances for individual atoms to be entered in the
Revise Atom: Central Distance Tab in the Input1 dialog.
Individual atom distances are not used in the Enter Forms - Molecules option.
There is a maximum of six forms (not faces) if you choose individual atom boundary
distances.
You can disable lattice translation on any of the structure axes, if you wish to use this
option to draw a molecule or polymer. Although it is generally simpler to use the
Translation Limits option for polymers, you can use the Enter Forms option to show
more diverse shapes for a two-dimensional polymer. For example with appropriate
choice of faces you can give the sheet a hexagonal shape, while the Translation Limits
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option will always give a parallelogram shape.
You can use this option for molecules to isolate a section, slab, or any convex polyhedral
volume. To prevent the repetition of the structure by translation, you must disable all the
lattice translations. It is not necessary to specify enough faces to define a closed
polyhedron, although you will get warning messages during calculation if you do not. For
example, to effectively slice through the middle of a molecule and just view the back half,
give only the "face" (100) at central distance 0.0 (set the face symmetry to No
symmetry).
Hint : specifying a center of symmetry for boundary faces, and the simple forms (100),
(010) and (001) at central distances of about 10 Angstroms will usually give 500-700
atoms for typical inorganic crystal structures. Central distances of about 7 Angstroms
usually gives about 300 atoms. Numbers are usually smaller for organic crystals.
3.2.2.3.3 Add/Revise Form
Dialog Box: Add/Revise Form [ Crystal Forms for Display Dialog] [ Boundary Enter Forms Dialog]
The central distance is the perpendicular distance, in Angstroms, from the center of the
structure to the faces of the form in question: the greater the distance, the greater the
number of atoms which will be included. Also, if there are many forms, the greater the
distance the less prominent the form (the smaller the area of the faces). Decimal values
may be used for the central distance, but not for the indices. Use the Next Form button
to add a form.
Keep in mind that there may be alterate orientations of symmetry elements with respect to
structure axes, and the indices of faces in a standard morphological setting may be
different from those in the setting of a particular space group. See section IV-5 for
further details of variant orientations.
You can use negative central distances to define a region which does not include the
origin. For example, if you want to display the part of the structure from y = 0.25 to y =
0.75 in an orthorhombic crystal with b = 10.0, enter the face (010) at distance 7.5
Angstroms and the face (0-10) at distance -2.5 Angstroms. If the crystal axes are not
orthogonal, you should use fractions of the d-spacing for central distances, not axis
lengths. The Enter Forms and Default Unit Cell boundary options list d-spacings of the
forms, uncorrected for systematic absences; the Slice boundary option will give a dspacing corrected for systematic absences.
For hexagonal and trigonal crystals with hexagonal axes, four indices, (hkil), are
commmonly used, but one of the first three is redundant. In ATOMS, you must omit the
third, or i index.
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3.2.2.3.4 Boundary - Slice
Dialog Box: Boundary - Slice [ Boundary Dialog]
This dialog may apply either to individual atoms, or to molecules (in which case the
dialog title will be Slice - Molecules ). In the latter case, bonded groups in the unit cell
will be identified and the center of each taken as the non-weighted average of atomic
positions. Then the boundaries will be determined with respect to the molecular centers.
This gives a section of a crystal structure parallel to a given face, with the thickness of the
X-ray d-spacing, or a multiple thereof. Such a "slice" is intended primarily to represent a
growth layer, but is often useful for illustrating special structural features.
In addition to the indices of the face, you need to specify several other things. An
Alignment vector is also necessary - when the calculation is complete, the slice will be
lying in the plane of the screen or paper and this vector will be vertical (parallel to z). The
vector must lie in the slice: a vector [uvw] lying in a face (hkl) satisfies the condition hu+
kv + lw = 0. If the default alignment vector is chosen, the alignment vector will be taken
as the intersection of the face (hkl) with the face (100), whose indices are given by the
vector cross product (hkl)x(100). If the slice face (hkl) is (100), the alignment vector will
be taken as its intersection with (010), which is the vector [001].
You must also specify the Height and Width of the slice, parallel and perpendicular to
the alignment vector.
The location of the slice within the crystal structure must also be specified in terms of the
Offset from the origin. One can specify different offsets, or boundary locations, for each
atom (set of symmetry equivalent atoms) in case the slice is not considered to be strictly
planar (see below). The Thickness of the slice is a fraction of the d-spacing: in most
cases it should be 1.0.
Atoms lying exactly on the "upper" boundary - (the face to which the slice is defined to
be parallel) are excluded from the slice, whereas atoms lying exactly on the "lower"
boundary (the face with indices negative to the "upper" face) are included.
The Use individual atom offsets checkbox allows the boundary surface to be non-planar
with respect to the centers of the atoms. If you use this option, you should revise the
offsets for the forms during atom input - the overall offset entered in this section sets the
default values. It is also used as the default for display of edges of the slice (the display
forms can be changed in the Crystal Forms for Display dialog), and to determine
preliminary unit-cell search limits for atoms during the calculation; thus this overall offset
and the offsets for individual atoms should not differ too much.
Systematic absences can be used to take account of d-spacings which are a submultiple
of those obtained solely from the cell parameters because of non-primitive lattices, screw
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axes or glide planes. The subdivision of the central distance for each form is done when
the d-spacing is calculated, after OK is clicked; to see the d-spacing values you must reselect the dialog. You cannot manually edit or add absences as in pre-V4.0 ATOMS.
The Custom symmetry option does not contain information on systematic absences - if
you want to use systematic absences, you should switch to the Space Group symmetry
option.

3.2.2.3.5 Boundary - None
Dialog Box: Boundary - None [ Boundary Dialog]
No boundaries whatever are used if this option is chosen, nor are any translations
applied. That is, the atoms in the molecule are just those, and all of those, generated by
the point-group symmetry specified (or the input atoms only, if there is no symmetry).
This boundary option is primarily for the case in which you already have absolute
coordinates of a single molecule. To draw a single molecule which is in a crystal, using
fractional coordinates and other data for the crystal, use one of the Molecules in Crystal
options in the Boundary dialog, or use the Default Unit Cell, Enter Forms or
Translation Limits boundary option to generate a volume large enough to include the
molecule or other group, then use the Find button in the Generated Atom Data dialog
(which appears when you click on an atom) or the Locate Groups dialog in the File menu
to isolate the molecule or group. Also, you can use the Enter Forms boundary option to
use pseudo-crystal faces to isolate part of a molecule - see the last paragraph of that
section.
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3.2.2.3.6 Boundary - Translation Limits
Dialog Box: Boundary - Translation Limits [ Boundary Dialog]
In this option, the contents of the central unit cell plus others within specified limits are
accepted. The central or "zero" unit cell contains atoms with fractional coordinates
0.00000 to 0.99999. The lower limit to unit-cell translations is normally zero or negative
and the upper limit is normally zero or positive. Disabling the translation entirely for an
axis is equivalent to setting the limits at zero. The translations belong to the Bravais
lattice, not the primitive lattice.
As an example of application to a crystal, putting the lower limit at -1 and the upper limit
at 0 for all axes results in a box with the shape of the Bravais unit cell, centered on the
origin and containing eight unit cells. Note that the "zero" unit cell, containing atoms with
fractional coordinates 0.0 to 0.99999, extends in the positive directions of the axes.
This is the primary option for one-dimensional polymers. It is also the simplest option for
two-dimensional polymers, but the shape of the resulting sheet is limited to the shape of
the unit cell, always a parallelepiped. You can use the Enter Forms option to give a
different shape to sheets.
3.2.2.3.7 Boundary - Sphere
Dialog Box: Boundary - Sphere

[ Boundary Dialog]

This dialog may apply either to individual atoms, or to molecules (in which case the
dialog title will be Slice - Molecules ). In the latter case, bonded groups in the unit cell
will be identified and the center of each taken as the non-weighted average of atomic
positions. Then the boundary will be determined with respect to the molecular centers.
This option is primarily designed to isolate a coordination sphere around a given atom,
although the center of the sphere can be at an arbitrary location in structure coordinates.
If you check the Specify structure coordinates radio button, you must enter the
coordinates in the x, y, z edit boxes below. If you check Input atom number, enter only
the input atom number in the edit box to the right. Then clicking the Get Coords. button
will fill out the coordinates (as will clicking OK).
If the structure is a molecule or polymer you should uncheck the appropriate lattice
tranlation(s), i.e. for a molecule uncheck all three.
3.2.2.3.8 Boundary - Locate Molecules in Crystal
Dialog Box: Boundary - Unit Cells - Molecules (Locate Molecules in Crystal) [
Boundary Dialog]
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This option will locate all symmetry-unique bonded groups, or all bonded groups, within
an integral number of unit cells. The central-ligand bonds in Polyhedra are used as well
as the standard Bonds. Like the Locate Groups option (Transform menu), this boundary
option starts with a seed atom, in this case the first input atom, which is within the zero
or central unit cell (fractional coordinates 0.0 to 0.9999) and then finds all others
involved. If the first molecule found in this way does not include all input atoms, the
excluded input atoms are in turn used as seed atoms, until all are located. An alert
informs you if there is more than one molecule or group. While the seed atoms are
always in the central unit cell, any other atoms may be in adjacent unit cells.
If the number of atoms located exceeds the number in the unit cell the procedure is
aborted. In such a case there is presumably continuous bonding.
You can locate all molecules in the unit cell, or only symmetry-unique ones. You can
also show the molecules in multiple unit cells. In this option, the boundaries of unit cells
are always the planes at fractional coordinates 0.0, 1.0, etc. To have more control over
boundaries you can use the Enter Forms - Molecules boundary option. Note that that
option finds the center of each molecule (unweighted average of atom locations), and
then places molecules within boundary faces according to that center location, whereas
this option does not find the center of each molecule, and molecules may be placed
"inside" the unit cell even if only one atom (the seed atom) is actually inside the cell.
After initial isolation of the molecules, it may be desirable to use the Generated to Input
conversion (Transform menu). This will simply make a list of the atoms located, which is
saved in the data file, and will in the future avoid the molecule-locating algorithm, which
can be time-consuming.
Do not use this option to isolate two- and three-dimensional polymer units. Instead, use
some other boundary option to generate a volume which you know includes a sufficiently
large number of polymer units. Then use the Locate Groups option in the Transform
menu - this option allows the specification of particular seed atoms. The Locate Groups
option is also appropriate if there are isolated molecules as well as a continuously bonded
framework, or polymers. See also Dealing with Molecules, Groups and Fragments.
This is a possible default boundary option for importing crystal-data files, with certain
exceptions (PDB, CCDC-FDAT, VIBRAT). If it is allowed, the initial dialog for that
import file type will give a choice between Locate Molecules in Crystal and
Default Unit Cell. Of course the boundary option can be changed after the import file is
read in.
In the case of CCDC FDAT files, the "molecule" option does not use this boundary
option, rather it uses data on molecules which is already present in the file.
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Crystal Forms for Display

Dialog Box: Crystal Forms for Display [ Input1 Menu]
With this option you can display an external crystal shape which is not the same as the
boundary faces for locating atoms. You can even show a crystal shape for structures in
which the boundary option is No Boundaries or Translation Limits.
This dialog controls the generation of the faces, corners and edges which make up the
display shape; the Crystal Edges dialog in the Input2 menu controls colors and other
display aspects of the crystal edges - of course it is only the edges which are actually
shown.
By default, the display shape is the same as the boundary shape for boundary options
Default Unit Cell, Enter Forms and Slice, and there is no display shape for options
No Boundaries, Translation Limits and Sphere. If you choose to change the display
shape, or to show one where no crystal forms are used as boundaries, the input and
revision thereof are similar to those for input of boundary crystal forms in the
Enter Forms boundary option, through the Add/Revise Form dialog
For the non-3D display modes of ATOMS, the edges demarking the external crystal
shape should be outside the atomic structure. As discussed in Drawing Crystal and Unitcell Edges, an external crystal shape which lies inside or interpenetrates with the atomic
structure will in many cases be drawn incorrectly. In the 3D mode, interpentration
relations are drawn correctly.
Although this option is primarily intended for the Default Unit Cell and Enter Forms
boundary options, it can also be used for molecules and polymers.
Note that you may have to change the Display radio buttons in the Crystal Edges dialog
in the Input2 menu, to allow the crystal shape to be displayed.
Using display faces with Cartesian symmetry input. The symmetry option
Cartesian matrices is intended primarily for molecules with non-crystallographic
symmetry. However, it can be used with "crystal" faces with certain restrictions. You
must use Cartesian face coefficients or inverse intercepts, and if some of these "indices"
or the symmetry equivalents thereof are irrational they must be converted to large
integers. For example, the face (100) in a trigonal or hexagonal crystal would also have
coefficients 1,0,0 in a Cartesian system with y=b (or a2), but some of the symmetry
equivalents of this face, such as (-110) and (0-10) would have irrational coefficients. If
you enter 20000,0,0 as the "indices" of the form, then when the indices are multiplied by
the Cartesian symmetry matrices the result will be large integral indices for the symmetry
equivalents. If you enter 1,0,0, the results would be fractions, which would be incorrectly
truncated or rounded off either to 0 or 1. As another example, an icosahedron may be
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drawn in either of the icosahedral groups I or Ih by giving the form indices 0,0,20000; the
indices 0,0,1 would not work because many of the 19 faces equivalent to this one have
irrational indices.
Using integers with up to four or five digits (99,999) gives adequate precision for the
calculations involved in determining the external crystal shape.
3.2.2.5

Atoms (Input)

Dialog Box: Atoms [ Input1 Menu]
You can choose to enter each atom interactively, or ATOMS can read some or all of the
atom parameters from a text file, supplying defaults for the atom types, radii and display
colors if desired. You can type in the name of this input file, or browse to open the file.
The file must contain certain lines specifying the which parameters are to be read in and
which set to default values (see Atom Parameter Files for specifications).
If you do not use a file, use the Revise or Add Atoms buttons to access the Revise Atom
dialog. You can also double click on any line to revise that atom.
To calculate bond distances and angles, for use in the bond and polyhedra input or just
for general information, use the Coordination button. It is not necessary to have
calculated the structure to use this option, or even to have selected the boundary option,
but you must have entered the correct structure axes or unit cell and symmetry.
The Vectors dialog called up by the Vectors button is for specification of general
properties of atomic vectors, for use in displaying magnetic symmetry or vibrational
modes. The vectors for the individual input atoms are specified in the Revise Atom
dialog.
The T. Factors button is for adding or deleting temperature factors to or from all atoms.
To view or modify temperature factors for individual atoms, select that atom to call up
the Revise Atom dialog, and select the Temperature Factors tab in that dialog.
Solid Solutions. There is no provision in ATOMS for directly showing solid solutions as
fractional atoms. However, it is possible to use the Randomize option in the Atoms Global dialog in the Input1 Menu to change the colors or other properties of selected
groups of atoms on a random basis. Of course, it is also possible to modify individual
generated atoms manually, after execising the Generated to Input option in the
Transform Menu.
3.2.2.5.1 Coordination of Atoms
Dialog Box: Coordination of Atoms [ Revise Atom Dialog]
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This controls computation of the list of bond or interatomic distances and angles centered
on one or all of the input atoms. The radio buttons determine whether distances and
angles are computed for all input atoms or only the one currently selected in the
Input Atoms dialog.
Only 32 atoms in addition to the central atom are allowed in each coordination sphere, so
the distance limit for central-ligand should normally not be more than about 4
Angstroms. Angles are only calculated for ligand pairs at less then the ligand-ligand
limit; if you want to determine angles for atoms on opposite sides of the central atom, the
ligand-ligand limit should be twice the central-ligand limit.
The results of the distance and angle calculations are written to a file called
BONDS.ATD, in the home directory (see File Types), and then shown in a Text window
(see Types of Windows). In order for this Text window to operate properly, ATOMS
exits from the Input Atoms dialog from which the Coordination dialog was originally
called.
From this Text window, return to the Graphics window and the ordinary operating mode
of ATOMS with the Window menu.
3.2.2.5.2 Revise Atom, Temperature Factor Tab
Dialog Box: Revise Atom: Temperature Factors Tab [ Input Atoms Dialog]
See the Basic Tab for most normal aspect of individual input atoms, the Central Distance
and Slice Offset tabs for adjusting boundaries for individual atoms, and the Vector Tab
for atomic vectors for magnetic moments or vibrational displacements.
The temperature factor type, according to ORTEP, must be selected with the radio
buttons. The most common types are 0 for anisotropic beta; 6 for isotropic B; 7 for a
sphere of constant radius, 8 for anisotropic u, and 10 for isotropic U (not a standard
ORTEP type).
The instructions and help for some releases of pre-V5.0 ATOMS may be incorrect in
stating that type 7 indicates isotropic U. Actually, type 7 should be a sphere of arbitrary
radius. Importing files with isotropic U may in some cases have incorrectly assigned type
7 to these atoms (although in most cases these should have been converted to isotropic
B). Thus when ATOMS reads a pre-V5.0.STR file with type 7 temperature factors, you
will be asked if you want to change these to type 10.
Isotropic values are entered in the first box; if the second or b22/U22 value is zero, the
atom will be considered to be isotropic.
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3.2.2.5.3 Revise Atom, Slice Offset Tab
Dialog Box: Revise Atom: Slice Offset Tab [ Input Atoms Dialog]
See the Basic Tab for most normal aspect of individual input atoms, the
Temperature Factor Tab for modification or entry of temperature factors, the
Central Distance tab for adjusting boundaries for individual atoms in the Enter Forms
boundary option, and the Vector Tab for atomic vectors for magnetic moments or
vibrational displacements.
This applies only to the Slice boundary option.
The default value is the offset entered in the Slice boundary option.
3.2.2.5.4 Revise Atom, Vector Tab
Dialog Box: Revise Atom: Vector Tab [ Input Atoms Dialog]
See the Basic Tab for most normal aspect of individual input atoms, the
Temperature Factor Tab for modification or entry of temperature factors, and the
Central Distance and Slice Offset tabs for adjusting boundaries for individual atoms.
Atom vectors, for magnetic spin direction or atomic displacements in vibrational modes,
are specified in the crystal or structure coordinate system. The length is specified
independently from the vector giving the orientation.
Vectors are drawn by adding pseudo-atoms to the list of generated atoms, and adding
pseudo-bonds between these pseudo-atoms and the real atom to which the vector is
attached. Thus if the length or orientation are changed the structure must be
recalculated, rather than just replotted. Also, since the length is computed as the visible
cylindrical part of the vector, if you change atomic radii the vector lengths will change
unless the structure is recalculated.
3.2.2.5.5 Revise Atom, Central Distances Tab
Dialog Box: Revise Atom: Central Distance Tab [ Input Atoms Dialog]
See the Basic Tab for most normal aspect of individual input atoms, the
Temperature Factor Tab for modification or entry of temperature factors, the
Slice Offset tab for adjusting boundaries for individual atoms in the Slice boundary
option, and the Vector Tab for atomic vectors for magnetic moments or vibrational
displacements.
This tab specifies central distances for an individual atom in the Enter Forms boundary
option.
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Only six forms are allowed. The default values are the central distances entered in the
option Enter Forms boundary option.
3.2.2.5.6 Revise Atom, Basic Tab
Dialog Box: Revise Atom: Basic Tab [ Input Atoms Dialog]
See the Temperature Factor Tab for modification or entry of temperature factors, the
Central Distance and Slice Offset tabs for adjusting boundaries for individual atoms, and
the Vector Tab for atomic vectors for magnetic moments or vibrational displacements.
Label. Each atom may be assigned a label of up to 6 characters. Labels in ATOMS may
not contain any embedded blanks. Any embedded blanks or leading blanks in labels will
be converted to underscores. Trailing blanks will be stripped.
Fractional coordinates. For crystals, the x, y and z coordinates should be in fractions
of the unit cell. However, if you are drawing a molecule and have chosen unit Cartesian
reference axes, the coordinates should be in Angstroms.
Type. The atom type is used when locating bonds and polyhedra; it is usually expedient
to enter the same type for all atoms which are bonded similarly (e.g. all carbons, all
silicons, all six-coordinated cations, all oxygens, etc.) to save effort in defining bonds and
polyhedra. The atomic number can usually be used for the type, although there are
situations in which different type numbers should be used for the same element (see
Polyhedra). For diffraction calculations (Powder, Precession) the type number must be
the atomic number, or a number which gives an entry to the scattering factor table,
modulo 100. That is, type numbers 6, 106, 206, 306 etc. will be read as atomic number 6
(carbon). Thus it is recommended that whenever possible type numbers be the atomic
number, with added 100's if necessary to differentiate bonds and polyhedra.
Radius. Each atom will be represented by a sphere of this radius, unless it is involved in a
polyhedron defined in the polyhedra input. If an atom is given radius 0.0, it will never be
plotted as a sphere and will only appear (as a corner) if it is involved as ligand in a
complete coordination polyhedron. Bonds to such atoms will not be plotted unless the
atoms are ligands in polyhedra. Thus if you want to show only polyhedra and never the
individual atoms, give radii of 0.0 to all the atoms which may be involved, either as
central atoms or as ligands. Even if you use positive radii for the atoms, you can switch
off display of the atoms in incomplete polyhedra with a checkbox in the Polyhedra dialog
(Input1 menu). However, using a radius of 0.0 omits calculation of bonds to atoms in
incomplete polyhedra, which can improve computation time and conserve memory.
If you do not want to show an atom at all, but want to show the bonds to the atom, that
is draw a wire-frame model, enter a negative number for the radius. The absolute value
of the radius can still be used in the Generate Bonds from Atomic Radii option. If atoms
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with negative radii are involved in polyhedra, they will be treated in the same way as
atoms with positive radii.
For ball-and-stick drawings of typical structures, radii of about half the ionic or covalent
radii usually work well. For space-filling or interpenetration the covalent radii can be
multiplied by a number larger than one. All radii can be changed simultaneously by a
given factor with the Atoms - Global dialog in the Input1 menu.
Colors and patterns/shades. Each atom always has a rim and a fill, the colors for which
are specified independently. Rims are turned on and off, and their widths are set, in the
Line Widths dialog in the Input2 menu. Shading applies only to fills. See
Input Colors/Patterns/Pens for general aspects of input.
If you have checked the Use individual atom distances box in the boundary option
Enter Forms, or the Use individual atom offsets box in the boundary option Slice, you
should use the Set Boundary Forms button (Central Distances for Individual Atom or
Slice Offsets for Individual Atom dialogs) to correct the central distance or offset for
each form, up to six forms for distances. These distances or offsets are the ones which are
actually used for the boundaries, but the central distances or offsets entered for each form
in the boundary option are used for display of crystal shape and to set up the initial search
intervals, so the individual distances or offsets should not be too different.
Shubnikov . This checkbox determines whether the equivalents of this particular input
atom show vectors or other Shubnikov indicators (+ or -). Set the orientation of atomic
vectors in the Vector Tab , and set the overall properties of vectors in the Vector dialog,
called from the Input1 menu or the Input Atoms dialog.
Protein. This only applies to structure input from Protein Data Bank files. It calls up a
dialog (Protein) which gives protein specific information about the atom.
Line Width. If the Use individual box for atoms in the Line Widths dialog (Input2
menu) is checked, the width specified here will be used, rather than the overall value in
the Line Widths dialog.
Hachure patterns are macroscopic patterns of lines which may be drawn within the
outlines of atoms. These are useful for black-and-white output in situations where
shading patterns are not reproduced very well, or a more definite pattern differentiation is
desirable. The patterns are simply drawn in 2 dimensions and do not vary with attitude of
the surface like the hachure patterns for Polyhedra.
Hachure patterns are not used in the 3D mode, and this entire section is not applicable to
3D display/output.
The Spacing is the distance between lines, in Angstroms. The colors/shades of the
patterns are same as those selected for the outlines or edges (above), and the widths are
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also as selected (above) for each individual atom type, or as selected overall in the
Line Widths dialog (Input2 menu).
If the Use shade box is checked, the gray shade selected in this dialog will also be applied
as fill, in addition to the pattern, in black-and-white non-shaded output. This choice
overrides the Use initial patterns box in the Shading dialog (Input2 menu). Shading, as
selected in the Shading dialog (Input2 menu) is applied independently of hachure
patterns, and it is possible to have both, either in color or black and white. In color
display and output, the fill color (above) is always used.
3.2.2.6

Polyhedra

Dialog Box: Polyhedra [ Input1 Menu]
This lists the current polyhedra. Click on individual items in the list, then on the buttons
to add, modify or delete polyhedra. The Revise and Add Polyhedra buttons call up the
Polyhedron Data dialog.
To calculate bond distances and angles, for use in bond and polyhedra input, use the
Coordination button in the Input Atoms dialog.
If the Show back edges dashed box is checked, the invisibleback edges of polyhedra
will be drawn as dashed lines - the dash parameters are set in the Crystal Edges dialog.
Polyhedra are still opaque. This applies to unshaded polyhedra only.
The possibilities for showing polyhedra are diverse, depending on the display mode. It
may be necessary to select settings in the 3D Polyhedra dialog and also the
Ellipsoid Parameters dialog as well as this dialog. These two other dialogs are accessible
directly from this one with buttons.
The 3D parameters button calls up a dialog (3D Polyhedra) for specification of
polyhedron properties unique to the 3D display mode. This includes options to draw the
polyhedron faces as transparent and to show the central atom and interior bonds. In the
3D Polyhedra dialog, and also the Ellipsoid Parameters dialog, there is an option to show
corners and/or central atoms of polyhedra as thermal ellipsoids in the 3D display mode.
The Ellipsoid Parameters button calls up the Ellipsoid Parameters dialog. In the
Ellipsoid display mode (which mimics ORTEP) polyhedra are never shown with actual
flat faces, but there is an option in the Ellipsoid Parameters dialog to draw the ligandligand "bonds" or polyhedron edges, and also the central-ligand "bonds" as standard
ORTEP bonds.
The Show ligands as spheres group has three options. If the None button is checked,
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only the polyhedron faces are shown and ligands are represented as points at the corners.
If one of the other boxes is checked, ligands are drawn as spheres. In the
Standard display mode, this option is an approximation in that junctions between the
atoms and the polyhedra are straight lines. In the 3D display mode, junctions are always
correct. For spherical atoms (not thermal ellipsoids) you can use the Atom radii entered
for each input atom, or you can use a Single radius for all ligands, entered in the edit box
to the right of this option. The Single radius option is not applicable to ellipsoids in the
3D display mode; if either the Atom radii or Single radius option is selected, ellipsoids
will be shown at polyhedron corners. If atoms are not shown at polyhedra corners (None
option), the bonds to such corners are always cylindrical,not tapered as they could be if
they were to ellipsoids. This option does not function as well when Hachure patterns
(Polyhedron Data dialog) are used - the junctions of the polyhedron corners with the
spheres are not correctly drawn.
The Test for incomplete polyhedra group determines how atoms in incomplete
polyhedra are handled. As detailed in Generated Atom Data , when ATOMS locates
polyhedra, it assigns a certain plot code (5) to atoms which are parts of polyhedra which
have fewer than the specified number of ligands. This will always be done, even if the
option selected is No test, and the atoms thus flagged can either be omitted or plotted as
spheres, depending on the setting discussed in the previous paragraph. However, some
further screening of possible polyhedral atoms can be made, to eliminate display of
potential ligands which are not found to bond to any of the specified central atoms within
the given boundaries. While locating polyhedra, ATOMS can make a list of either the
Input atom numbers or the Atom types involved (as ligands) in polyhedra. Then after
all polyhedra are located, the generated atom list is searched to find those atoms with the
specified numbers, and these atoms are then marked with plot code 5, i.e. as belonging to
incomplete polyhedra. The normal option for crystals is Input atom numbers.
However, this option is of no use when the structure is of type Input=Generated , or for a
molecule with no symmetry, since every input atom corresponds to a single generated
atom. Thus the default for Input = Generated is No test. The Atom types option
works well when each input atom type (normally the atomic number) plays only one
structural role, i.e. is either always a polyhedron ligand or not. However when an atom
type can be a polyhedral ligand in some cases, and a non-ligand in others (for example
when oxygen atoms are ligands in phosphate radicals or other groups and also are present
in water molecules or hydroxyls), the atoms which are non-ligands will be incorrectly
omitted. When using the Atom types option, it may thus be necessary to assign special
types to atoms with different structural roles, for example 8 for oxygens which are in
phophate (or other) groups; 108 for hydroxyls; and 208 for waters.
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3.2.2.6.1 Polyhedron Data
Dialog Box: Polyhedron Data [ Polyhedra Dialog]
Polyhedra are defined by specifying the Coordination number, and the Types of the
central atom and the coordinating atoms or ligands. Note that atom types are used, not
individual atom numbers, so that chemically similar atoms may be grouped. It is usually
convenient to use atomic numbers for the types. You must further specify the Maximum
distance for the bonds from the central atom to the ligands.
If the coordination number is given as 3 or larger, only complete polyhedra are identified
and displayed; that is, both the central atom and all the ligands must be within the
structure boundaries defined in the Boundary option. Atoms belonging to incomplete
polyhedra can be displayed as spheres with the radii assigned in the Revise Atom dialog,
unless their atomic radii are zero - then they will be marked as permanently non-plotting.
The display of these atoms is controlled by a checkbox in the Polyhedra dialog. If more
coordinating atoms are found than specified within the given distance, an error message is
shown and the polyhedron is skipped.
If you do not know the coordination number or the bond distances, you may wish to
make one or more runs with the coordination number set to zero. In this case, all
polyhedra with three or more ligands within the bond-distance limit will be accepted, and
you can examine the Calculation Output to see what the proper coordination number or
distance limits should be.
If you want to show polyhedra which do not have central atoms, it will be necessary to
enter dummy central atoms. The best way to do this is to take the average of each
coordinate for all the atoms in one polyhedron.
In the Standard display mode, polyhedra are always opaque; if you wish to show only the
skeletons, you can define bonds among the ligands (next section). Also, you can use the
Skeletal display mode, selected in the Display Mode sub-menu of the Display menu.
Once the ligands are located, central atoms are never shown in non-3D modes.
If a nominally planar coordination is not strictly planar, within tolerances, it will be shown
as a polyhedron. In Standard display mode, strictly planar polyhedra will vanish when
seen edge-on if display of rims or edges is not turned on with the Rims dialog in the
Input2 menu.
In 3D mode, planar polyhedra have finite thickness. There are also several options for
showing polyhedra as opaque, translucent or skeletal (see 3D Polyhedra).
Colors and patterns/shades. Each polyhedron may have a rim and a fill, the colors for
which are specified independently. Rims are turned on and off, and their widths are set,
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in the Line Widths dialog in the File2 menu. Shading applies only to fills. See
Input Colors/Patterns/Pens for general aspects of input.
Line Width. If the Use individual box for polyhedra in the Line Widths dialog (Input2
menu) is checked, the width specified here will be used, rather than the overall value in
the Line Widths dialog.
Hachure patterns are patterns of lines based on a square grid which may be applied to
polyhedra. The patterns are drawn on the surface of each polyhedron face in 3
dimensions (not simply applied in 2 dimensions to the projection of the face), so that they
give some illusion of depth or shading. Thus they enhance the 3-dimensional appearance
of the drawing while at the same time allowing differentiation of the different types of
polyhedra. Differentiation of polyhedra types is almost impossible using gray shades
(above ) alone.
Hachure patterns are not used in the 3D Display mode, and this entire section is not
applicable to 3D display/output.
The Spacing is the distance between lines, in Angstroms. The colors/shades of the
patterns are same as those selected for the outlines or edges (above), and the widths are
also as selected (above) for each individual polyhedra type, or as selected overall in the
Line Widths dialog (Input2 menu).
If the Use shade box is checked, the gray shade selected in this dialog will also be applied
as fill, in addition to the pattern, in black-and-white non-shaded output. This choice is
overridden if the Use initial patterns box is checked in the Shading dialog (Input2
menu) - in that case, gray shades or dot patterns will always be applied.
In color display and output, the fill color (above) is always used. Shading, as selected in
the Shading dialog (Input2 menu) is applied independently of hachure patterns, and it is
possible to have both either in color or black and white. If hachure patterns are used in
conjunction with shading for atoms and bonds, the illumination vector (Shading dialog)
should probably be 1,0,0, as this is the effective illumination direction for hachures.
Differentiating polyhedra. The size and shape of different polyhedra are not generally
sufficient to allow identification of the polyhedron type in a drawing. There are several
different display attributes of polyhedra which may be varied alone or in combinations to
allow differentiation.
1) Color. This is certainly the best option when it is available, especially when using
shading, except that a significant fraction of people are at least partially color-blind.
2) Hachure patterns. Both the pattern itself and the scale can be varied.
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3) Gray shade of fill (black-and-white). This does not usually work well in combination
with shading.
4) Width of edges.
5) Gray shade of edges. Lines of one dot width (width 0.0 in this dialog) are always
black.
3.2.2.7

Bonds

Dialog Box: Bonds [ Input1 Menu]
This lists the current bonds. Click on individual items in the list, then on the buttons to
revise, delete or add bonds. The Revise and Add Bonds buttons call up the Bond Data
dialog.
To calculate bond distances and angles, for use in bond and polyhedra input, use the
Coordination button in the Input Atoms dialog.
You can also click the Generate from Radii button, to derive bonds automatically.
PDB quick bonds check box. In the case of Protein Data Bank (PDB) structures,
ATOMS is able to use the information on residues which is present in the file, as well as
CONNECT records, to greatly decrease the time required to locate bonds, compared to
standard ATOMS methods for crystals. However, if some bonds are missing or
duplicated it may be necessary to uncheck this box.
3.2.2.7.1 Bond Data
Dialog Box: Bond Data [ Bonds Dialog]
Bonds are specified by giving the Types of the two atoms involved - in some cases, such
as carbon-carbon bonds, these may be the same. The Minimum, as well as Maximum
distance must be specified; this allows differentiating bonds to the same atom. A stick
bond has the shape of a cylinder, but if the Radius of this cylinder is entered as zero, then
the bond is drawn as a single line. The width of this single line, or the width of the lines
defining the outline of a stick bond, is normally one dot in screen display or dot-matrix
plots, but this can be changed - for all bonds in the Line Widths dialog in the
Input2 Menu, or if desired for each input bond (see below).
Bonds to atoms in polyhedra can only be drawn to ligands defined in the Polyhedra input,
not to central atoms.
If you wish to show only bonds, not atoms (wire-frame model), you should enter negative
radii for the atoms.
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If the Inter-molecule box is checked, this bond specification will not be used in locating
molecules or groups in either the Molecules in Crystal boundary options, or the Find
button in the Generated Atom Data dialog or Locate Groups dialog. Intermolecule
bonds are drawn normally by default, but they can be dimmed, highlighted or hidden
(Atom/Bond Plot States dialog in the Input2 Menu, or Dialog Bar - Right)
In Standard display mode, the interpenetration relationships of cylindrical bonds with
each other, and with the polyhedra to which they are attached, are not drawn accurately.
This affects wire-frame atoms (atomic radius negative), and bonds from polyhedral
ligands to other atoms. The affect of this limitation is mimimized if the bond radii are
kept relatively small. In Standard display mode, if atoms are interpenetrating (interatomic
distance less than the sum of the radii), no sticks or lines will be shown, but it is still
necessary to specify a bond between the atom types so that the junctions will be handled
properly (if no bond is specified, the atom in front will simply be drawn over the other
one). The radius and colors of the bond are immaterial for interpenetrating atoms. In
3D mode, interpenetration relations are always drawn correctly and if atoms are known
to interpenetrate it is not necessary to specify bonds between them.
Colors and patterns/shades. Each bond may have a rim and a fill, the colors for which
are specified independently. The color for a single-line bond is the same as the rim color
for a cylindrical bond. Rims are turned on and off, and their widths are set, in the
Line Widths dialog in the Input2 menu. Shading applies only to fills. See
Input Colors/Patterns/Pens for general aspects of input.
Line Width. If the Use individual box for bonds in the Line Widths dialog (Input2
menu) is checked, the width specified here will be used, rather than the overall value in
the Line Widths dialog.
Individual input bonds may be dashed if they are single-line (radius 0.0). The length of
the dashes is specified in the Crystal Edges dialog.
3.2.2.7.2 Generate Bonds
Dialog Box: Generate Bonds from Atomic Radii [ Import File] [ Bond Data dialog]
This will derive a set of bond specifications for the atoms currently in memory, which
may have just been read in from an import file.
Source of atomic radii. Starting with V4.0, ATOMS can use a constant set of radii in
an internal table (read in from the RADII file), rather than the given input atom radii
(which is still an option). If you choose to use the table, the element can be identified
either using the first two characters of the label, or using the type number which is
assumed to be the atomic number. If you choose to use the input atom radii, the atom list
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is scanned and the radius is taken from the first occurrence of each atom type. That is, if
input atom number one is type 1 with a certain radius, and input atom number seven (for
example) is also type 1 but with a different radius, only the radius of input atom number
one will be used.
The Maximum distance as fraction of radii sum field specifies the upper distance limit
for each type of bond. This will be the sum of the radii of the two atom types, multiplied
by the number entered in this field. The minimum distance will be 0.2 Angstroms. If you
choose to use the current input atom radii, the factor must take account of any reductions
in the atomic radii from values which cause the atoms to almost touch.
If the Delete old bonds box is not checked, the new bond list will simply be added to the
old list.
The All pairs/Cation-anion only radio buttons allows skipping many superfluous
combinations, i.e. atoms which never bond with each other. In the RADII file, each atom
is assigned a code indicating whether it is a cation (1), an anion (-1), non-metal (0) or
inert (3). A "non-metal" is considered to be able to bond with all other types except inert
atoms (rare gases). At the time of generating bonds, the codes for the two input atoms in
question are added together, and any resulting values with absolute value greater than 1
are rejected. The codes in the RADII file are by default set up primarily for inorganic
structures, and if you want to use this option for organic structures, they may need to be
modified.
Whether or not this option is used, superfluous bonds can still be removed in the Bonds
dialog in the Input1 menu.
In the Bond radii group of radio buttons, you can choose to make the bond radius a
fraction of the radius of the smaller atom of the two in the bond; or to enter a constant
radius for all bonds. A constant radius value of 0.0 will result in single-line bonds.
The Default Colors button will call up a dialog similar to that for individual input bonds
(Bond Data ), but the atoms types, distance limits and radius will be missing.
If the Hydrogen bonds box is checked, a list of Specifications will be used to set up
bonds for atoms involved in hydrogen bonding. This will result in two input bonds for
each pair (H-other) which may be involved in hydrogen bonding. If the Hydrogen bonds
box is not checked, any bonds involving hydrogen should be of the normal covalent type.
3.2.2.7.3 Hydrogen Bond Specifications
Dialog Box: Hydrogen Bond Specifications [Generate Bonds Dialog]
The current hydrogen bond specifications are given in the list box - edit the variables for
the selected specification in the edit boxes on the right.
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If the Hydrogen bonds box in the Generate Bonds dialog is checked these specification
will be used to set up bonds for atoms involved in hydrogen bonding. As ATOMS
considers each possible pair of atoms in the input list, it will test the type numbers against
those in this list
If one member of the pair has type number 1 (hydrogen), 99 (deuterium) or 98 (tritium),
and the other member of the pair has one of the type numbers in this list, hydrogen bonds
will be set up. If both members of the pair have type numbers indicating hydrogen, no
bonds at all will be set up. Note that atomic numbers in this list (non-hydrogen) do not
need to be atomic numbers, but hydrogen itself (and deuterium and tritium) must have the
default atomic numbers.
Two separate input bonds will be set up for each hydrogen-other pair: a short or strong
bond in which the other (the atom in this list) is the hydrogen donor in a hydrogen bond;
and a long bond or hydrogen bond itself in which the other atom is the acceptor. For
normal, strong (non hydrogen) bonds between H and the other atom, the minimum
distance is 0.2 Angstroms and the maximum bond distance is the minimum distance
(Min) in this table. For hydrogen bonds between H and the other atom, the minimum
bond distance is the minimum distance in this table and the maximum bond distance is the
maximum distance (Max) in this table. That is, the Min value is the boundary between
donor bonds and acceptor bonds, and the Max distance is the longest possible acceptor
bond.
The Intermol (Intermolecular) flag determines whether bonds will be considered to be
intermolecular (see Bond Data dialog) for purposes of locating molecules.
Any input bond specifications set up with this option can always be edited through the
Input Bonds dialog.
3.2.2.8

Atoms - Global, Variables Tab

Dialog Box: Atoms - Global: Variables Tab [ Input1 Menu]
This applies to input atoms, not generated atoms. Select the atoms to be modified in the
Which Tab.
3.2.2.9

Atoms - Global, Which Atoms Tab

Dialog Box: Atoms - Global: Which Atoms Tab [ Input1 Menu]
This tab specifies which atoms will be changed: it applies to input atoms, not generated
atoms. You can change parameters for all atoms, for all atoms of a given type, for a
sequence of atoms, or for all atoms in a given fragment (if there is more than one
fragment - see Multiple Structures ) in the Transform menu.
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Randomize. This allows you to modify only a certain fraction of the input atoms chosen,
on a random basis. This is intended primarily for representing solid solutions - you can
modify the colors and/or sizes of individual input atoms. Before doing this, it will
normally be necessary to do the Generated to Input option in the Transform Menu, so
that all atoms become input atoms. If only atoms on a certain site are to be modified, it
may be necessary to change the atom type of this site before transforming
Generated to Input .
A solid solution with only two types of atom is straightforward, but more than two
occupants will require some pre-calculation and repeated use of this dialog. Since all
atoms present are affected, the fraction which is entered in this dialog must be with
respect to the new occupant and those occupants already present, not the final fraction.
For example, suppose you want to show four occupants, each with occupancy factor
0.25. The first occupant is already present. When adding the second occupant, for
example changing the color, the fraction should be 0.5, because this gives the correct
ratio of occupant 1 and 2. To add the third component, this dialog must be repeated and
the fraction is 0.3333, and for the fourth and last occupant the fraction is 0.25.
Select the variables or attributes to be changed in the Variables Tab.
3.2.2.10

Atomic Vectors

Dialog Box: Atomic Vectors [ Input1 Menu] [ Input Atoms dialog]
The vectors can be cylinders or single lines; if cylinders, all will have the same radius.
The Scale factor should be in whatever units are necessary to convert the given lengths
of the vectors (specified in the Vector Tab of the Revise Atom dialog) to suitable
lengths in Angstroms. The length of the vector is measured from the surface of the atom
to the end of the line or the cylindrical portion, except for double ended vectors (see
below) in pen plots, in which the length is measured from the surface of the atom to the
center of the sphere on the positive end..
You can choose to use the colors of each individual atom, or the color specified in this
dialog.
If the Single-end, no arrow radio box is not checked, the vectors will be single lines or
cylinders extending in one direction from the atom. The termination is a disk in
Standard display mode or a hemisphere in 3D display mode. If the Single-end, arrow
radio box is checked, the end will be marked with a cone (arrowhead) except in pen-plot
output, in which the positive ends will be marked with a sphere. If the Double-ended
box is checked, the vectors will extend in both directions from the atom, and the positive
end will be marked with a cone (arrowhead).
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The Radius increment for arrow gives the absolute increment in Angstroms of the
radius of the base of the cone over the radius of the vector. The length of the arrow is
determined by the Length/radius value. Likewise, the Radius increment for sphere
(pen-plot only) gives the absolute increment in Angstroms of the radius of the sphere
over the radius of the vector.
Vectors are drawn by adding pseudo-atoms to the list of generated atoms, and adding
pseudo-bonds between these pseudo-atoms and the real atom to which the vector is
attached. Thus if the length, orientation (Revise Atom dialog, Vector tab) or
single/double-ended status is changed the structure must be recalculated, rather than
just replotted. Also, since the length is computed as the visible cylindrical part of the
vector, if you change atomic radii the vector lengths will change unless the structure is
recalculated. In this dialog (Atomic Vectors), changing the scale factor will require
recalculation, as will changing the vector radius, since this affects the length of the visible
part of the vector (although this effect is slight).
3.2.2.11

Vibrational Modes

Dialog Box: Vibrational Modes

[Input1 Menu]

See the Import File dialog for general aspects of importing atomic-structure data files.
This dialog controls.MOT vibrational displacement files (see
Import VIBRAT (.MOT) files) written by the VIBRATZ program (or the original
VIBRAT - Dowty, Phys Chem Minerals (1987) 14:67). When these files are read in the
infomation is converted into a standard ATOMS data file, and also a special.MDT modes
file which contains the atomic displacements and other information for each vibrational
mode. When you re-read the.STR file, the.MDT file is read in also; if this fails, you can
read it in using one of the options in the Modes file group in this dialog. The title of
the.MDS file should already be present in the edit box so you can edit it and click the
Read Named File button, or use the Browse button to find it.
The Read.MOT file for motions only button will read the atomic motions, but will
ignore other information in the.MOT file. This allows you to set up the drawing once in
terms of atom sizes, colors, etc., and retain all this if you decide to recalculate the
vibrational modes in VIBRAT.
The mode which is in the.STR file and which is displayed when you first read and
calculate the file is the one which was selected when the.STR file was last saved.
After selecting a new mode, you will need to recalculate the structure (Calculate
command in the File menu, or the Dialog Bar), not simply replot, since new vectors
involve generating new pseudo-atoms and pseudo-bonds.

© 2002 Shape Sof tware

ATOMS Menus and Dialogs

99

To see on the screen or output which vibrational mode is being displayed, select the Print
title on plot option in the Title/Axes dialog in the Input1 menu.
.MOT files from versions of VIBRAT previous to 1997 do not transmit the lattice-type
information which is necessary for display of the unit cell. Insert the correct Bravaislattice symbol if necessary with the Lattice combo box. This does not affect the atoms,
bonds and displacements.
VIBRATZ data for a crystal can be imported in either of two ways; showing the atoms in
the primitive unit cell as a molecule; or using the normal ATOMS boundary options for
crystals (see Import VIBRAT (.MOT) files).
VIBRATZ uses two types of atoms for crystals or infinite polymers: primary atoms,
which are just those in the primitive unit cell; and secondary atoms, which are those
required to complete the bonds and angles of the complete set of internal coordinates (i.e.
force constants). Molecules do not require secondary atoms. For a crystal, the atoms of
the primitive (not Bravais) unit cell are listed in the.MOT file, but the coordinates are
given in the standard Bravais cell..
If you have imported the.MOT file as a molecule, not a crystal, this distincion is
preserved. The structure is treated as a molecule, that is there is no symmetry and no
lattice translations. Sometimes there may be more secondary than primary atoms. You
have the option to show the secondary atoms in just the same way as the primary atoms;
to mark the secondary atoms with a triangle; or to omit the secondary atoms altogether.
If you omit the secondary atoms, the bonds to them will also be omitted.
If you have imported the.MOT file as a crystal, there are no secondary atoms. If the unit
cell is non-primitive the Bravais cell is filled out (i.e. you do not see only the atoms in the
primitive cell), and all atoms which are translationally equivalent are displayed in the same
way.
To specify the details of the vectors which represent the atomic displacements, including
the scale factor, go to the Atomic Vectors dialog in the Input1 menu.
3.2.2.12

Cavity Parameters

Dialog Box: Cavity Parameters [ Input1 Menu ]
This dialog controls the Cavities display mode which uses the 3D system capabilities - if
your system does not support 3D display the Cavities display mode is not available. It is
applicable to crystals only (not molecules or polymers). The display mode is selected in
the Dialog Bar - Left or the Display Mode option in the Display Menu.
Grid spacing. This is the approximate spacing in Angstroms between sample points -
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the actual spacing may be slightly reduced from this value to give an integral number of
points across the unit cell. This should be considerably smaller than the radius of the
smallest atom. Values of 0.1 to 0.4 are reasonable. Time of the calculation is
proportional to the cube of this number.
Particle radius. This is the radius of the sphere which is presumed to exist in the
cavities. The volume shown is that enclosing possible centerpoint locations of this
sphere. If this radius is zero, the volume shown will simply be that not occupied by the
atoms of the structure.
Show cell faces. If this box is checked, the surface where the cavity volume crosses the
unit-cell faces is shown in a different color (next paragraph). If not checked, it may be
possible to see completely through a channel, although this requires that the channel be
fairly straight. The inner surface is then given a different color (next paragraph).
List Coords [Coordinates]. This will list the fractional coordinates of all grid points
which can accomodate the sphere of the specified Particle radius. The listing is made to a
text file, CAVVAL.ATD, and this file is then displayed in a Text window (see
Types of Windows).
Colors - Outer surface and Cell faces/Inner. The first color is for the outer or exterior
surface of the cavities, inside the unit cell. If the Show cell faces box (above) is checked,
the second color is for the surfaces where the cavities cross the unit-cell faces. The cellface surfaces may be especially important in judging the continuity of the cavities. If the
Show cell faces box (above) is not checked, the second color is for the inside or inner
surface of the cavities themselves. The material parameters used
(3D Parameters/Materials, Input2 menu) are those for polyhedra. As for polyhedra, the
specular component is usually best kept small.
In VRML files the viewer controls the color of inner surfaces - it is impossible to specify
the color without redrawing the surface (i.e. there is only one color per surface in a
VRML file). Some viewers may make the inner surfaces the same color as outer surfaces
(there may be a switch specifying that surfaces are "double sided"), some may make them
black and some may make them transparent. For VRML files it is safest to check the
Show cell faces box above.
Offset (fraction of unit cell). This allows the boundaries of the crystal volume shown
to be offset by a fraction of the unit cell (axis length). The offset is always in a positive
direction, and the lower and upper boundaries are offset by the same amount. The
Offsets shift the boundaries of the volume shown, not the unit cell itself or the unit-cell
Displacements in the Axes/Unit Cell option.
Number of unit cells. You may display multiple integral unit cells in any of the axis
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directions. The extra unit cells extend in the positive directions of the axes. You cannot
display fractions of unit cells.
Porosity. This is the fraction of the volume of the unit cell which can accomodate the
given size particle. The value shown is for the the last plot (which could be printed or file
output, rather than screen display). To get true porosity, set the Particle radius to zero.
Changing the Grid spacing or Offset requires a recalculation of the grid, and thus you
must select Calculate in the Dialog Bar - Left or File menu. Changing other parameters
only requires Replot.

3.2.3

Input2 Menu (Graphics Window)

Note: if the screen is narrow, this may be a submenu in the Input menu.
Crystal Edges - This controls the display attributes (color, etc.) of the edges defining
the exterior crystal shape, if present.
Perspective - Controls drawing in perspective versus straight projection.
Stereopairs - Controls automatic drawing of stereopairs.
Rims - Controls presence or absence of rims on atoms and bonds and edges on
polyhedra.
Linewidths - Controls widths of lines used as edges, etc.
Shading - Controls three-dimensional shading.
Background Color - Controls background color (ignored for b/w display or output).
Crystal Axes - Controls display of crystal or structure axes.
Unit Cell - Controls display of the unit cell, which may be drawn as edges or solid
(translucent) faces.
Ellipsoid Parameters - Controls the drawing of ellipsoids and stick bonds in the
Thermal Ellipsoids and 3D display modes.
3D Parameters - A pop-up submenu, controlling aspects of the 3D Display mode.
---- General - Some overall parameters.
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---- Lighting - Number, direction and/or location of lights.
---- Material - The way the atoms, bonds and polyhedra reflect or emit light.
---- Fog (Fading) - Aids the illusion of depth.
---- Polyhedra - Some aspects of polyhedra specific to the 3D drawing mode.
PDB (Protein) Display - A pop-up submenu (no dialogs), controlling which atoms are
plotting in Protein Data Bank structures.
----All Atoms
----Omit All Hetatoms
----Omit Water
Initial Orientation - Controls the orientation which can be imposed after calculation and
before first viewing.
Scaling - Controls scaling modes and factors.
Centering and Displacements - Controls displacements and automatic centering of the
image.
Calculation Output - Controls the listing of the analytical results of the calculations
such as atom locations, bonds, etc.
Atom/Bond Plot States - Allows changing the plotting or non-plotting status of
generated atoms and intermolecular bonds.
3.2.3.1

Crystal Edges and Faces

Dialog Box: Crystal Edges and Faces [Input2 Menu]
This dialog controls the appearance of the display crystal shape. The
Crystal Forms for Display dialog in the Input1 menu controls the actual generation of the
faces which make up this shape.
Display. Crystal means the edges which define the external boundary faces. Atoms
means the atomic structure including bonds and polyhedra. If you are drawing a
molecule or polymer, crystal edges are not normally shown, but you can nevertheless
display a crystal shape if desired.
Edges Only/Faces Only/Both. In 3D display modes the actual planes of the crystal
faces can be shown, instead of or in addition to the edges between faces. Set the
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Opacity and color of the faces in the group at the bottom of the dialog.
Dash length and dash ratio. The dashes are used for back edges of crystals and in
display of Crystal Axes and Unit Cell. Length or repeat distance is in inches/centimeters,
and the length factor is the actual length of the solid part divided by the repeat distance.
Note that when using Frames in output the dash length remains the same - it may be
desirable to decrease the length for very small plots.
Back edges - those not visible if the crystal is opaque - may be specified as none (not
shown at all), dashed or solid.
Lines/Cylinders. In 3D display modes the edges may be shown as lines or cylinders of
the specified width.
Colors, Patterns, Pen numbers. Front edges are those which are visible; back edges are
not visible in an opaque crystal. Widths of lines are set in the Line Widths dialog in the
Input2 Menu). See Input Colors/Patterns/Pens for general aspects of input.
For alternate ways of drawing unit cells, and problems sometimes encountered with
crystal edges, see Drawing Crystal and Unit-Cell edges.
3.2.3.2

Perspective

Dialog Box: Perspective [Input2 Menu]
If perspective is not in effect, or turned off, the drawing is simply a perpendicular or
orthographic projection down the observer x axis. If perspective is on, the drawing is
projected from a point (xp+xo, yo, zo), where xp is the perspective distance and xo, yo
and zo are the projection offsets (below), perpendicularly onto the plane (xo, y,z ), that is
a horizontal plane passing through the structure center. Scaling applies to the projection
plane, but obviously fixed scaling has limited intrinsic meaning. Generally the scaling
modes Universal Maximum or Each View Maximum (set in the Scaling dialog in the
Input2 menu) should be used when perspective is in effect. The perspective distance is the
distance xp of the projection point from the projection plane, or in other words the
distance from which the structure is viewed (distance from the center of the structure to
the eye). Smaller distances will accentuate the "perspective"; larger distances will cause
the plot to appear more like a straight-on projection. The perspective distance should be
considerably larger than the distance of the furthest atom from the center (or the plane
x=xo) in the positive x direction. If atoms come within about 1 Angstrom of the x
coordinate of the eye they will be omitted, but many of such atoms would be off scale
(sideways) anyway.
Projection Offsets. During calculation the midpoint of the structure is determined - this
includes all atoms, but does not include crystal edges, unit cell or axes. When projecting
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in Perspective viewing, the coordinates of this midpoint, xo, yo and zo are used as the
coordinates of the projection point (xp+xo, yo, zo), where xp is the perspective distance.
This insures that the projection is never oblique to the projection plane. This is equivalent
to the Automatic Centering option in previous versions of ATOMS. Although arbitrary
specification of the offsets is no longer allowed, you can attain almost any attitude of the
structure by suitable rotations. Note that the structure can be displaced in the plotting
area with the Centering and Displacements dialog (Input2 menu). In effect, the
projection direction moves along with the structure. If you also have structure axes or a
unit cell (Display of Axes and Unit Cell dialogs, Input2 menu) which are separated from
the structure, they will be projected obliquely, according to their distance in Angstroms
from the structure center; that is, if you are looking down, say, the a-axis in the structure
itself, structure axes placed to the side will not have that axis exactly parallel to the view
direction. You can rotate to effect a compromise between the two orientations.
3.2.3.3

Stereopairs

Dialog Box: Stereopairs [Input2 Menu]
When stereopair display is on, two images of the structure will be drawn. The upper part
of this dialog pertains to non-Anaglyph display modes, in which each image centered in
one half of the plot area. The left or left-eye image will be rotated by the stereopair
Rotation angle clockwise from the normal orientation, and the right-eye image will be
rotated the same amount counter-clockwise. If shading is active the illumination vector
will be rotated along with the structure. The stereopair rotation angle is typically about 3
degrees, although the proper angle may vary depending on the perspective distance, the
actual viewing method, etc.
The Stereopairs on check box applies only to separated-image stereopairs drawn in nonAnaglyph display modes.
If the hard copy of stereopairs is to be viewed directly or with a small viewer, a frame
size in the dot-matrix or pen plot of 4 to 5 inches across will give a distance between the
two images about equal to the normal interocular distance. If you want a pair of images
larger than a single page, you can use the Stereopair Rotation in the Rotation menu to
rotate the images separately, if shading is in effect; if shading is not in effect, ordinary
rotation on z is sufficient..
Few people can directly view a stereo pair as shown on the full screen because the images
are considerably further apart than the eyes. However, if a negative rotation angle is used,
some people can view the image by crossing their eyes.
The lower half of the dialog pertains to the Anaglyph display mode, selected in the
Display Mode command in the Display menu, or the Dialog Bar - Left. In this type of
display, there are two skeletal images of two different colors, superimposed. Generally
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red/blue with a black background works best for the screen, while red/green with a white
background works best for printed output. However, depending on the color of the
glasses, red/cyan may work better for either.
The stereopair Rotation Angle for anaglyphs is separate from that for separated-image
stereopairs, since a smaller angle is usually better (e.g. 2 degree instead of 3). The angle
for anaglyphs should always be positive, whereas that for separated-image stereopairs
may be negative for cross-eyed viewing.
---- Windows only ---Anaglyphs in 8-bit (256-color) screen modes are not drawn correctly, because the colors
are not added correctly for areas of red/green or red/blue overlap. If possible, switch
Windows to a "true color" (16-, 24- or 32-bit) mode to get a correct drawing.
---- Macintosh only ---The Macintosh adds colors correctly even in 8-bit screen modes.
---- End Macintosh only ---Colors are not added or mixed correctly for labels in anaglyph mode.
3.2.3.4

Rims/Edges

Dialog Box: Rims [Input2 Menu]
In the Standard and Thermal Ellipsoid display modes, this controls the drawing of rims
and edges for all the atoms, polyhedra and bonds. Colors and shades for rims and edges
are entered in the input for atoms, polyhedra and bonds. Note that edges for polyhedra
include edges that appear in the front, as well as those forming the outline.
Generally, rims should be turned on for all types of black-and-white images. They should
usually be off for atoms and bonds with color shading with 8-bit or greater pixel depth,
although you may wish to show polyhedron edges. Color images with black dithering,
such as 4-bit raster files, usually look better with rims. Rims in color images should
usually be black or a dark color.
Rims are never used in the 3D display mode.
3.2.3.5

Line Widths

Dialog Box: Line Widths [Input2 Menu]
The widths are in inches or centimeters. If the value is 0.0, the lines will be only one dot
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wide. For black-and-white display and output, one-dot lines will always be solid black,
while wider lines can have gray shades or patterns.
If the Use individual box is checked for atoms, bonds or polyhedra, the individual line
widths entered for each in the dialogs of the Input1 menu will be used instead of the
overall values in this dialog.
When reading older files written with ATOMS for the Macintosh or for Windows V3.0,
in which the line widths are in dots, the conversion to floating-point is made using the
resolution values for the current printer.
Note that line widths in 3D Display Mode are always one pixel. You can use cylinders of
any desired diameter instead of lines for Crystal Edges, Crystal Axes or the Unit Cell
(also 3D General dialog in the Input2 menu).
3.2.3.6

Shading

Dialog Box: Shading [Input2 Menu]
For 8-bit screen display and raster files, the number of shading zones determines the
nature of the 256-color palette generated by ATOMS and the number of colors available
for shaded atom, bond and polyhedron fills. If the number of zones is 16 or fewer, you
can use all 16 colors from the 16-color palette, except black, and there are 16 gradations
of each color. If the number of zones is greater than 16, you should use only the first 8
colors in the palette numbered from 0 to 7, each of which has 32 gradations. See
Colors, Palettes and Dot Patterns for more details.
Darkness angle (degrees). For an isolated object in a vacuum, the intensity of
illumination should vary from maximum to minimum as the angle varies from 0 to 90
degrees. However, this would be a very "hard" illumination, and ATOMS allows for a
"softening" or diffusing of the illumination in two alternative ways, by darkness angle or
by darkest shade. The darkness angle, or the angle at which the illumination becomes zero
or minimal, can vary from 90 to 180 degrees.
Darkest shade (fraction). This option "softens" the shading by allowing the presumed
illumination of the darkest zone to be other than zero. Small values of this fraction, such
as 0.1 or 0.2, are usually appropriate. It is 0.0 by default.
Use initial pattern numbers. Each atom, bond or polyhedron type is given a fill pattern
number or gray shade for use in black-and-white screen displays and dot-matrix images,
and this is used if shading is turned off. If shading is on, the shading normally starts from
pattern zero, white. However, if the initial-pattern-number option is on, this pattern is
used as the initial pattern number, for maximum illumination, other zones then increasing
in darkness from this pattern number rather than from zero.
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This option can be useful for spherical atoms, which all show the same shading zones, but
is less successful for stick bonds and polyhedra, which will show different shading
depending on their orientation.
Front-back fading. The initial or unshaded colors of atoms, bonds and polyhedra can be
made to darken with depth (decreasing x coordinate). The foremost atom (greatest x
coordinate) is considered to have full illumination, and illumination drops off to the rear
according to the fading factor. The unit of fading is fraction of full illumination per
Angstrom. If the structure has already been calculated, the factor for complete fading
(black at the rearmost atom) is shown.
3.2.3.7

Background Color

Dialog Box: Background Color [Input2 Menu]
The best color for background may be neither white nor black - sometimes gray brings
out shading and front-to-back fading better. The background for black-and-white display
and output is always white.
Using colors other than white, black or gray for background may result in increased size
of Raster or bitmap files and PostScript files in 3D modes. In some cases a simple runlength-encoding method is used for compression of these files, and this fails for 24-bit
RGB (true color) files when the three components are not identical. That is, for a row of
white pixels the sequence of bytes is 255, 255, 255, 255... whereas for a row of red pixels
it is 255, 0, 0, 255, 0, 0...
3.2.3.8

Display of Crystal Axes

Dialog Box: Display of Crystal Axes [Input2 Menu]
Structure axes cannot be drawn on stereopairs in non-3D display modes.
If perspective viewing is on, the axes are projected as if they intersected at the origin,
although in non-3D modes they are drawn as if they were in front of the structure as well
as any crystal edges present. If the Dashed box is checked, the c axis is shown solid, the
b axis is dashed with the dash length and interval set in the Preferences dialog in the
Settings menu or the Crystal Edges dialog in the Input2 menu, and the a axis is dashed
with half these intervals.
If the Include in scaling box is checked the axes will not go off-scale in either the
Universal or Maximize for each view scaling modes (Scaling dialog, Input2 menu).
In the 3D display mode, the axes can be either lines or cylinders with the specified radius
(which can also be set in the General sub-option of the 3D Parameters command in the
Input2 menu). The axes are not shown in Stereopairs in non-3D display modes since
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they do not have a definite location in space, but they are shown in stereopairs in the
3D display mode
The Scale factor refers to the distance from the center to either end. Thus a scale factor
of 0.5 gives lines equal in total length to the axes. In non-3D display modes, the axes are
always shown in front of the atoms and faces.
The Labels, if selected, will be on the positive ends of the axes.
Use PostScript font. This allows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and slant (italic, oblique) of the font, but not the size, which is specified in
the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.
The Displacements can be used to separate the structure and axes, for example to put a
small axial cross in a corner of the drawing. Note that you can also move the structure
with the Centering and Displacements command in the Input2 menu. The Scale Grid
can assist in these displacements. In 3D display mode, the axes may interpenetrate with
the structure, and the x-coordinate or front-back displacement is also relevant. Unlike
the Unit Cell, the crystal axes are not fixed with respect to the structure, rather their
location is specified in observer coordinates (see Coordinate Systems), with respect to
the center of the structure.
Clicking in the plot area after clicking on the Locate with Mouse button will determine
the y and z (across and up) coordinates, all that is required in non-3D display modes; in
3D display mode the x (front-back) coordinate will be unchanged and can be set
independently.
Projection - Orthographic/Perspective. If Perspective (Input2 menu) is off, the axes
are always projected by the orthographic method, in the same way as the structure. If
Perspective is on, the projection point is always on a perpendicular to the projection
plane (screen or paper) passing through the approximate center of the structure. If the
Perspective radio button in this group is chosen, the axes are projected from the same
point, as a three-dimensional object. This means that if the axes are displaced from the
center of the structure, they are viewed obliquely, and it may not be obvious that they are
in parallel orientation with the structure. This can be confusing to the observer who is not
aware of the complexities of perspective projection. If the Orthographic radio button is
selected, the axial cross is projected orthographically, which usually is more satisfactory.
If the axes are at or near the center of the structure, there is little or no difference
between the two methods.
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Display of Unit Cell

Dialog Box: Display of Unit Cell [ Input2 Menu ]
For alternate ways of drawing unit cells, and problems sometimes encountered with
crystal edges, see Drawing Crystal and Unit-Cell edges.
The unit cell is a simple box, with front and back edges having the colors specified. No
distinction is made between "front" and "back" edges. In non-3D display modes, the unit
cell is shown in front of the structure, like the structure axes, while in 3D display mode it
has a definite location in space and may interpenetrate with the structure depending on
the Displacements.
In non-3D display modes, only the edges may be shown, while in 3D modes faces may be
shown as opaque or translucent planes.
Edges may be Dashed in non-3D modes only. The dash length and interval are set in the
Preferences dialog in the Settings menu or the Crystal Edges dialog in the Input2 menu.
If the Include in scaling box is checked the unit cell will not go off-scale in either the
Universal or Maximize for each view scaling modes (Scaling dialog, Input2 menu).
For non-primitive lattices, you can choose either the Bravais or Primitive cell; the
primitive cell will have the same shape as that generated by the Default Unit Cell
boundary option (if a primitive cell is selected in that option also).
In 3D modes the edges may be shown as lines, which are always one pixel wide, or as
cylinders with the specified radius. In non-3D modes edges are always drawn as lines the width is set in the Line Widths dialog (Input2 menu).
The unit cell is not shown in Stereopairs in non-3D display modes since it does not have a
definite location in space, but it is shown in stereopairs in the 3D display mode.
In 3D display mode, and in perspective viewing in non-3D display modes, the unit cell
applies to only one location in three-dimensional space. Change this location with the
Displacements button, which calls the Unit-Cell Displacements dialog.
See Input Colors/Patterns/Pens for general aspects of color input.
3.2.3.10

Unit-Cell Displacements

Dialog Box: Unit-Cell Displacements [Unit Cell dialog]
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The unit cell drawn with the Unit Cell dialog (Input2 menu) has its origin at particular
coordinates in the structure coordinate system. The displacements from 0,0,0 are in
fractions of the current cell vectors, which may be either primitive or Bravais vectors.
The current vectors, in terms of components in the axes used for atomic coordinates
(normally the Bravais cell edges), are listed; these are trivial unless you have chosen a
primitive cell for a non-primitive Bravais lattice. If you have chosen the -0.5 to 0.5
suboption of the Default Unit Cellboundary option, the boundary volume is centered on
the origin, so the displacements -0.5, -0.5, -0.5 will cause the unit-cell outline to coincide
with the edges of the boundary shape. For the 0 to 1 suboptions use the displacements 0,
0, 0.
3.2.3.11

Ellipsoid Parameters

Dialog Box: Ellipsoid Parameters

[ Input2 Menu ]

This dialog controls plotting parameters for the Thermal Ellipsoid and 3D display modes,
set in the Display Mode sub-menu in the Display menu or in the Dialog Bar - Left
The following parameters are those which are in the various instruction series of ORTEP.
NPLANE - drawing of ellipses
= 0, no ellipsoid components
= 1, boundary ellipse only
= 3, principal ellipses only
= 4, boundary + principal ellipses
NDOT - back side of principal ellipses
< 0, solid line back side
= 0, back side omitted
= 3, 4 dots on back side
= 4, 8 dots on back side
= 5, 16 dots on back side
= 6, 32 dots on back side
NLINE - forward principal axes and shading (cut-out octant)
= 0, no forward axes or shading
= 1, forward principal axes only
= N, forward axes + (N-1) line shading
NDASH - dashed reverse principal axes
= 0, no reverse axes
= N, dashed reverse axes with N dashes
NBOND - bond type for stick bonds
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= 0, no bonds
= 1, 2, 3, 4, 5 give lines at 180, 90, 45, 22.5 or 11.25 degrees apart, bonds ending
at ellipsoids
= -1 to -5, same, bonds ending at atom centers
TAPER - bond taper. The bond radius is
R = R0 +- TAPER * ABS( COS(THETA) )
where theta is the angle between the bond and the view direction. The bond radius is set
in the Bond Data dialog (Input1 menu).
SCAL2 - ellipsoid probability scaling factor.
This controls the size of ellipsoids. A value of 0.76 gives 10% probability, 1.54 gives
50% probability, 3.36 gives 99% probability, etc. See the table in the original ORTEP
instructions.
DISP - retrace resolution.
When lines are retraced to emphasize certain ellipsoids or make the width a function of
depth, this is the separation.
A0 and A1 - depth function parameters.
Lines may be retraced to give wider lines for closer ellipsoids.
dR(x) = AO + A1 * x
where dR is the width of the line and x is the height in Angstroms.
Use b/w shades. If this box is checked, ellipsoids in black-and-white display and output
will be filled with the b/w shade or color specified in the Input Atom Data dialog (Input1
menu). If it is not checked, they are filled with white before drawing ellipsoid
components.
Show iso as spheres. If this box is checked, isotropic atoms are shown as spheres (i.e.
circles) without the principal planes, which can give a false impression of anisotropy.
Default radius. This is the mu value which is given to atoms with no valid entered
temperature factors; it is 0.1 by default.
If DISP is 0.0, lines are not retraced. For one-dot lines on typical screens, DISP should
be about 0.01 inch, but it can be much smaller for output. Note that x is measured from
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the zero of coordinates, not the rear-most atom
Line widths for atoms are set independently in the Line Widths dialog (Input2 menu), and
the value of DISP should take account of these settings if wide lines are used.
For color display and output, depth is probably best shown by front-back fading of color
(Shading dialog, Input2 menu) rather than line retracing.
3D Mode. If the Show in 3D mode box is checked, and if temperature factor data have
been entered, atoms will be shown as ellipsoids in the 3D Display Mode. If NLINE is
greater than 0, the "forward axes" or cutout octant is shown as in ORTEP (except in 3D
files - see below). If NPLANE is greater than 1, the trace of the principal planes will be
shown as stripes or three-dimensional bands just outside the ellipsoids. The Width of
principal- plane stripes gives the width of these bands. The Radius Factor for stripes
gives the height or extent to which the curves for the principal planes are outside the
ellipsoid itself; this should always be larger than 1.0. By increasing this factor and
decreasing SCAL2, the principal planes can be made to dominate the representation, as
elliptical disks.
For direct screen and print rendering, the bonds between ellipsoids are the same size as
shape as in ORTEP drawing, and the TAPER parameter is applicable. In 3D files
(VRML and POV-Ray), bonds are always strictly cylindrical. Also in these files, the
ellipsoids are always complete and do not have the cutout octant as possible in ORTEP
drawing. When Polyhedra are present, and ligand atoms are not shown at the corners,
bonds to these corners are always cylindrical, not tapered. Note that the option to show
corner atoms as spheres of constant size is not applicable to the 3D mode - such atoms
are either absent, or shown as thermal ellipsoids. Of course, the atoms could be
converted to isotropic temperature factors of appropriate size.
The SCAL2 parameter above determines the size of the ellipsoids as in the Ellipsoid
drawing mode. Apart from SCAL2, TAPER, NLINE and NPLANE the ORTEP
parameters above are not applicable to 3D drawings.
The 3D Material parameters used for both the cutout octant and the principal-plane bands
are those for polyhedra - this is to avoid distracting specular reflections from large flat
surfaces (although polyhedra may be assigned large specular reflection components as
well).
Polyhedra in Ellipsoid mode (non-3D) group. In the Ellipsoid display mode, you can
either show polyhedra with flat, opaque faces (last option), or you can show the ligandligand "bonds" which are the edges of polyhedra, and also the central-ligand bonds. Both
of these types of "bonds" are as defined in the Polyhedra input in the Input1 menu, not
the Bonds input. The ligand-ligand "bonds" or edges will have the fill and edge colors
which are specified for the given polyhedron in the Polyhedron Data dialog, and the
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central-ligand "bonds" will have the edge and fill colors of the central atom
(Input Atom Data dialog). Both these bond types will have a uniform radius, as specified
in the edit box.
The intersections of the solid polyhedra with the corner ellipsoids are not solved exactly,
but approximated assuming the corner atoms are spheres. The size of these spheres is
determined by the settings in the Polyhedra dialog (Input1 menu). This approximation
will be less acceptable as the ellipsoids deviate further from sphericity.
All the atoms involved in polyhedra, except for the central atom in the case of solid
polyhedra, will be shown as elllipsoids.
The central-ligand and ligand-ligand "bonds", if used, must be added to the bond list
during calculation, so changes in this option may require Recalculation, rather than just
replot.
3.2.3.12

3D General

Dialog Box: 3D General [ Input2 Menu ]
In the 3D drawing mode, crystal edges (Crystal Edges and Faces dialog), structure axes
(Crystal Axes dialog) or unit-cell edges (Unit Cell dialog) may either be lines or
cylinders. If they are lines, the width is set in the Line Widths dialog (Input2 menu).
Rims of atoms and bonds and edges of polyhedra are never shown, so the relevant values
are for edges (which include axes and unit cell) and bonds (which include skeletal bonds.
Width of lines in VRML files cannot be controlled. Wide lines in 3D generally do not
look good, so if width is to be more than one pixel, cylinders are better.
Spheres (atoms) and cylinders (bonds or vectors) are actually drawn as assemblages of
planar polygons, the number of which is determined by the Subdivisions... setting
(below).
If the Thermal ellipsoids box is checked, and if temperature factor data have been
entered, atoms will be shown as ellipsoids in the 3D Display Mode. Some of the
parameters in the Ellipsoid Parameters dialog may need to be adjusted - see that dialog
for further details.
Subdivisions per quadrant... Spheres or ellipsoids (atoms) and cylinders (bonds or
other lines) are drawn as assemblages of flat faces, and this parameter determines the
fineness of the subdivisions. The default value of 5 may need to be increased for very
large atoms. This parameter replaces the Slices and Stacks parameters in V4.0 of
ATOMS - in V4.0 files, values of Subdivisions will be obtained from the sphere Slices
number. The Slices for spheres and cylinders number is 4 times the Subdivisions, and
Stacks for spheres is 2 times the Subdivisions. Cylinders have only one stack. Ellipsoids

© 2002 Shape Software

114

ATOMS Help

are distorted spheres (it could also be said that spheres are special ellipsoids) and they use
the same subdivision parameters.
Bonds between ellipsoids, which are drawn in ORTEP style, have either 4 or 8
Subdivisions per quadrant, according to whether the value entered is less than, or equal to
or greater than 6.
3.2.3.13

3D Light Sources

Dialog Box: 3D Light Sources [ Input2 Menu ]
There may be as many as 8 light sources in the 3D drawing mode, and each may have a
different color.
Each light may be either Directional, in which case all rays are parallel in a given
direction; it may be Positional, in which case all rays emanate from a given point; or it
may be Ambient, in which case the rays bathe all objects uniformly - there is no
directional quality. If the light is Directional, the x, y and z coordinates in the
Position/Direction box give the direction vector. If the light is Positional, the
coordinates give the location of the light source, in Angstroms in the Observer coordinate
system. Ambient light is neither directional or positional and these coordinates are not
used.
There may be only one ambient light.
Each light has only one color. For non-ambient lights, the diffuse and specular
components have the same color and intensity. The absolute values of the RGB
components determine the intensity of the light - for example, 0.2, 0.2, 0.2 gives a white
light of one/fifth the maximum intensity.
Since the colors and Material properties for each atom, etc. are specified individually, the
Ambient, Diffuse and Specular Colors should normally be white (1.0, 1.0, 1.0).
However, they can be changed for special effects or to correct color distortions in display
or output devices.
The color of a given object is the resultant of the colors of the various lights, the color
specified for the object itself in the dialogs of the Input1 and Input2 menus, and the
Material coefficients. See Lighting Equation for details.
Attenuation . The incident intensity from a light source is itself subject to attenuation
according to the equation
Ii = Ii(0) / (Kc + Kl d + Kq d^2 )
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Where d is the distance of the point in question from the (positional) light and Kc, Kl and
Kq are the constant, linear and quadratic attenuation coefficents respectively. Constant
attenuation is essentially a brightness coefficient. Values larger than 1.0 simply darken
the scene. Values smaller than 1.0 may add a white component and/or increase the
specular contribution. Linear and quadratic attenuation apply only to Positional lights.
3.2.3.14

3D Fog

Dialog Box: 3D Fog (Fading) [ Input2 Menu ]
Fog in the 3D drawing mode is similar to fading (Shading dialog) in the Standard
drawing mode - it contributes to the illusion of depth by changing the color as a function
of distance from the eye. It blends the specified foreground color for the atom, bond or
other object with the given background or other specified color, on a pixel-by-pixel basis.
This can be according to one of three equations, selected with the radio buttons in the
upper left of the dialog.
Linear:

f = (end - z) / (end - start)

Exp:

f = exp[-density * z]

Exp2:

f = exp[(-density * z) ^2]

where z is the distance from the eye and f is the fraction of the initial color, the remainder
being the fog color specified in the lower part of the dialog. Note that the color in this
case is specified by RGB components varying from 0.0 to 1.0 (floating point) rather than
0 to 255.
ATOMS sets the parameters start and end at the foremost and rearmost atoms, or
calculates the density, using the specified Fraction of intensity at rear. That is, the
foremost atom will always have the pure (non-fogged) color (f = 1.0), and the rearmost
atom will have the specified fraction (f) of the pure color and the remainder the fog color.
For example, if the rearmost atom is to blend into the background, i.e. disappear, set the
Fraction of intensity at rear at 0.0 and check the Use background radio button. If the
fog color is not the current background (Background Color dialog, Input2 Menu), it will
usually be black (0.0, 0.0, 0.0).
Fog or fading may also be referred to as depth-cueing.
3.2.3.15

3D Material Properties

Dialog Box: 3D Material Properties [ Input2 Menu ]
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In the 3D drawing mode the material properties of objects determine the way the objects
interact with the light sources.
The color observed at a given point is a resultant of the light source(s) (3D Lighting) and
the material properties; that is, the RGB coefficients of the Ambient, Diffuse and
Specular components of the light source(s) are multiplied by the specified colors of the
objects, and by the material coefficients in this dialog, then the results are limited to the
range 0.0-1.0. See Lighting Equation for details.
Ambient light has no direction or origin and is considered to bathe all objects uniformly.
Having a significant ambient component causes non-illuminated parts of objects to be
other than black. It thus "softens" the illumination in a somewhat similar way to the
Darkest Shade and Darkness Angle parameters (Shading dialog) in the Standard
display mode. Note that there must be a separate ambient light to show this component.
Diffuse color is usually the main component of the appearance of objects. The intensity
of the color is dependent on the angle between the light ray and the normal to the surface
in question.
Specular reflection only occurs when the normal to the surface in question is close to
bisecting the angle between the incident light and the vector from the point on the surface
to the eye. It produces bright highlights on a curved surface. The larger the
Shininess coefficient, the smaller will be the bright specular highlight on a curved
surface. The shininess coefficient has a maximum of 128 because of computational
restrictions, but values on the order of 5-30 are usually realistic.
In ATOMS, specular reflection is always white, that is it does not depend on the color of
the object, only the color of the light source(s). Specular reflection does not work well
for polyhedra because faces at the reflection angle will give an essentially solid white
appearance, rather than a bright spot. This is because the angle is calculated for the
corners of the face, and interpolated for each point in the interior of the face.
When thermal ellipsoids are shown in the 3D mode (see Ellipsoid Parameters), the
material parameters used for both the cutout octant and the principal-plane bands are
those for polyhedra - this is to avoid distracting specular reflections from large flat
surfaces.
Emission is similar to ambient, except that there is no dependence on the color of any
light source. A high value of emission makes an object look like is is glowing.
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3D Polyhedra

Dialog Box: 3D Polyhedra [ Input2 Menu ]
This dialog specifies some special ways of displaying polyhedra in the 3D display mode
which are not available in non-3D modes.
The Polyhedron Mode can be:
1) Completely opaque. This is similar to Standard display mode (but edges cannot be
shown);
2) Skeletal, no bonds or 3) Skeletal, with bonds. The skeletal modes show the ligandligand bonds or polyhedral edges, with the central atom as a sphere.
4) Translucent, no bonds or 5) Translucent, with bonds. The polyhedron faces may
all be translucent, in which case objects behind show through, or you may check the Back
faces opaque box, in which case the interior may be seen, but nothing behind the
polyhedron. Complete translucency may be confusing if there are many polyhedra, i.e.
polyhedra behind polyhedra.
Translucency may increase computation time. Support for translucency may depend on
the platform and output mode. VRML files do not support Back faces opaque.
Viewers for these files may not support translucency.
The Opacity (1.0-transmission) for the translucent modes may be specified, but again
system software and file viewers may not support a complete range.
Ligands may be shown as spheres, or only as intersections of the ligand-ligand bonds.
Planar polyhedra are shown as plates with a finite thickness, with or without the central
atom.
3.2.3.17

Initial Orientation

Dialog Box: Initial Orientation [ Input2 Menu ]
Any initial Cartesian rotations specified here will be be applied to the x, y and z structure
Cartesian axes (see section IV-4) in that order after the atoms are located and boundaries
determined and before the structure is first displayed. If initial clinographic viewing is in
effect, the clinographic rotations are applied after these initial rotations.
If the Clinographic viewing box is checked, the clinographic rotation (see
Coordinate Systems) will be applied at the end of the calculation, after any initial
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Cartesian rotations. It may be turned off with the Clinographic Viewing command in the
Rotation menu (or the ClinographicViewing command in the Display menu).
When exiting, ATOMS checks to see if the orientation has changed from the initial
orientation defined in this dialog. If so, you have the option of saving the current
orientation. This orientation will be converted into initial rotations on x, y and z, plus
initial clinographic viewing if that is in effect.
Summary of orientation operations. ATOMS first sets the c structure axis parallel to the
z viewer axis, and the a * structure axis (perpendicular to b and c ) parallel to x. This is
the original orientation. Next, if the Slice boundary option is in effect, the slice is
oriented with the slice plane parallel to yz, and the orientation vector parallel to z. Then
the initial Cartesian rotations, if any, are applied. Finally, the clinographic rotations, if
selected, are applied. This is the initial orientation.
3.2.3.18

Scaling

Dialog Box: Scaling [ Input2 Menu ]
Scaling and displacement operations do not apply to the actual values of atom and corner
coordinates and face coefficients, which are permanently set (in Angstroms) by axis
lengths and fractional coordinates and the central distances of the faces. Rescaling and
displacement apply only to the plotting coordinates in screen, dot-matrix or pen-plotter
displays.
Scale mode. There are three modes of scaling:
----Maximize size for each view. In this mode, the structure is scaled in each orientation
so that it is just smaller than the viewing area. The actual scale will therefore change
whenever the structure is rotated. Hard copy is scaled the same way and what you see is
essentially what you get. Note that the Rescale factor (below) is now applied - this has
the effect of reducing or enlarging the size of the viewing area as used for determining the
scaling.
----Universal maximum. In this mode, the structure is scaled so that its maximum
dimension is just smaller than the minimum dimension of the plotting areas; thus,
rotations can be made without changing the scale and without going out of bounds.
Again, hard copy is scaled the same way and what you see is essentially what you get.
Note that the Rescale factor (below) is now applied - this has the effect of reducing or
enlarging the size of the viewing area as used for determining the scaling.
----Fixed scale factors. This suboption allows you to set the scale to a fixed number of
inches or centimeters per Angstrom for the dot-matrix and/or pen plot, or simply to
reduce or enlarge the image from the automatic scaling modes.

© 2002 Shape Sof tware

ATOMS Menus and Dialogs

119

Rescale factor. This factor is always applied in the Maximize size for each view and
Universal maximum modes. When you "zoom" or rescale with the scaling buttons in
the Dialog Bar - Right, this changes the rescale factor (rather than changing to the Fixed
scale mode, as in pre-V4.2 ATOMS).
Scaling for the screen and normal printer output (Print command in the File menu)
depends on the resolutions (dots per inch or centimeter), which are obtained from the
software drivers for these devices. Resolution for the printer may often be reset in the
Page Setup dialog in the File menu. The resolution for the Pen Plotter is set in the
Pen Plotter Settings dialog, and that for a direct PostScript printer is set in the
Postscript Settings in the Settings menu.
The Dialog Bar - Right allows "zooming" or incremental adjustment of the scale factors
in the Fixed mode, or the Rescale factor in the other modes.
3.2.3.19

Calculation Output

Dialog Box: Calculation Output [ Input2 Menu ]
This output gives information on the results of the initial calculation, including locations
of all atoms, all faces generated, and atoms involved in bonds and polyhedra. It is
regenerated every time you use the Calculate command in the File menu.
Output. Output, if selected, is sent to a file with title infile.ATD, where infile is the
name of the input file. The.ATD file will be in the same directory as the.STR file (data
directory). You can elect to show this file on-screen in a Text window, which is a
standard edit window - see Types of Windows.
Note that the output referred to here gives the original atom locations without any
rotations whatsoever, while the List Generated Atoms command in the File menu gives
current Cartesian atom locations.
Bond lengths and angles. Bond angles are part of the normal bond output, so in order
to get angles, you must also check the Bonds box. You have the option of calculating
the angles on all atoms, or only on one atom of each symmetry-equivalent set (input
atom) which occurs in the final atom list. ATOMS will find the generated atom which is
closest to the zero point.
Note that angles will only be calculated for bonds which have been specified for display,
and angles will only be calculated for atoms within the boundaries specified in the
Boundary option. Angles within polyhedra will not be calculated. If the boundaries of the
structure are not large enough, you may not get a complete set of bonds and angles on
any given atom. Specifying the Default Unit Cell boundary option will not guarantee that
you get a complete set, unless you select the third suboption in that dialog, which
completes the coordination of all atoms in the unit cell.
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Bond lengths and angles about any input atom can can be obtained immediately with the
Coordination button in the Input Atoms dialog (Input1 menu).
3.2.3.20

Centering/Displacement

Dialog Box: Centering/Displacement [ Input2 Menu ]
Automatic centering will center the structure in the current viewing area. This is done for
each view, and any displacements entered under Constant Displacements are ignored.
In most cases, the easiest way to scale and position a drawing onto a printed or typed
page is to use the frame options in the Print command or other options in the File.
However, the displacements in this section can be used to position the drawing within the
frame defined in those suboptions.
The displacements are used only in plotting and are not actually part of the atomic
coordinates. Note that the center of rotation is not changed by these displacements - that
is, the structure is always rotated about its own zero of coordinates. Thus any desired
rotations should always be made before using displacements.
The Dialog Bar - Right allows centering of the viewing area on a particular projection
point in the structure. Displacements made in that dialog will affect the displacements in
this dialog (Centering/Displacement ), and may be removed here.
The Set Center button in the Dialog Bar - Right also allows centering of the viewing
area on a particular projection point in the structure.
The Scale Grid command in the Display menu is useful for showing the actual scaled
location of the structure and in estimating displacements.
For perspective viewing, the projection is made from a point related to the zero of the
observer coodinate system. If the displacements in Centering/Displacement are large, it
may be desirable to enter offsets in the Perspective dialog, or to select Automatic
Centering of the projection point in that dialog.
Note that the projection point for perspective viewing is independent of the
Centering/Displacement settings, although this point may also be centered automatically
(see the Perspective dialog).
3.2.3.21

Atom and Bond Plot States

Dialog Box: Atom/Bond Plot States

[ Input2 Menu ]

This is primarily intended for restoration of generated atoms that have been marked as
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non-plotting with the Generated Atom Data dialog which comes up when an atom is
identified by clicking with the mouse pointer in the Graphics window. However, you can
also select a range of atoms by number to mark for non-plotting. If the end number is
zero, it will be made equal to the start number, i.e. only one atom will be affected.
The Intermolecule/fragment bonds combo box (only displayed if there are bonds
between molecules or fragments) gives several options for display of inter-molecule or
interfragment bonds. If Highlighted is selected, such bonds are shown in normal colors
while all other atoms, bonds, etc. are dimmed. Other possible highlighting of molecules
or fragments is ignored.
Changes in plot states will only be shown after using the Replot command in the Display
menu.
See Deleting Atoms and Generated Atom Data .
3.2.4

Display Menu (Graphics Window)

Replot - Replots the image (does not recalculate).
Color - Switches the screen between black-and-white and color.
Atom Labels - Controls automatic labeling of atoms, using input labels.
Bond Labels - Controls automatic labeling of bond distances.
Angle Labels - Controls automatic labeling of interbond angles.
Scale Grid - Superimposes a scale grid for location of the structure or parts thereof.
Mark Atoms - Draws a small box at the location of specified types of atoms.
Clinographic Viewing - Switches clinographic viewing on and off.
DialogBar - Left - This is a control bar which is fixed on the left side of the Main
window.
DialogBar - Right - This is a control bar which is fixed on the right side of the Main
window. It contains some frequently-used controls.
DialogBar - Fragments - This controls placement and orientation of individual structure
fragments, if present.
Powder Diffraction - Produces a simulated powder diffractogram or a list of reflections.
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Precession Pattern - Produces a simulated precession photograph of a given net.
3.2.4.1

Display Mode Sub-Menu

Sub-Menu - Display Mode [Modes menu]
This sub-menu switches between the five (or six) types of display supported by ATOMS.
Note that switching between four of the five modes requires only replotting, but switches
involving the Thermal Ellipsoid mode require recalculation. Whichever is required is
done automatically.
Graphics on either Macintosh or Windows can be either 2D (or non 3D), which use the
standard system software for drawing in two dimensions; or they can be 3D, which uses
the system software ( OpenGL) for drawing three-dimensional objects. The Standard,
Skeletal, Thermal Ellipsods and Anaglyph modes are 2D, while the 3D, 3DSkeletal and
Cavities modes are 3D.
Standard. This is the main display mode in ATOMS, which supports ball-and-stick,
interpenetrating atoms, polyhedra and wire-frame representations, ranging from simple
schematic drawings to fully-shaded three-dimensional drawings.
Skeletal and 3DSkeletal. Skeletal or wire-frame representations can be drawn in either
non-3D or 3D display. The 3DSkeletal mode may be faster on the screen, but because all
3D output is by means of bitmaps printing may be slower. In either mode, there are two
choices for the method of representation. In the "Bond colors" method, atoms are shown
as small dots, except those in polyhedra; all bonds are shown as lines with the bond color,
and polyhedra are shown by lines joining the corners (outlining the faces). In the "Atom
colors" mode there are no dots for atoms, and rather than showing bonds in the color
specified in the Bond Data dialog, they are shown half-and-half in the two atom colors.
Also, polyhedra are converted to central-ligand bonds and ligand-ligand (corner-corner)
lines are not shown. The choice between these two modes of representation is in the
Preferences dialog in the Settings menu.
Thermal Ellipsoids. This mode shows thermal ellipsoids in the style of ORTEP, the
classic plotting program by Carroll K. Johnson. Note that ellipsoid may also be drawn in
the 3D mode.
3D. Although a fully shaded drawing done in the Standard mode may have a highly 3dimensional appearance, this option, which uses special system software not available on
all machines, allows a number of extra options in terms of lighting and material properties
and correctly draws interpenetration of crystal edges, axes and unit cells with the
structure. Switching into this mode requires loading the system software, which may take
a few seconds. Thermal ellipsoids may be drawn in combination with polyhedra, which is
not possible in either the Thermal Ellipsoids or Standard modes.
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Anaglyph. This is a special type of stereopair display which must be viewed with
colored glasses. Rather than completely separate left- and right-eye images, as in the
stereopair option in the other display modes, there are superimposed images in two
different colors, red/green, red/blue or red/cyan. The representation is the same as in the
Skeletal mode, bond colors option.
Cavities. This shows the cavities or "open space" in a single unit cell, using the current
atomic radii. This mode uses the 3D system capabilities - if your system does not support
3D display (e.g. 68K Macintosh or Windows 3.1) the Cavities display mode is not
available.
The choices in this submenu are also in the Dialog Bar -Left which is controlled from the
Display menu.
3.2.4.1.1 Standard Display Mode
This is one of the modes which can be selected in the Display Mode submenu in the
Display menu, or in the Dialog Bar- Left.
This mode is actually very flexible, and supports representations ranging from very
schematic line drawings to fully three-dimensional. The settings in the Rims, Linewidths,
and Shading commands in the Input2 menu have an especially great influence on this
mode.
The main alternative to Standard mode is 3D Display mode, which gives a more realistic
appearance in full color, but is not generally suitable for schematic drawings.
3.2.4.1.2 Skeletal and 3DSkeletal Display Modes
There are actually two skeletal drawing modes, Skeletal and 3D Skeletal. The
appearance in the two modes is virtually identical. Even if you are not otherwise using
the 3D display mode, the 3DSkeletal mode may be preferable in that redrawing may be
faster, since it is not necessary to sort drawing objects back to front. The relative speed
of the two modes may depend on your graphics display hardware.
In either or both of the skeletal drawing modes, there are two alternative modes of
skeletal viewing, as selected in the Preferences dialog (Operation tab) in the Settings
menu.
In the Bond colors or "old" mode, all atoms are shown as small dots, except those in
polyhedra; all bonds are shown as lines using bond colors (either fill or edge colors as
selected in the Preferences dialog), and polyhedra are shown by lines joining the corners
(outlining the faces). The lines indicating polyhedron edges use the polyhedron fill
colors.
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In the Atom colors or "new" mode (new in ATOMS 5.1) the bonds are shown in the
colors of the two atoms (fill color), half-and-half. Polyhedron edges are not shown;
instead the central-ligand bonds are shown.
During rotation with the mouse cursor, the skeltal mode may optionally be used to
represent the structure while the button is down - this is selected in the Preferences
dialog. If you are in the 3D display mode, 3DSkeletal will be used during rotation.
This drawing mode can be selected in the Display Mode submenu of the Display menu,
the Dialog Bar - Left.
See also the Anaglyph drawing mode.
3.2.4.1.3 Thermal Ellipsoid Display Mode
In non-3D display, ATOMS shows thermal ellipsoids in the style of ORTEP, the classic
plotting program by Carroll K. Johnson. Display parameters, controlling the way the
atoms and bonds are drawn, are the same as in ORTEP. However, the ORTEP plotting
commands, including atom generation, are not used. Atom generation is done by the
usual Boundary methods of ATOMS, and bonds are set up in the usual way (Bonds
dialog in the Input1 menu). Bond radii used are the same as those specified in the
Bond Data dialog. The ORTEP parameters which actually affect the configuration of the
ellipsoids and bonds are set in the Ellipsoid Parameters dialog in the Input2 Menu .
Atoms and bonds are drawn generally from back to front, as in the Standard display
mode, the height of bonds being taken at the midpoint. From V5.1, ATOMS has an
additional algorithm which should eliminate most inaccuracies in overlap relations which
resulted from strict back-to-front drawing. The true relations will be always be shown in
the 3D display mode.
Note that thermal ellipsoids may also be shown in the 3D display mode. The option to
show them or not is in the Ellipsoid Parameters dialog, and also the 3D-General dialog
(Input2 menu)
Thermal ellipsoids in pen-plot or HGPL-file output are not supported at this time.
Switching between Standard, Skeletal, Thermal-ellipsoid, 3D and Anaglyph display
modes is done with (a) the Display Mode sub-menu in the Display menu; or (b) a box in
the Dialog Bar, which is turned on and off in the Display menu.
Temperature factor data may be entered and edited for individual atoms in the Atom Data
Dialog (Input1 menu), or temperature factors may be read in with the Import File
formats (File menu), including the original ORTEP format, or with atom parameters in
free-form style through the Input Atoms dialog (Input1 menu). ATOMS supports all of
the temperature factor types used in ORTEP, although most data published now are of
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type 0 or 8 for anisotropic temperature factors, or 6 for isotropic factors (and also type
10 for isotropic U, which is not a standard ORTEP type). ATOMS will save temperature
factor data in its data files only if there is at least one atom with non-zero B11 or U11
coefficient.
When converting to the Input=Generated mode (Generated to Input command in the
Transform menu), the temperature factors of all generated atoms are converted to
eigenvectors and eigenvalues in the Cartesian system and stored in that way instead of as
beta or U coefficients. Therefore, temperature factors cannot be modified once the
conversion has been made. (It would be possible to modify the values in the.STR file, but
it is not likely this would be worth the trouble). The Thermal Ellipsoid mode is not
supported for multiple structure fragments.
3.2.4.1.4 3D Display mode
This drawing mode can be selected in the Display Mode submenu of the Display menu,
or the Dialog Bar - Left.
Although a fully-shaded ATOMS drawing in the Standard display mode has an excellent
3-dimensional appearance, the term "3D drawing" is used to denote a method of drawing
which is different in several respects. ATOMS uses the OpenGL software package for
both Windows and Macintosh.
In this type of drawing, the surfaces of three dimensional objects such as spheres and
cylinders are converted to an assemblage of planar polygons. Then each polygon is
drawn essentially independently. The critical difference from non-3D modes is that a
depth buffer is used in 3D imaging. This is an array of integers, one for each pixel in the
display or output (or that portion which is currently being drawn). Each element,
representing a pixel, holds the relative x coordinate (in the ATOMS observer coordinate
system) of the foremost object or polygon. The color for this object is retained in the
color buffer, which is a similar array representing pixels; this array is actually the image
itself. Whenever a polygon is drawn, each pixel which it contains is compared against the
depth buffer; if the x coordinate of the pixel is greater, or closer to the observer than
what is in that element of the depth buffer, the color for this pixel in the new polygon
replaces the value in the color buffer. That is, the depth buffer keeps track of the front
surface of the drawing, and ensures that only this front surface (not any hidden surfaces)
are kept in the color buffer or image itself. It is also possible to have transparent or
translucent objects, through which hidden surfaces may show partially, by mixing the
color of the latest object with the color which is already in the buffer.
Actually, the "double buffer" method is normally used, the color buffer being kept in an
area of memory and then copied to the screen memory when the drawing is completed.
This is usually faster than drawing directly to the screen.
The non-3D display modes of ATOMS do not use a depth buffer: the atoms, bonds and
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polyhedra are sorted from back to front and drawn in that order (except for the Anaglyph
mode). When necessary, the intersections of objects are solved analytically and only the
required portions of each are drawn.
Using a depth buffer has the advantages that it is not necessary to solve analytically for
intersections, nor to sort the objects with respect to depth (unless some objects are
translucent). This may save considerable time, especially for complex drawings, since the
time for sorting tends to increase exponentially with the number of objects. Since
analytical solution of intersections is not necessary, it is possible to place essentially any
objects into the drawing. in any location. This overcomes the problem in ATOMS non3D display modes of sometimes-incorrect drawing of crystal edges or unit-cell edges
which intersect with atoms, bonds and polyhedra. The 3D method allows more complex
shading and lighting effects, such as specular highlights and multiple light sources. For a
completely 3-dimensional image, on a computer which has sufficient memory, the 3D
display mode is superior to the ATOMS Standard display mode.
However, there are disadvantages to the 3D method. The depth buffer may result in
excessive memory requirements even for the screen (but some 3D accelerator cards may
have special memory for the depth buffer). The 3D method is not very suitable for blackand-white drawings, which typically are simplified, showing mutual intersections of atoms
with bonds and polyhedra as lines or curves; such intersections simply are not drawn in
the 3D method. Both Windows and Macintosh implementations currently have some
severe limitations in terms of printing. It is necessary to draw each image into a bitmap
and then copy that bitmap to the printer. Because printers have much higher resolution
than the screen, this causes even higher memory requirements, and for reasonable sized
printed drawings it is usually necessary to do the printing in bands or segments.
The 3D Display mode itself is for drawing atoms, bonds and polyhedra as threedimensional objects. The same system software is also used for the 3DSkeletal mode and
the Cavities mode. During rotation using the mouse when in 3D Display mode, the
drawing mode may optionally be switched to 3DSkeletal while the mouse button is
down. This is controlled in the Preferences dialog in the Settings menu.
3.2.4.1.5 Anaglyph drawing mode
This drawing mode, selected in the Display Mode command in the Display menu or the
Dialog Bar - Left, is a type of stereopair display. Rather than using separated images, as
in the Stereopairs option in the other display modes, the two images are superimposed,
but each is in a different color - either red/green, red/blue or red/cyan. The only type of
display which is currently supported is the same as the Skeletal display mode, that is
atoms are shown as small dots and bonds and polyhedra as lines.
Stereoscopic glasses, with the left lens red and the right lens either blue or green, are
required to view the image. Such glasses may be purchased where comic books are sold,
among other places.
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The settings for the Anaglyph mode are in the Stereopairs dialog in the Input2 menu.
Generally red/blue with a black background works best for the screen, while red/green or
red/cyan with a white background works best for printed output. The anaglyph mode
seems to work better with a smaller rotation angle than the separate-image stereopair
mode - for example 1.5 instead of 3 degrees.
For anaglyphs to work properly, the operating system must be able to blend pixel colors
in the appropriate way. For example, in printed output, where red and green areas
overlap the result must be black, not the color of the line which was drawn last. This is
not possible in PostScript, so anaglyphs do not work properly in PostScript output. In
metafile or PICT (Picture) output, the program which receives the file may not be able to
interpret the command which sets the blending mode. Color blending does not seem to
work properly for labels.
----Windows only ---Anaglyphs for Windows in 8-bit (256-color) screen modes are currently not drawn
correctly, because the colors are not added correctly for areas of red/green or red/blue
overlap. If possible, switch Windows to a "true color" (16-, 24- or 32-bit) mode to get a
correct drawing.
---- Macintosh only ---The Macintosh adds colors correctly even in 8-bit screen modes.
------------------------3.2.4.1.6 Cavities Display Mode
Parameters for this display mode are set in the Cavity Parameters dialog, Input1 menu.
This display mode shows the surface enclosing the centerpoint locations of a given-sized
particle (sphere) within the structure. By setting the particle size to zero, you can show
the actual reciprocal of the crystal structure.
There are two steps to the location of this surface. First (grid calculation), the unit cell is
sampled at the given Grid spacing and Offset, to get the distance to the surface of the
nearest atom. This calculation need not be repeated unless the unit cell, atom coordinates
or atom radii, or the Grid spacing or Offset are changed. Second (surface evaluation),
at plot time the surface which outlines the given Particle radius (i.e. a three dimensional
contour surface) is drawn. Multiple unit cells are drawn by duplicating the surface
segments in the central unit cell, which increases drawing or rendering time, but not grid
calculation or surface location time.
The grid calculation uses the current atom radii (Atoms dialog, Input1 menu).
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Presumably these are full ionic, covalent or van der Waals radii. The radii can all be
changed by a factor with the Atoms-Global dialog (Input2 menu).
Since a single unit cell is sampled from 0 to 1, and offsets and multiple cells extend in the
positive axis directions, automatic centering should normally be selected in the
Centering/Displacement dialog (Input2 menu).
The calculations involved in this mode are essentially independent of those involved in the
other display modes. If you want to switch between Cavities mode and other modes, to
compare the the actual structure with cavities, it may be helpful to set the
Boundary Option and other conditions to match.
When showing a single unit cell with no offsets, the Boundary should be set to Unit Cell,
0-1 inclusive. It is usually helpful show the unit cell edges with the Axes/Unit Cell
option (Input2 menu). The unit-cell Displacements (button in the Axes/Unit Cell dialog)
should all be set to zero.
When displaying in Cavities mode with multiple unit cells and/or offset unit cells, showing
the actual structure with the same boundaries requires using the Enter Forms boundary
option. Symmetry for the faces should be None, and the bounding faces should be those
of the unit cell, at central distances which are suitable fractions (to take account of
Offsets) and/or multiples of the d-spacing. The d-spacing is printed out for each form
after it is entered. If the boundary is initiallyset up for Unit Cell (previous paragraph),
and then switched to Enter Forms, the appropriate faces will be entered and the central
distances/d-spacings given. Note that Offsets will require negative central distances. For
example, if the Cavities volume is offset by 0.25 on the a-axis, the bounding faces cutting
the a-axis should be (100) at central distance 1.25d and (-100) at -0.25d (where d is dspacing).
Note that atoms with small radii have little influence on the configuration of cavities, and
such atoms can usually be omitted. For example when doing silicates using ionic radii,
silicon atoms may be omitted. Even using covalent or van der Waals radii the silicon
atoms do not greatly influence the configuration of cavities. Of course if the Particle
radius is set to zero, the locations of omitted small atoms may show up as isolated
cavities, but this may be minimized by setting the Grid spacing to a value larger than the
small atoms. Thus omitting small atoms improves the speed of the calculations in two
ways; directly by reducing the number of atoms considered in the grid calculation step;
and indirectly by allowing larger grid spacing.
Cavities-mode drawings may be saved as VRML Files. Rotation of a small Cavitiesmode drawing may be faster in a VRML viewer than in ATOMS, primarily because the
viewer saves all the individual polygons comprising the surface in memory, and does not
have to calculate them for each view. However, for large drawings storage of all this
information may cause the viewer to use virtual memory, which can bring the entire
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process essentially to a halt.
There are two zeolite structures set up for Cavities mode in the /SAMPLES sub-folder,
LINDE_L.STR and ZSM5.STR. Open these files and switch to the Cavities display
mode.
Using Stereopairs (Input2 menu) is usually very helpful in Cavities mode.
3.2.4.2

Cursor Mode Sub-Menu

Cursor Mode Submenu [ Display Menu]
In Atom ID (identification) mode, clicking on the left (or only) mouse button will
identify atoms and give bond lengths and angles - see Atoms at Cursor . The cursor in this
mode is a cross. Clicking and dragging with the right mouse button (Windows) or
control+button (Macintosh) will switch temporarily (as long as the button is down) to the
the Rotate mode, below.
In Rotation mode, clicking and dragging rotates the structure. In most of the window,
rotation will be around the y and z Cartesian axes, in the plane of the screen. Clicking
and dragging near the left or upper edges will rotate about the z axis, perpendicular to the
screen. The cursor is a quadruple arrow when rotating on x and y, and a circular arrow
when rotating on z.

The Cursor Mode can be selected either in the Display menu or the Dialog Bar - Right.
3.2.4.3

Replot Command

Replot Command [ Display menu]
This command redraws the image in the graphics window which is currently active
without recalculation. The active window may be the main graphics window (containing
the structure image), the Powder or Precession diffraction patterns.
Changes in most items in the Input2 Menu can be put into effect with this command
(although these dialogs all have an automatic replot check box). It can also be used after
some changes in the items in the Input1 menu, such as colors and bond radii. For
changes which affect atom locations and atoms involved in bonds and polyhedra, or
changes in thermal ellipsoids, use the Calculate command in the File menu. Changing
atomic radii does not require recalculation as long as stick bonds are not changed to
interpenetration or vice-versa.
When the Auto button in the Dialog Bar - Left is checked, replot is automatic whenever
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you click one of the axis rotation buttons.
3.2.4.4

Color Command

Color Command [Display menu]
This switches between full-color and black-and-white screen display (all types of output
such as printing, metafiles, etc. have independent color switches). Screen displays with
more than 16 colors may show true gray-scale rather than the dithering which is used in
actual black-and-white output. You can set the default or start-up status of this switch in
the Preferences dialog in the Settings menu.
3.2.4.5

Atom Labels

Dialog Box: Atom Labels [ Display Menu]
You can show either labels or generated atom numbers. The labels will use the atomic
labels entered in the Revise Atom dialog, up to 6 characters. You can specify fewer
characters with the Max. letters item. The labels will be stripped of trailing blanks and
centered on the projection of the atomic center, unless the Offsets are non-zero.
If the Scale box is checked, in printed output or output to a file, the labels in that output
will be scaled to approximately the same relation to the drawing itself as on the screen.
This is a very approximate process, and trial-and-error adjustment may still be necessary
to get the desired label sizes in output. The option applies to all types of lettering on the
plot, not just atom labels.
If the Background is opaque, each letter will lie on a small block of the designated color;
this usually makes the labels easier to read. Other programs which read ATOMS output
files may not be able to reproduce these opaque blocks in Metafile or PICT files output.
Labels are not supported for Pen Plot output.
Sequence. The labels may be plotted immediately after each atom, or all at once after all
atoms have been plotted. The first usually looks better, but some labels will usually be
partly or completely obscured.
Use PostScript font. This allows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and slant (italic, oblique) of the font, but not the size, which is specified in
the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.
The label positions are correct for stereopairs, and labels for central atoms of polyhedra
will appear suspended in the interior of the polyhedra.
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With Atoms to omit, you can elect to omit labels for certain classes of atoms, such as
non-plotting atoms (those in incomplete polyhedra, or deleted by the user) which are
deleted by default.
Individual generated atoms can be omitted or deleted, by clicking on the atom and
unchecking the Labels checkbox in the Generated Atom Data dialog. This type of
deletion is like deleting atoms themselves (see Deleting Atoms) - when you save a file, a
list is made of the generated atoms for which labels are deleted. Labels which have been
deleted in this way can all be restored with the Restore All button in this dialog. Also,
you can delete all labels with the Delete All button, then restore selected atoms
individually with the Generated Atom Data dialog. Starting with V4.0, the lists of
deleted atoms and labels use a code containing the unit-cell, the symmetry operator etc.,
rather than an arbitrary sequence number, so that changing the boundary conditions will
not usually make the list invalid (although some deleted atoms or labels may no longer be
within the boundaries). However, changing the symmetry will make the list invalid.
Use the color options in this dialog, not the color options in the Font dialog to set the
color of the letters. Letters are always solid black in black-and-white display or output.
See Input Colors/Patterns/Pens for general aspects of color input.
Note that in 3D display mode the labels have an absolute position in space, including the
x (front-back) coordinate. They are arbitrarily plotted a short distance in front of each
atom if the after each sequence is selected. If the after all sequence is selected, they are
drawn in a single plane in front of all atoms.
3.2.4.6

Bond Labels

Dialog Box: Bond Labels [ Display Menu]
You can specify the number of figures to the right of the decimal with the Decimals item.
The labels will be stripped of trailing blanks and centered on the projection of the center
of the bond (midpoint between atom centers), unless the Offsets are non-zero.
If the Background is opaque, each letter will lie on a small block of the designated color;
this usually makes the labels easier to read. Some other programs may not be able to
reproduce these opaque blocks in Metafiles or PICT files output. Labels are not
supported for Pen Plot output.
Sequence. The labels may be plotted immediately after each atom, or all at once after all
atoms have been plotted. The first usually looks better, but some labels will usually be
partly or completely obscured. Some offset may be required.
Use PostScript font. This allows you to enter a character string for PostScript fonts
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supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and slant (italic, oblique) of the font, but not the size, which is specified in
the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.
If the Scale box is checked, the letters in the labels in printed or file output will be
rescaled to keep the same approximate proportions with respect to atoms, bonds, etc. as
in the screen view.
Use the color options in this dialog, not the color options in the Font dialog, to set the
color of the letters. Letters are always solid black in black-and-white display or output.
See Input Colors/Patterns/Pens for general aspects of color input.
Individual bond labels may be "deleted", or marked for non-plotting, by clicking on the
two atoms in succession and unchecking the Bond Label box in the
Generated Atom Data dialog. The Show All button in this dialog will restore all bond
labels to visibility, and the Delete All button will mark them all for non-plotting.
Note that in 3D display mode the labels have an absolute position in space, including the
x (front-back) coordinate. They are arbitrarily plotted 0.5 Angstroms in front of the
center of the bonds, but they may still actually intersect or interpenetrate with the bond in
some cases.
3.2.4.7

Angle Labels

Dialog Box: Angle Labels [ Display Menu]
Angles are labeled with their values in degrees. A circular arc is drawn between the two
central-ligand bonds defining the angle, and the label is drawn over the midpoint of this
arc. Note that this arc is 3-dimensional, and its projection may not be circular. The radial
position of arc and label are defined with the Fraction of short bond edit box. If this
value is 0.5, for example, the arc will be drawn half-way out from the central atom to the
atom at the end of the shorter bond.
Angles are located automatically, from the Specifications (below). Note that the
location is done in the calculation, not plotting, so changing the specifications will require
Recalculation (Dialog Bar - Left or File menu).
Drawings should be kept simple when this option is used, as only a limited number of
angle labels will be intelligible. Typically this option would be used in conjunction with
the Sphere boundary option, to illustrate the coordination of a single atom.
The Blank interval causes the bond to start and end short of the actual center line of the
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bonds. Using this interval may improve the appearance, especially if stick bonds, instead
of line bonds, are used.
You can specify the number of figures to the right of the decimal with the Decimals item.
The labels will be stripped of trailing blanks and centered on the projection of the
midpoint of the arc, unless the Offsets are non-zero.
If the Background is opaque, each letter will lie on a small block of the designated color;
this usually makes the labels easier to read. Some other programs may not be able to
reproduce these opaque blocks in Metafile or PICT file output.
If the Scale box is checked, the letters in the labels in printed or file output will be
rescaled to keep the same approximate proportions with respect to atoms, bonds, etc. as
in the screen view.
The Linewidth gives the width of the arc, which is always a line even in 3D display
mode. The line will have the same color as the letters; this color can be specified in this
dialog. [Macintosh only ] In the 3D display mode on the Macintosh it is not possible to
set linewidths - all lines are one pixel wide.
Use PostScript font. This allows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and slant (italic, oblique) of the font, but not the size, which is specified in
the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.
Use the color options in this dialog, not the color options in the Font dialog to set the
color of the letters. Letters are always solid black in black-and-white display or output.
See Input Colors/Patterns/Pens for general aspects of color input.
Specifications. These are given in terms of coordination of a single central atom.
Angles will be found around all atoms of the given Type. The Maximum Angle can be
used to exclude near-180-degree angles in octahedra, for example. The angles are
located at calculation, not plot time, so changing specifications will require Recalculation
(Dialog Bar - Left or File menu).
"Deleting " angle labels. All angles around the atoms of the specified type(s) will be
located. However, individual angles can be "deleted", or actually marked for nonplotting. This is done by clicking successively on the three atoms in the order outercentral-outer. In the Generated Atom Data dialog, there then appears an Angle
checkbox. Unchecking will cause non-plotting of the angle. A list of the non-plotting
angles is saved in the data (.str) file. The Show All button allows restoration of all nonplotting angles, and the Delete All button marks all angles for non-plotting. Individual
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non-plotting angles can be restored by clicking on the atoms and checking the Angle box
in the Generated Atom Data dialog.
Angle labels are not supported for Pen Plot output.
Note that in 3D display mode the labels have an absolute position in space, including the
x (front-back) coordinate. They are arbitrarily plotted 0.5 Angstroms in front of the arc,
but they may still actually intersect or interpenetrate with the arc in some cases.
3.2.4.8

Scale Grid

Dialog Box: Scale Grid [ Display Menu]
This option allows you to locate and size the structure, so that it can be rescaled or
displaced. It will draw a square grid at the given absolute intervals. The center of
coordinates is shown by a star at the center of the screen, and the current location of the
center of the structure by another star. These two center points differ only if you have
entered displacements or turned on automatic centering with the
Centering/Displacements dialog in the Input2 menu. The grid is removed only by
replotting with the Grid plotting on box unchecked.
See Input Colors/Patterns/Pens for general aspects of input
3.2.4.9

Mark Atoms

Dialog Box: Mark Atoms [ Display Menu]
This will draw a box of the given size around the center of of each of the selected type of
atom. This is especially useful in locating atoms which you have previously marked as
non-plotting.
See Input Colors/Patterns/Pens for general aspects of input.
3.2.4.10

Clinographic Viewing

Clinographic Viewing Command [ Display menu]
This turns clinographic viewing on and off, with automatic replot. See also
Clinographic Viewing in the Rotation menu, which does the same thing without
automatic replot. Set the inital state of clinographic viewing in the Initial Orientation
dialog in the Input2 menu.
See also Coordinate Systems.
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General Planes

Dialog Box: General Planes [ Display Menu]
3D Display mode only.
This allows insertion of general planes.
The planes are defined in terms of corners (points) in fractional coordinates on the
structure (crystal) axis system. The points must define a convex planar polygon in
correct order. The planes are two-sided, so the sequence 1-2-3-4 is equivalent to 4-3-21.
Complete parallelogram. If this box is checked and there are only three points, a fourth
point will be added such that side 3-4 will be parallel to 2-1 and 4-1 will be parallel to 32. If the box is not checked, three points will define a triangle.
3.2.4.12

General Lines or Cylinders

Dialog Box: General Lines or Cylinders [ Display Menu]
3D Display mode only.
This allows not only general lines or cylinders, but customized "bonds" to be drawn.
The lines or cylinders are defined in terms of two points in fractional coordinates on the
structure (crystal) axis system.
If the Radius is 0.0, lines will be drawn (if allowed in the particular type of display or
output) - otherwise cylinders will be drawn.
If you have clicked with the mouse on two atoms (see Identifying (Picking) Atoms), you
have the option, in the Generated Atom Data dialog, of defining a "bond" between the
current atom and the last one. You will be referred to this dialog, and the "bond" will be
kept in the list of lines/cylinders, not in the Bonds dialog in the Input1 menu.
3.2.4.13

Dialog Bar - Left

Dialog Bar - Left
This is actually a special type of Control Bar, which resides on the left side of the Main
window. It can be turned on or off with the Dialog Bar - Left command in the Display
menu.
The upper part controls rotation of the structure in simple ways (for more ways to rotate
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or align the structure, see the commands in the Rotation menu). The current orientation
is shown at the top. The a, b and c axis labels are attached to the positive ends of the
axes, and the part of the axes extending forward (positive x) are drawn with heavier lines.
The rotation buttons below this are for rotation on x, y and z, respectively; positive angle
(clockwise looking outward on the axis) is on the left, and negative rotation on the right.
The angle of rotation is in the box below the buttons. The initial value of this angle is set
in the Preferences dialog in the Settings menu.
If the Auto box is checked, the drawing is replotted immediately after each click on a
rotation button. If it is not checked, the rotations are accumulated into a matrix, and the
drawing is not replotted until you click on the Replot button lower in the dialog (or select
Replot from the Display menu).
The buttons beneath Auto duplicate some common commands, all from the File menu
except Replot, which is also found in the Display menu. You can use Open to start up
ATOMS by reading in a file.
Replot - Replots the image (does not recalculate).
Calculate - Reproduce atoms within specified boundaries and locate bonds and
polyhedra.
Open - Open an old ATOMS data file.
Import - Open a crystallographic or molecular data file from other sources.
Import - Open a crystallographic or molecular data file from other sources.
Save - Save an ATOMS data file.
Save as - Save an ATOMS data file with a new name
Print - Print out the graphics image.
The Combo box at the bottom of the dialog controls the Display mode - this duplicates a
submenu in the Display menu. The options are Standard, Skeletal/3DSkeletal, Ellipsoid,
3D,Anaglyph, and Cavities.
3.2.4.13.1 Import File
Dialog Box: Import File [ Dialog Bar - Left ]
This offers a selection of file types to import, including CCDC FDAT, SHELX-93, CIF,
DBWS/LHPM Rietveld, ICSD, ORTEP, XTLVIEW, VIBRAT, PDB, RIETAN, GSAS,
AM MINERAL, FULLPROF and Free-Form.
The boundary option in most cases can either be Default Unit Cell, suboption as selected
with the Default radio button, or Locate Molecules in Crystal.
Multiple occupancies are not permitted in ATOMS, and when more than one atom is
found to be in the same position (same fractional x, y and z coordinates) the second and
subsequent occurences will be deleted.
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There is a limit of 500 input atoms in most cases.
3.2.4.14

Dialog Bar - Right

Dialog Bar - Right
This is actually a special type of Control Bar, which resides on the right side of the Main
window. It can be turned on or off with the Dialog Bar - Right command in the
Display menu.
Cursor Mode. In Atom ID (identification) mode, clicking on the left (or only) mouse
button will identify atoms and give bond lengths and angles - see Atoms at Cursor .
The cursor in this mode is a cross. Clicking and dragging with the right mouse button
(Windows) or control+button Macintosh) will switch temporarily (as long as the button is
down) to the the Rotate mode, below.
In Rotate mode, clicking and dragging rotates the structure. In most of the window,
rotation will be around the y and z Cartesian axes, in the plane of the screen. Clicking
and dragging near the left or upper edges will rotate about the z axis, perpendicular to the
screen. The cursor is a quadruple arrow when rotating on x and y, and a circular arrow
when rotating on z.
The Clino (clinographic) View checkbox will switch viewing with the Clinographic
rotations.
The Set Center button defines a new center point - use this to "focus" or "zero in" on a
specific area or point in the plot. After clicking on this button, an dialog informs you that
the next mouse click in the graphics window will define a new center point. After
clicking on a point, the drawing will then be displaced so that that point will be at the
center of the viewing area. It may be more useful to think of the result as the viewing
area being centered on the point selected. Displacements set in this way may be changed
in the Centering/Displacement dialog in the Input2 Menu .
With the Rescale buttons, you can "zoom" in or out. The actual factor applied is 1/(1+x)
for down scaling, and (1+x) for up scaling, where x is the amount in the edit box
converted from percent to a fraction. In the Maximize size for each view and Universal
maximum modes this changes the Rescale factor, which may be reset manually in the
Scaling dialog in the Input2 menu. When in the Fixed scaling mode, the actual scale
factors for screen, print and pen plot are changed. This behavior is a change from preV5.0 ATOMS, in which rescaling always changed to the Fixed mode.
Orientation buttons. These buttons will actually remove accumulated rotations and
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return to either the original orientation or the initial orientation. They perform the same
functions as the Remove Rotations option in the Rotation menu.
The original orientation means the orientation before any rotations, including the
alignment of a slice, and the rotations of the Initial Orientation dialog in the Input2
menu, have been made. This gives the standard orientation of the crystal (the first one in
the case of multiple crystals) with respect to the reference Cartesian coordinate system.
The initial orientation is that attained after the rotations just listed have been made, if
any of them were actually used. See also Coordinate Systems.
Delete Tool. This allows "deleting" (see Deleting Atoms and Atom Labels) groups of
atoms by creating a polygon with the mouse. All atoms within the projection of the
polygon can be marked for non-plotting.
The Show All button allows immediate restoration of all atoms marked as non-plotting.
See the Atom/Bond Plot States dialog (Input2 menu) for more options regarding nonplotting atoms.
The Inter. bonds (inter-molecule bonds) combo box (only displayed if there are bonds
between molecules or fragments) gives several options for display of inter-molecule or
interfragment bonds. If Highlighted is selected, such bonds are shown in normal colors
while all other atoms, bonds, etc. are dimmed. Other possible highlighting of molecules or
fragments is ignored.
3.2.4.15

Dialog Bar - Fragments

Dialog Bar - Fragments
This is actually a special type of Control Bar, which resides on the right side of the main
Graphics window. It can be turned on or off with the Dialog Bar - Fragments command
in the Display menu.
Frag (Fragment) This selects the fragment to be operated on.
Rotate. Each of the six buttons will rotate the selected fragment about one of the
Cartesian observer axes (see Coordinate Systems) by the angle in degrees entered in the
edit box below. The arrows in the lower four buttons indicate motion of the front of the
structure.
Translate. Pressing the Translate button will move the selected structure by the
distance in Angstroms entered in the edit box, along one of the Cartesian observer axes
(Cart x, y or z) or one of the structure (crystal) axes (Struct a, b or c) of the main
structure as selected by the radio buttons.
Use a negative distance to move backward along one of the axes.
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The translations in this dialog affect the actual x, y and z coordinates of the atoms and are
thus quite different from the plotting displacements in the Centering and Displacements
dialog in the Input2 Menu.
Translations can be removed in the Translate Structure Fragment dialog under
Multiple Structures in the Transform menu. This dialog also allow more complex
translations.
Rotations made in this dialog can be removed with the Rotate Structure Fragment
dialog, Transform menu.
3.2.4.16

Powder Diffraction

Dialog Box: Powder Diffraction [Display Menu ]
To calculate diffraction, the type numbers for atoms (Atom Data dialog) must be valid
atomic numbers, or those numbers modulo 100, or must anyway correlate with the table
of scattering factors in the SCATFAC.DAT file if you modify that file.
If you select a List, the list will appear in a Text window (see Types of Windows). There
will be a line in the listing for each crystal form, or symmetry-unique set of reflections
(with center of inversion assumed). If there is more than one wavelength, the 2-theta and
relative intensity will be listed for each in that line.
If you select a Graph, you may show either Bars or a Curve - the curve will use
Gaussian lines with the selected full width at half maximum (FWHM). For a curve, the
location of individual reflections will be shown as a short bar underneath the curve.
The Line width pertains to the width of all lines or "pen strokes" in the graph, not the
width of each spectral peak (FWHM).
If the Vertical scale factor or magnification is 1.0, the strongest peak will just fill the
plot area. If you want to see more detail in the weaker reflections, this factor can be
increased and the stronger reflections will be truncated.
If the atom records include temperature factors, they will be used. If an atom has no
temperature factor, the B isotropic value in the Default temperature factor box will be
used. No absorption or extinction corrections are applied.
There are four options for wavelength; averaged K(alpha); separate K(alpha)1 and
K(alpha)2; averaged K(alpha) and (separate) K(beta); and a single Specified
wavelength. For the first three options, the X-ray tube target element must be selected
in the Radiation combo box. When two wavelengths are calculated, the bars indicating
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the second (K(alpha)2 or K(beta)) are shown in red on the screen and in color output,
and as a dotted line in black-and-white output.
In the case of K(alpha) and K(beta) the relative intensity of K(beta) must be specified
(Beta inten.). For unfiltered radiation this is in the neighborhood of 0.2. Of course it
will be smaller for filtered radiation.
This option gives only a semi-quantitative calculation of powder intensity, intended for
purposes of identification. For somewhat more elaborate options, including the ability to
show multiple species, try the program Powder Cell. For highly quantitative
reproduction of powder patterns, there are now many Rietveld programs available (see
Import files).
The results of the Graph option are shown in a graphics windows (see
Types of Windows), and when this window is active, the File menu allows graphics
Printing, Raster Files and Metafiles or PICT files.
For this option to work properly the space-group symbol entered either in the
Space Group from Table or Custom Symmetry option must be valid for a standard
setting. If it is not, it should be possible to transform to a valid setting using the program
CRYSCON (Shape Software).
NOTE: Many of the sample files provided with ATOMS, especially the Basic Inorganic
structures, are idealized structure types. They may have a unit cell scaled to a bond
length of 1.0, or use arbitrary numbers for types instead of atomic numbers as required
for diffraction. Therefore they will not always give correct diffraction results.
3.2.4.17

Precession Pattern

Dialog Box: Precession Pattern

[ Display Menu ]

To calculate diffraction, the type numbers for atoms (Atom Data dialog), or those
numbers modulo 100, must be valid atomic numbers, or must anyway correlate with the
table of scattering factors in the SCATFAC.DAT file if you modify that file.
The Precession angle (mu) and Crystal-Film distance should match those of the real
film to which comparison is to be made. The Precession angle determines the extent of
the pattern in reciprocal space. If the Fixed Scale option (rather than Fit in Window) is
selected, the pattern will be in true scale. This can be altered with the Factor, which is
1.0 by default.
The part of the reciprocal lattice shown is determined by the Horizontal axis, the Other
axis and the Level. For example, for a 0kl pattern with b* horizontal, the Horizontal
axis is b*, the Other axis is c*, and the Level is 0.
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Reflections are shown as squares whose area is proportional to the calculated relative
intensity. The intensities are normalized based on the number of electrons in the unit cell
(intensity of reflection 000) and the smallest reciprocal lattice spacing in this net. The
Intensity factor scales the edge length, not area, of the squares (thus it really applies to
the structure factor).
To reproduce actual X-ray precession photographs, the Do Lorentz-polarization box
should be checked. Omitting the Lp corrections shows the structure factors (squared),
and it also allows display of the inner region in the upper levels, which is not recorded in
an actual X-ray pattern. The Lp factor becomes very large near the inner and outer edges
of the recorded pattern - if the value of this correction is greater than 10.0, an open
symbol is used rather than a filled one. Such intensities are not reliable.
If an atom has no temperature factor, the B(iso) value in the Default temperature factor
edit box will be used. Extinction and absorption are not considered.
Scattering factors used by default are those for neutral atoms from Volume 4 of the
International Tables (1974 edition). Atom type numbers must be atomic numbers, or
must correlate with the order of the entries in the SCATFAC.DAT file. This file may be
edited to supply different scattering factors.
If the Show grid box is checked, the reciprocal lattice will be shown as a grid in red on
the screen and color output, or as dotted lines in black-and-white output.
The results of this option are shown in a graphics windows (see Types of Windows), and
when this window is active, the file menu allows graphics Printing, Raster Files and
Metafiles or PICT files.
For this option to work properly the space-group symbol entered either in the
Space Group from Table or Custom Symmetry option must be valid for a standard
setting. If it is not, it should be possible to transform to a valid setting using the program
CRYSCON (Shape Software).
NOTE: Many of the sample files provided with ATOMS, especially the Basic Inorganic
structures, are idealized structure types. They may have a unit cell scaled to a bond
length of 1.0, or use arbitrary numbers for types instead of atomic numbers as required
for diffraction. Therefore they will not always give correct diffraction results.
3.2.5

Rotation Menu (Graphics Window)

Cartesian Axes - Rotate on the viewer or reference axes.
Structure Vector - Rotate on a rational structure vector [uvw].
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Clinographic Viewing - This turns clinographic viewing on and off, with optional replot
Align Face or Vector - Align the structure with a face in the screen or a vector
perpendicular to it.
Stereopair Rotations - Used to draw separate left- and right-eye stereopair views when
Shading is on.
Remove Rotations - Remove all rotations made since the calculation or the
Initial Orientation.
Current Orientation - Gives the current orientation of the structure with respect to the
observer coordinate system.
Continuous Rotation - Sets up continuous timed rotation about any of the observer
axes.
Rotation Movie - Write a video or movie file in the.AVI (Windows) or.MOV
(Macintosh) format.
3.2.5.1

Rotate on Cartesian Axes

Dialog Box: Rotate on Cartesian Axes [ Rotation menu]
This rotates the structure on one of two sets of Cartesian axes. If clinographic viewing is
off, the structure is always rotated about one of the axes belonging to the observer
system: x coming straight out towards the observer, y in the plane of the screen or paper
pointing to the right and z upwards.
Each time you click the Rotate button, a rotation is added to a master rotation matrix;
the number of such rotations is listed at the bottom of the dialog box. When you have
finished rotating, click the Done button and the master rotation matrix is applied to the
structure. If you click Cancel, no rotations are applied.
3.2.5.2

Rotate on Structure Vector

Dialog Box: Rotate on Structure Vector [ Rotation Menu ]
This will rotate about a rational structure direction [uvw], regardless of the current
display mode or orientation of the structure. If you are drawing a molecule and have used
Cartesian reference axes, the rotation direction is simply a vector with the coefficients u,
v and w in the original molecule axis directions a, b and c. The indices or coefficients
refer to a coordinate system fixed with respect to the structure (always rotating with it).
The indices must be integers, but this is not a bar in practice to rotation about irrational
vectors, since the indices may take very large values.
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Each time you click the Rotate button, a rotation is added to a master rotation matrix;
the number of such rotations is listed at the bottom of the dialog box. When you have
finished rotating, click the Done button and the master rotation matrix is applied to the
structure. If you click Cancel, no rotations are applied.
3.2.5.3

Clinographic Viewing

Dialog Box: Clinographic Viewing [ Rotation Menu]
This will switch on and off the rotations of -18.4 degrees on z and 9.5 degrees on y,
applied in clinographic display mode. This in effect changes the viewpoint of the observer
between the clinographic position, down the vector [621] referred to the observer
Cartesian axial system, and a straight-on position, down the x axis. This command is
included in the menu for convenience; the same operation is performed by the
Clinographic Viewing command in the Display menu, although choosing that command
always causes a replot.
See also Coordinate Systems.
3.2.5.4

Stereopair Rotation

Dialog Box: Stereopair Rotation [ Rotation Menu ]
If you want to show a steropair which can fit onto one page, it is usually easiest to draw
it automatically by turning on the stereopair mode with the Stereopairs dialog in the
Input2 menu. However, you may want to set up and draw each half of the pair
manually, if for example each view is to take up an entire page of output. This option
rotates the structure and the illumination vector for shading by the requested angle about
the z axis. If you are not using shading, ordinary rotation about z (viewer) will suffice.
The left-eye view should be rotated clockwise (positive angle): an angle of about +3
degrees is usually satisfactory, although this may depend on the perspective distance, the
type of viewing device, etc. After making a hard copy of this orientation, the rotation
should be negated with the Remove button. Then make a right-eye view by rotating the
negative of the left-eye value; after making the hard-copy, remove the rotation again.
3.2.5.5

Align Face or Vector

Dialog Box: Align Face or Vector [ Rotation Menu]
This will rotate a specified face (hkl) to lie flat in the screen or paper (face-normal parallel
to x observer), or a vector (uvw) to be perpendicular to the screen or paper. To align a
face, it is also necessary to specify a vector lying in the face which will be vertical in the
screen or paper (z direction). Conversely, to align a vector, it is necessary to specify a
face, containing the vector, whose normal will be vertical. If a vector [uvw] lies in a face
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(hkl), the indices satisfy the condition hu + kv + lw = 0. If clinographic viewing is in
effect, it is turned off when the face is aligned, to simplify any subsequent rotations.
You can elect to use the default alignment vector or face, instead of specifying it. The
default vector will be the intersection of the face (hkl) with the face (100), whose indices
are given by the cross product (hkl)x(100). If the face (hkl) is (100), the default alignment
vector will be the vector [001]. For aligning a vector the algebra is just the same, with
interchange of face and vector.
When dealing with a molecule or polymer, using a Cartesian axial system, this rotation
option can be used to obtain a view down a given vector direction. Use the vector
alignment option, although when the structure axes are Cartesian the two cases of
aligning a face or a vector are identical. After specifying the initial vector or view
direction, if you do not accept the default you must then give another vector, in place of
the "face indices", which is perpendicular to the first vector, and which is to be vertical (z
direction). If the two vectors are at right angles, their coefficients or "indices" multiplied
together (the vector dot product) should equal zero as in the above condition for a vector
lying in a face.
3.2.5.6

Remove Rotations

Dialog Box: Remove Rotations [ Rotation Menu ]
This will counteract all rotations made by the dialogs in the Rotation menu as well as any
made on-screen with dialogs in the Display menu, and take you back to one of two
settings. The original orientation means the orientation before any rotations, including
the alignment of a slice, and the rotations of the Initial Orientation dialog in the Input2
menu, have been made. The initial orientation is that attained after the rotations just
listed have been made, if any of them were actually used. See also Coordinate Systems.
Summary of orientation operations. ATOMS first sets the c structure axis parallel to the
z viewer axis, and the a * structure axis (perpendicular to b and c ) parallel to x. This is
the original orientation. Next, if the Slice boundary option is in effect, the slice is
oriented with the slice plane parallel to yz, and the orientation vector parallel to z. Then
the initial Cartesian rotations, if any, are applied. Finally, the clinographic rotations, if
selected, are applied. This is the initial orientation.

3.2.5.7

Current Orientation

Dialog Box: Current Orientation

[ Rotation Menu]

This gives the current orientation of the structure in terms of the structure vectors lying in
the x (reverse view direction) and z (vertical) axes of the Cartesian observer system (see
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Coordinate Systems).
3.2.5.8

Continuous Rotation

Dialog Box: Continuous Rotation

[ Rotation Menu ]

This option will rotate the image about any of the three Cartesian observer axes (see
Coordinate Systems), by the given increment in degrees.
The Time delay is the delay after the image is finished before redrawing is started again.
The time required to draw the image is not included in this value.
When this option is in effect, the image is drawn into an off-screen bitmap and then
copied onto the screen (see the Preferences dialog in the Settings menu), rather than
drawn directly onto the screen. When continuous rotation is halted, the previous mode of
drawing on- or off-screen is restored. Sound is temporarily turned off.
Pressing any key or mouse button will halt the rotation.
3.2.5.9

Rotation Movie

Dialog Box - Rotation Movie [ Rotation Menu]
This will write a movie or video file in.AVI (Windows) or.MOV (Macintosh) format.
This files consist of a series of bitmap (raster) images.
The structure will be rotated from its current attitude about the selected Axis, with the
selected Rotation increment, until the sum of rotations exceeds the Maximum
rotation.
A normal motion picture uses 32 Frames per second, but typical computer videos use
less than this. In fact, some computers may not be able to handle 32 frames/sec for large
images.
Note that movie files may be very large (many megabytes) even if compressed. For
Macintosh, the compression mode is automatically selected by the System software, and
is supposedly optimal for the resolution (Pixel size) selected. In Windows, you are
presented with a dialog showing the available codecs (COmpression-DECompression
algorithms), and you must select one. Finding the optimal codec may be a matter of trial
and error - performance usually varies with the Pixel size and the actual number of colors
used. Some codecs compress very effectively, but cause degradation of the image ATOMS images should usually be compressed with a lossless compression method. One
codec which has been found to be good for typical ATOMS images is the Cinepak codec
by Radius.
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See Frames for details of the frame and frame units.
3.2.6

Transform Menu (Graphics Window)

Generated to Input - Converts to a special mode, necessary for dealing with multiple
structure fragments, and for modifying individual generated atoms.
Locate Groups - Isolate molecules, polymers or other bonded groups.
Multiple Structures - Generate, read in, or manipulate separate structure fragments.
Remove Crystal Symmetry - Converts to a crystal with no symmetry (space group P1).
Unit-cell contents will be converted to input atoms, retaining cell parameters (as triclinic).
Temperature factors will be converted to isotropic B.
Expand Layers - Expands a crystal structure on certain planes, increasing the length of
the selected axis, creating space near the expansion planes, but leaving the actual
structure within layers unchanged.
3.2.6.1

Generated to Input

Dialog Box: Generated to Input [ Transform menu]
This converts the generated atoms (i.e., all those generated by the symmetry operations
and translations within the given boundaries) to input atoms, removes all symmetry and
boundary conditions, and changes to a special operating mode, called "Input=generated".
This is like converting the current generated volume to a molecule with no symmetry.
This option is required before using the Multiple Structures options in the Transform
menu. It is also a good idea to use this option if you want to delete more than a few
generated atoms (see Deleting Atoms).
Temperature factor data are carried over into the special mode as Cartesian eigenvalues
and vectors rather than U or beta coefficients, but they can no longer be modified.
However, if there is more than one structure fragment temperature factors are not
allowed (they will be deleted).
Orientation radio buttons. You have the option of returning to the original or standard
orientation before converting, or taking the current orientation as the new "original"
orientation. This orientation will be saved, which was not the case in pre-V4.0 ATOMS.
Some of the following checkboxes may not be shown, depending on circumstances.
Convert molecules to fragments. This will convert molecules or groups located in
several different ways to individual fragments. If one of the Molecules in Crystal
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boundary options has been chosen, all atoms will be in molecules, and each molecule will
become a fragment. "Molecules" may be individual atoms, as in CaCO3 structures
(assuming Ca-O bonds are not defined or are marked as intermolecular). If another
boundary option is used, and molecules or groups are subsequently located with the Find
button in the Generated Atom Data dialog (which appears when you click on an atom),
or with the Locate Groups dialog in the Transform menu, there may be atoms which are
not part of molecules or groups. All these "leftover" atoms will be put into a single
fragment, in addition to those already located.
Remove non-plotting atoms. Non-plotting atoms are those which have been explicitly
marked as non-plotting, either individually or in groups. Atoms in incomplete polyhedra,
which may or may not be shown in the drawing (Polyhedra dialog, Input1 menu) are in a
separate option below.
Keep thermal ellipsoids. Thermal ellipsoids are not allowed in Multiple Structures, so
there is no point in keeping them if additional fragments are to be added.
Omit atoms in incomplete polyhedra. This includes all atoms in polyhedra which have
less than the specified number of ligands, i.e. are incomplete because of boundary
conditions.
Keep vectors. Atomic vectors are not likely to be useful in Multiple Structures.
3.2.6.2

Locate Groups

Dialog Box: Locate Groups [Transform Menu]
This allows you to isolate individual molecules, polymers or other structural groups in a
crystal. You must specify a single "seed" atom, then all other atoms interconnected to
this one are located. The interconnection is by bonds specified in the Bonds input, or
polyhedra specified in the Polyhedra input in the Input1 menu. There must be no bonds
(except those marked inter-molecular) from atoms in a group to atoms outside the group,
nor can polyhedra connect atoms within and without the group.
If the structure consists of discrete molecules, not polymers, it is usually easier to use one
of the Molecules in Crystal Boundary options. These will automatically identify any and
all molecules. See Dealing with Molecules, Groups and Fragments for more information
on strategy for dealing with groups. Note also that ATOMS V5.1 differs from previous
versions in the way groups are identified - several groups can be identified and this
identification persists regardless of whether the atoms are marked for non-plotting or not;
and groups may be directly converted to fragments with the Generated to Input option
(Transform menu).
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Creation of a structure file for displaying such groups involves three steps. Note that the
Find button in the Generated Atom Data dialog (which appears when you click on an
atom) is an alternative to step 2 (that is, to this dialog).
1) Setting the original boundary option. Before exercising the Locate Groups option,
the molecules or other groups must be within the boundaries of a structure calculated in
the usual way. For example, you can use the Default Unit Cell option, suboption -1 to 1;
this gives one full unit cell on either side of the origin (for a total of 8 unit cells).
2) Locating the group(s). To do the actual isolation of the group, call on this dialog Locate Groups or use the Find button in the Generated Atom Data dialog. You must
specify an initial or "seed" atom; this can either be a specific generated atom, or an input
atom. If you use a generated atom, it will normally be necessary beforehand to use the
on-screen atom-location feature (see Generated Atom Data ) or a print-out from the
List Generated Atoms command in the File menu to find the number of a suitable atom.
Actually, when using a generated atom the Find button in the Generated Atom Data
dialog is usually more convenient than using this dialog (Locate Groups). However, this
dialog is the only way to use an input atom (see the list in the Input Atoms dialog in the
Input1 menu, or the List Input dialog in the File menu). In this case, ATOMS will test
all the generated atoms in the equivalent set derived from that input atom, and find the
one which is closest to the origin.
When you click on OK, ATOMS makes a temporary list of all atoms in each group.
3) Saving the Structure. After you are finished with step 2, you are presented with the
Groups Located dialog, which allows a) restoration of the non-plotting atoms, which
will not undo the process of group location (as in pre-V5.1 ATOMS); b) locating an
additional group; or c) converting the generated atoms to input atoms. If you leave the
dialog without doing any of these things, the molecule(s) can be highlighted or hidden in
various ways.
You may wish to turn on centering with the Centering/Displacement dialog in the Input2
menu if the group(s) are not near the origin.
The "deletion" of atoms (see Deleting Atoms) or marking for non-plotting, does not
directly affect the location of groups. That is, if you mark an atom for non-plotting,
neither the atom nor bonds to it are shown in the drawing, but the atom and its bonds still
exist for the purpose of locating groups. In order to remove atoms and bonds
permanently before locating groups, you must convert Generated to Input (Transform
menu), selecting the option to remove non-plotting atoms. Or you can convert
Generated to Input and then delete the atoms. Then recalculate to reestablish bonds and
polyhedra, and proceed with location of groups.
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Groups Located

Dialog Box: Groups Located [Transform Menu]
This dialog appears after you have located one or more groups with the Locate Groups
dialog.
If you click on the Done button, the last and other groups can be displayed in various
ways according to the radio buttons;
---Highlight the last group - really means dim all atoms not in this group.
---Hide all except the last group - atoms not in the last group selected will be marked
as non-plotting.
---Hide all except groups - atoms not in any group will be marked as non-plotting.
Highlighting and hiding can be reversed with buttons in the Generated Atoms Data dialog
which appears when you click on an atom.
The Show All button allows restoration of any non-plotting atoms. In pre-V5.1 ATOMS
this would undo the process of group location, but now the atoms in groups are
individually marked with the group number.
The Add button allows locating an additional group (back to the Locate Groups dialog).
The Convert button converts generated to input atoms in exactly the same as in the
Generated to Input command in the Transform menu. Note that this option now can
convert molecules directly to independent structure fragments.
See the Locate Groups dialog for step-by-step instructions on locating groups, and
Dealing with Molecules, Groups and Fragments for general aspects of handling groups.
3.2.6.4

Multiple Structures

Dialog Box: Multiple Structures [ Transform Menu]
Multiple structures fragments can be used to model twinning, epitaxy and certain types of
crystalline defects, as well as interactions between molecules. Each structure can be
rotated and translated independently; however, there is only one list of bonds and of
polyhedra, and both are located throughout the structure as a whole.
Thermal ellipsoids for multiple structures are not supported; temperature factor
information is lost if you introduce multiple fragments.
Most operations on individual structures are carried out through this dialog in the File
menu. However, individual structure fragments can be rotated and translated in some
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simple ways using the Dialog Bar - Fragments (Display menu).
Before more than one structure can be dealt with, each of the structures concerned must
be transformed to the "Input=generated" mode with the Generated to Input command in
the Transform menu.
The Multiple Structures dialog gives a list of the current structure fragments. The first
fragment is always the main structure. There are two ways to add additional fragments;
the Duplicate button and the Read File button.
If you choose Duplicate, the new fragment will have the same orientation and center
point as the current fragment. You have the option of inverting the current fragment, that
is, negating all the atomic coordinates. All the types of the atoms remain the same, and
the lists of bonds and polyhedra are not duplicated. The title is copied to the new
fragment (the title for fragment number 1 is that of the structure as a whole).
The Read File button calls up the Read Structure Fragment from File dialog. The
Revise button calls up the Revise Structure Fragment dialog.
After duplicating a structure or reading in an additional structure fragment, you must
choose Calculate from the File menu in order to locate bonds and polyhedra. The
Calculation Output dialog in the Input2 menu allows you to get a listing of only those
bonds and bond angles which involve more than one fragment, i.e. inter-fragment bonds.
To get such a list you must have some sort of calculation output turned on, and the bond
distances and/or angles print-outs turned on also.
You can highlight, dim or omit interfragment bonds with a Combo box in either the
Dialog Bar - Right or the Atom/Bond Plot States dialog (Input2 menu). Individual
fragments can be rotated or moved with DialogBar - Fragments.
Note that clicking with the mouse on an atom in the drawing on-screen brings up the
Generated Atom Data dialog, which lists the bond distance to the last atom, and the bond
angle involving the last three atoms.
3.2.6.5

Read Structure Fragment from File

Dialog Box: Read Structure Fragment from File [Multiple Structures dialog]
The file specified must be an ATOMS data file (.STR), and this structure must already
have been transformed to the "Input=generated" mode with the Generated to Input
command in the Transform menu. Structure files from old versions of ATOMS may not
be readable through this option - in this case the old file may be read with the Open
command (File menu) and saved in the current format.
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You have the option of inversion, that is negating all the atomic coordinates. All other
orientation operations can be carried out with rotations after the file is read in. You have
the option of adding the bond and polyhedra lists to the old ones.
ATOMS can use either standard bonds, defined by specifying atom types in the
Bond Data dialog in the Input1 menu, or it can use a connectivity table, which is
obtained only from a CCDC FDAT file or PDB file - it cannot use both. Thus if the main
(first) structure has normal bonds, and the structure read in has a connectivity table, the
connectivity table will be ignored; and if the main structure has a connectivity table,
normal bonds in the structure fragment being read in will be ignored. In general, normal
bonds are more flexible, and can be derived automatically (see
Generate Bonds from Atomic Radii).
3.2.6.6

Revise Structure Fragment

Dialog Box: Revise Structure Fragment [Multiple Structures dialog]
This gives the start and end numbers of the atoms for the current fragment or individual
structure - the atoms are all kept in the same master list. The coordinates, colors, etc. of
individual atoms are revised through the Input Atoms dialog in the Input1 menu. The
displacement of the current fragment is given in both Cartesian coordinates and
coordinates on the structure axes of the current fragment, and the fragment may be
moved on either set of axes with the Translate button. The center point, used for
rotations, is given in Cartesian coordinates with respect to the zero or center point of the
aggregate.
The structure which is in memory when you first add a second fragment provides the
overall zero point for translations of individual fragments, and for rotations of the
aggregate with the Rotation menu or the on-screen rotations in the Display menu.
However, it is possible to rotate the initial fragment, translate it or reset its center point
with the subdialogs under Multiple Structures so that its center point and/or orientation
are not the same as that of the aggregate.
There are three main types of coordinate system involved in Multiple Structures dialog:
(1) Fixed or reference Cartesian coordinate systems. These apply to all structures and
have fixed orientations. The main observer or reference system has a simple relationship
to the screen or paper. When Clinographic Viewing is in effect, rotations can also be
done on the Clinographic axial system, which is another Cartesian system rotated by a
fixed amount relative to the reference system (see Coordinate Systems).
(2) The aggregate or overall structure axes coordinate system. This is taken originally
from the first or main structure, but if the first structure is individuallytranslated or
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rotated through sub-dialogs in Multiple Structures dialog, it may not be the same.
Operations in the Rotation menu apply to this coordinate system.
(3) A structure-axes coordinate system for each individual structure. Translations and
rotations done with sub-dialogs in Multiple Structures dialog may use these coordinate
systems.
Only one set of crystal faces is allowed, and it belongs to the overall structure axes
coordinate system. Thus it is possible to rotate the first structure out of proper
orientation with the faces. For this and other reasons, rotating structure fragment number
1 individually is not usually advisable.
3.2.6.7

Rotate Structure Fragment

Dialog Box: Rotate Structure Fragment [Revise Structure Fragment dialog]
This allows much the same operations as for the overall rotations in the Rotation menu,
except of course that only the atoms in the current fragment are rotated, about its own
center. The Cartesian Axes, Structure Vector and Align Face/Vector options call up
dialogs which are called up from the Rotation menu, but in this case only the current
fragment is affected. The Structure Vector and Align Face/Vector options use the
structure axes belonging to the current fragment. For orienting fragments, especially
crystal structures, the Align Face/Vector option is most useful.
If you click on the Set Default button, the current orientation of this fragment will be the
one which is returned to with the Remove Previous Rotations button.
3.2.6.8

Translate Structure Fragment

Dialog Box: Translate Structure Fragment [ Revise Structure Fragment dialog]
The locations listed at the top are the distances the structure has been moved from its
original position, or since the last time the Set Current Location as Zero button has
been used.
You can move the current structure on either its own structure axes or the overall
observer Cartesian axes. Note that the Distance in Angstroms applies only to translation
on Cartesian axes; if you use a structure vector, the vector itself must have the proper
length, which is expressed as fractions of the original structure axes.
If you click on the Set Zero button, the current location of this fragment will be the one
which is returned to with the Remove Previous button.
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Reset Rotation Center of Fragment

Dialog Box: Reset Rotation Center of Fragment [Revise Structure Fragment dialog]
This allows you to change the observer Cartesian coordinates of the point about which
the fragment is rotated. This rotation center is initially the same as the origin of the
coordinate system for this fragment. If it is changed, the new center will be moved along
with the fragment by any translations.
3.2.6.10

Expand Layers

Dialog Box: Expand Layers [Transform Menu]
This option will expand a crystal structure on certain planes, increasing the length of the
selected axis, creating space near the expansion planes, but leaving the actual structure
within layers unchanged.. It operates on input atoms, leaving the symmetry unchanged.
Any atoms which are exactly on the expansion planes (for example K atoms in a mica
structure) will remain on the expansion planes, and thus bonds from these atoms to other
parts of the structure will be lengthened. Bonds connecting structural layers (that is, any
bonds crossing the expansion planes) will also be lengthened.
The Expansion factor is the amount by which the selected axis is increased. For
example, if the c-axis is 10.0 Angstroms before conversion, an expansion factor of 1.5
will change it to 15.0 Angstroms.
Expand on axis. This selects the axis to be lengthened. Fractional coordinates of most
atoms on this axis will be changed. The other two axes, and fractional coordinates on
these axes, will be unchanged. Thus the structure will be expanded on the principal plane
or unit-cell face which cuts the chosen axis - this plane is not always perpendicular to the
axis. For example if the chosen axis is c, the expansion is on the (001) plane.
Number of planes. There are often several symmetrically identical planes cutting the
selected axis. For example, there may be identical mirror planes at 0.0 and 0.5. You
must determine this number from examination of the space-group symmetry.
Expand at zero. There may be a choice of location of the expansion planes. Normally
this will be a choice between the set of planes at fractional coordinate zero (on the
expanded axis) and another set at some rational fractions. For example, if the Number of
planes is 2, there may be a set at 0.0 and 0.5 and another at 0.25 and 0.75. If the
Expand at zero box is checked, the expansion will be at the first set.
At the moment an arbitrary location of the expansion plane is not supported, and for lowsymmetry crystals, or those which have a choice of more than two locations, it may be
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necessary to adjust all coordinates so that the expansion plane is at zero. If this situation
is common, support for arbitrary location will be added. Support for expansion planes
other than unit-cell faces could also be added if necessary.
Tolerance. This is used to decide if an atom is exactly on the expansion plane, in which
case its coordinate on the expansion axis will not be changed - that is, it will remain
exactly on this plane. Tolerance is in fractional coordinate units (not Angstroms). If you
want atoms which are exactly on the expansion plane to remain in continuity with the
remainder of the structure, their fractional coordinates on the expansion axis should be
changed by greater than the tolerance. Usually this will result in duplication of the atoms.
3.2.7

Settings Menu (Graphics Window)

The Settings Menu (Graphics Window) is identical to the Settings Menu (Startup Window) .

3.2.8

Window menu

The Window menu lists all the possible windows in ATOMS - those which do not
actually exist are greyed out. Select a window to make it active, or bring it to the front.
When a Text window or either the Powder or Precession graphics window is active, the
first item in the menu is a Font selector. In the Text window, this acts on the entire text
in the window and the font applies to all Text windows. The font for the powder and
precession windows applies to both windows and to all text, except that the index
lettering in the Powder window is 0.4 times the size of the lettering for legends.

3.3

Text Window Menu Bar

Text windows are used for the Listings group in the File menu of the Graphics window,
by the Coordination button in the Input Atoms dialog in the Input2 menu, and by the
Calculation Output command in the Input2 menu - see Types of Windows. They are
standard text or edit windows. To switch to the ATOMS main graphics window, which
has the menus and commands for altering and displaying atomic structure data, use the
Window menu, or click on the Graphics window if it is visible.
File menu - This is a standard File menu which pertains only to the special files with
extension.ADT named above.
Edit menu - This menu has the normal text editing commands, which again pertain only
to the special files with extension.ADT.
Window menu - Use this menu to switch to the ATOMS graphic window for most
operations on ATOMS data sets, and to set the font for the Text windows.
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Help menu - On-line help.
3.3.1

File menu (Text Window)

The commands in this menu apply only to Text windows, which are generated by the
List... commands in the File menu of the Graphics window, by the Coordination button
in the Input Atoms dialog in the Input1 menu, or by Calculation Output - see
Types of Windows for further explanation.
Close - Closes the Text window, and the file associated with it.
Save - Saves the file associated with the window.
Save As - Saves the contents of the window to a specified file name.
Print - Prints the contents of the Text window.
Page Setup - Set the page size and select the printer.
Exit - Exits ATOMS.
3.3.1.1

Save command (Text Window)

Save command ( File menu, Text windows)
When called from Text windows, this saves the (text) contents of the current window in
the file whose name is in the title bar. The standard ATOMS files INPUT.ATD,
GENATOMS.ATD, FACES.ATD and TOTALS.ATD are in a subdirectory or subfolder
(Output) to the directory containing the ATOMS program (.EXE) file. They are
overwritten each time you request a list of the corresponding type. Thus if you want to
save these files, you should probably use the Save As command instead of Save, give the
files new names and put them in the same directory as the structure data (.STR) file. See
Types of Windows.
3.3.1.2

Save As command (Text Windows)

Save As command ( File menu, Text windows)
When called from Text windows, this saves the (text) contents of the current window in
the file whose name is in the title bar. The standard ATOMS files INPUT.ATD,
GENATOMS.ATD, FACES.ATD and TOTALS.ATD are in a subdirectory or subfolder
(Output) to the directory containing the ATOMS program (.EXE) file. They are
overwritten each time you request a list of the corresponding type. Thus if you want to
save these files, you should probably use the Save As command instead of Save, give the
files new names and put them in the same directory as the structure data (.STR) file. See
Types of Windows.
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To save a text file with its existing name and directory, use the Save command.
3.3.1.3

Close command (Text Windows)

Close command ( File menu, Text windows)
Use this command to close the currently active Text window. ATOMS inquires if you
want to save changes to your data file before you close it. If you close a data set without
saving, you lose all changes made since the last time you saved it.
The standard ATOMS files INPUT.ATD, GENATOMS.ATD, FACES.ATD and
TOTALS.ATD are in a subdirectory or subfolder (Output) to the directory containing
the ATOMS program (.EXE) file. They are overwritten each time you request a list of
the corresponding type. Thus if you want to save these files, you should probably use the
Save As command, give the files new names and put them in the same directory as the
structure data (.STR) file.
3.3.1.4

Print command (Text Windows)

Print command ( File menu, Text windows)
Use this command to print the contents of a Text window. This command presents a
Print dialog box, where you may specify the range of pages to be printed, the number of
copies, the destination printer, and other printer setup options.
3.3.1.5
Page Setup
This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins (except Macintosh). Margins will only be used in
Text Windows.
---Macintosh only -----Use the Page Margins dialog to set margins.
3.3.1.6

Page Margins

-----Macintosh only---This dialog sets the margins for
size and orientation.

3.3.2

Text Windows. Use the Page Setup dialog to choose page

Edit menu (Text Window)

The Edit menu for Text windows offers the usual commands.
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Reverse previous editing operation.
Deletes data from the document and moves it to the clipboard.
Copies data from the document to the clipboard.
Pastes data from the clipboard into the document.
Cut command

Cut command (Edit menu)
Use this command to remove the currently selected data from the document and put it on
the clipboard. This command is unavailable if there is no data currently selected.
Cutting data to the clipboard replaces the contents previously stored there.
3.3.2.2

Paste command

Paste command (Edit menu)
Use this command to insert a copy of the clipboard contents at the insertion point. This
command is unavailable if the clipboard is empty.
3.3.2.3

Copy command

Copy command (Edit menu)
Use this command to copy selected data onto the clipboard. This command is unavailable
if there is no data currently selected.
Copying data to the clipboard replaces the contents previously stored there.
3.3.2.4

Undo command

Undo/Can't Undo command (Edit menu)
Use this command to reverse the last editing action, if possible. The name of the
command changes, depending on what the last action was. The Undo command changes
to Can't Undo on the menu if you cannot reverse your last action.
3.3.3

Window Menu

The Window Menu in Text Windows is identical to the Window Menu in the Graphics Window.
It does have a command for changing the font of all text in the window.
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ATOMS Help

Help Menu

The Help menu offers the following commands, which provide you assistance with this
application:
ATOMS Help Topics. This brings up the Help system. Use the Content, Index or Find
tabs to locate information on a particular topic.
About. This gives the version number of ATOMS. For Macintosh, the About dialog is
either in the Apple menu (OS 8/9) or the Application menu (OS X).
3.4.1

About command

About command (Help menu)
Use this command to display the copyright notice and version number of your copy of
ATOMS.
3.5

Identifying (Picking) Atoms

Identifying (Picking) Atoms
When a drawing is displayed in the ATOMS graphics window, you can identify generated
atoms by clicking with the mouse. Generated atoms can thus be marked for non-plotting
and later deletion (see Deleting Atoms ). If molecules have been located or fragment are
present these are also identified.
A mouse click is judged to be "on" a given atom if it is within that atom's radius of its
center point. If the atom in question has zero or negative radius (see the Revise Atom
dialog in the Input1 menu for the significance of non-positive radii), then the default
radius, set in the Preferences dialog in the Settings menu, is used.
The click point may actually be "on" more than one atom; all atoms which project onto
the plane (x = 0) within the specified distance of this point are identified, not just the one
which is visible at this point. In this case, the Atoms at Cursor dialog comes up, giving a
list of the atoms, from foremost to rearmost. Select the desired atom, and click on the
View/Revise Atom button. This brings up the Generated Atom Data dialog for that
particular atom. If the click point is only on one atom, the Generated Atom Data dialog
comes up directly. If the click point is not on an atom, you get an alert to this effect.
The atom(s) which have been identified may be marked by outlining with a contrasting
color - see the Preferences dialog in the Settings menu.
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Atoms at Cursor

Dialog Box: Atoms at Cursor [click in graphics window]
When a drawing is displayed in the ATOMS graphics window, you can identify generated
atoms by clicking with the mouse. Generated atoms can thus be marked for non-plotting
and later deletion (see Deleting Atoms). If molecules have been located or fragment are
present these are also identified.
A mouse click is judged to be "on" a given atom if it is within that atom's radius of its
center point. If the atom in question has zero or negative radius (see the Revise Atom
dialog in the Input1 menu for the significance of non-positive radii), then the default
radius, set in the Preferences dialog in the Settings menu, is used.
The click point may actually be "on" more than one atom; all atoms which project onto
the plane (x = 0) within the specified distance of this point are identified, not just the one
which is visible at this point. In this case, the Atoms at Cursor dialog comes up, giving a
list of the atoms, from foremost to rearmost. Select the desired atom, and click on the
View/Revise Atom button. This brings up the Generated Atom Data dialog for that
particular atom. If the click point is only on one atom, the Generated Atom Data dialog
comes up directly. If the click point is not on an atom, you get an alert to this effect.
The atom(s) which have been identified may be marked by outlining with a contrasting
color - see the Preferences dialog in the Settings menu.
3.5.2

Generated Atom Data

Dialog Box: Generated Atom Data [click in graphics window]
[Atoms at Cursor dialog]
When a drawing is displayed in the ATOMS graphics window, you can identify generated
atoms by clicking with the mouse. With this dialog, generated atoms can thus be marked
for non-plotting and later deletion (see Deleting Atoms). If molecules have been
located or fragment are present these are also identified.
A mouse click is judged to be "on" a given atom if it is within that atom's radius of its
center point. If the atom in question has zero or negative radius (see below and the
Revise Atom dialog in the Input1 menu for the significance of non-positive radii), then
the default radius, set in the Preferences dialog in the Setting menu, is used.
The click point may actually be "on" more than one atom; all atoms which project onto
the plane (x = 0) within the specified distance of this point are identified, not just the one
which is visible. In this case, the dialog Atoms at Cursor dialog comes up, giving a list
of the atoms, from foremost to rearmost. Select the desired atom, and click on the
View/Revise Atom button. This brings up the Generated Atom Data dialog for that
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particular atom. If the click point is only on one atom, the Generated Atom Data dialog
comes up directly. If the click point is not on an atom, you get an message to this effect.
The atom(s) which have been identified may be marked by outlining with a contrasting
color - see the Preferences dialog in the Settings menu.
The label, type and atomic radius listed towards the top of the Generated Atom Data
dialog pertain to the input atoms and cannot be changed here - they are set in the
Revise Atom dialog in the Input1 menu.
The listed Cartesian atomic coordinates are in Angstroms, in the observer Cartesian
system (see IV-4). You can change these coordinates if you wish, but if ATOMS is in its
normal operating mode this change in position will only be temporary; it applies to a
generated atom, which is not saved in the structure file. If the structure is recalculated,
the changes are lost. However, you can make such changes permanent by using the
Generated to Input conversion in the Transform menu. This puts the Input=generated
operating mode into effect, and the changes in atomic coordinates are permanent (if the
file is saved). When this mode is in effect, input atoms are equivalent to generated atoms.
The fractional atomic coordinates are in the structure axis system. They cannot be
changed directly, but will be changed if the Cartesian coordinates are changed (previous
paragraph).
If the structure has been converted to the Input=generated mode (Generated to Input in
the Transform menu), there is an Edit Input button. This button brings up the
Revise Atom dialog for the current atom. With this dialog, you can change the color,
radius, type, etc. of the current atom. Some such changes may require recalculation,
rather than replotting. For example, you can change the color of individual polyhedra.
Set up an additional polyhedron type, identical to a current type except for color and the
type number of the central atom. Then, by clicking on a central atom, you can change the
color by changing the atom type number.
Use the Mark Atoms command in the Display menu to mark the locations of specified
types of atoms, or of atoms which may not currently be plotting.
The Atom plot type determines how the atom, and bonds to it, are displayed. The plot
type is determined by the absolute value of a plot code, which is set by certain input
values and results of the calculation. (this plot code is listed with other data on the
generated atoms, with the List Generated Atoms command in the File menu). The
check box below the plot type may be labeled Plot atom, Plot bonds, Plot Atom and
Bonds or Plot Polyhedron, or it may be absent altogether. Checking or unchecking this
box changes the sign of the plot code; generally positive means plotting and negative
means non-plotting.
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By unchecking the box, you can make the atom and/or and the bonds to it non-plotting.
This action marks the atom as non-plotting but does not remove it from the generated
atom list. A list of non-plotting generated atoms is saved in the structure file (see
Deleting Atoms). You can cause the non-plotting atoms to be permanently deleted by
exercising the Generated to Input conversion in the Transform menu; this can be done
repeatedly, just for the purpose of deleting atoms.
All atoms marked as non-plotting can be restored, and a specific range of generated
atoms can be either restored or marked non-plotting, with the Atom Plot Status dialog in
the Input2 menu.
The effect of the check boxes depends on the atom plot type. The atomic radius of an
input atom (see the Revise Atom dialog in the Input1 menu) in part controls the plot
type; if the radius is positive, the generated atoms derived from this input atom are shown
as spheres, if they are not part of polyhedra. Display (as spheres) of atoms which belong
to incomplete polyhedra is controlled by a checkbox in the Polyhedra dialog (Input1
menu). Display of polyhedron ligands as spheres is also controlled by a checkbox in the
Polyhedra dialog. If the input radius is zero (polyhedron atom), the atom is only shown
if it is a corner of a complete polyhedron. If the radius is negative (wire-frame atom), the
atom is never shown as a sphere, but its bonds may be shown. The plot codes are derived
as follows.
Non-plotting atom (plot code 0). These atoms never plot. This code is assigned to
atoms with input radius zero, and which should be either central atoms or ligands of
polyhedra, but which belong to incomplete polyhedra - that is polyhedra with an
insufficient number of ligands or no central atom.
Spherical atom (plot code 1). This type is always shown as a sphere. The check box
below Atom plot type is labelled Plot Atoms and Bonds. Positive (+1) plot code (box
checked) means the atom and all bonds to it are plotted, negative (-1) means they are not
plotted.
Central atom of polyhedron (plot code 2). This type is never actually shown itself; The
check box below Atom plot type is labelled Plot Polyhedron. Positive (+2) plot code
(box checked) means the entire polyhedron is plotted, negative (-2) means it is not
plotted. Checking or unchecking not only changes the sign of the plot code for the
central atom, but also that of all the ligands (see next item). This means that all the bonds
from spherical or wire-frame atoms (codes 1 and 3) to the ligands become plotting or
non-plotting respectively.
Polyhedron ligand (plot code 3). If the atom input radius is positive, this type of atom
may be shown as a sphere, as controlled by the checkbox in the Polyhedra dialog (Input1
menu). If the input radius is zero, these atoms may never be shown as spheres, only as
corners of polyhedra. The check box below Atom plot type thus can be labelled either
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Plot Atom and Bonds or Plot Bonds. Whether the polyhedron as a whole is shown or
not is controlled by the central atom (see above). The Plot Atoms/Bonds box controls
all bonds from this ligand to spherical atoms (code 1), ligands of other polyhedra (code 3)
or wire frame atoms (code 4).
Ligand or wire frame (plot code 4). The check box below Atom plot type is labelled
Plot Bonds. This type of atom is never plotted itself. However, the Plot bonds check
box is active and controls whether the atom is visible, since it controls all bonds to the
atom.
Atoms in incomplete polyhedra (plot code 5). If the input radius of either the central
atom or ligands of polyhedra is positive, and an insufficient number of atoms is found to
complete the polyhedron (because of boundary conditions), these atoms will be given plot
code 5. The display of such atoms as spheres is controlled by a check box in the
Polyhedra dialog (Input1 menu). Note that if input radius of polyhedral atoms is zero,
atoms in incomplete polyhedra will be given plot code zero, and will never be plotted.
This saves computation time because the bonds to these atoms are not located.
For polyhedron ligands, the Plot Atoms/Bonds check box is generally best left alone,
except for the case of ligands shared between polyhedra. In this case, if the Plot
Polyhedron box for the central atom of one of the polyhedra is unchecked, this unchecks
the Plot Atoms/Bonds box for all of its ligands (i.e. changes the plot code from +3 to 3). If there are non-polyhedron bonds, i.e. bonds from a spherical atom or a wire-frame
atom, to a ligand which is shared between the non-plotting polyhedron and a polyhedron
which is still plotting, they will not be shown. You can correct this condition, restoring
these bonds to plotting, by checking the Plot Atoms/Bonds box of the shared ligands.
Note that changing the status of the central atom will undo changes of the status of the
ligands.
Deletions or restorations of atoms and attached bonds with the check boxes does not take
effect immediately, only after replotting of the drawing. Replotting is automatic if the
Replot box is checked; otherwise select the Replot command in the Display menu.
Label. This box is checked by default, so that turning on atom labels with the
Atom Labels dialog in the Display menu will produce a label for each atom. Deleting or
omitting labels is similar to deleting atoms (see above); it only applies to generated atoms.
Deleted labels can be restored with the Restore Deleted button in the Atom Labels
dialog in the Display menu.
The distance to the last atom selected with this dialog is printed out near the bottom, if a
different atom was selected. There will be a Bond Label checkbox, and unchecking this
box will suppress plotting of the label. All labels can be restored with the Show All
button in the Bond Labels dialog. A list of non-plotting bond labels is kept in the data
(.str) file.
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The Bond button can be used to make a custom "bond" between the current atom and
the last one. If you click on this button, you will be shown the
General Lines or Cylinders dialog, and the "bond" thus defined will be kept in that list,
not in the Bonds dialog in the Input1 menu.
The bond angle involving the last three atoms selected is also printed out, if three
appropriate atoms have been selected. If this angle is one of those which satisfy the
specifications in the Angle Labels dialog, there will be an Angles checkbox. Unchecking
this box will supress plotting of the angle label. All labels can be restored with the Show
All button in the Angle Labels dialog. A list of non-plotting angles is kept in the data
(.str) file.
If Atomic Vectors are present and if the structure is Input=generated, the direction may
be reversed with the Invert Vector button. The drawing must be recalculated, not just
replotted, to see the reversal.
For Protein Data Bank (PDB) structures, the Protein button will bring up a listing of the
protein-specific attributes of the selected atom.
Molecule/Group options.
If molecules have been located or individual structure fragments are present (allowed only
in the Input=generated boundary/operating mode), you can control their display with the
buttons at the bottom of the dialog. Highlight means that the selected group appears in
normal colors while all other atoms are dimmed. Hide means that atoms in the group are
marked as non-plotting (see above)
If molecules have not been located with one of the Molecules in Crystal
boundary options, you can locate them with the Find button. Molecules or groups to be
located or isolated must have all their atoms connected by Bonds or Polyhedra, and the
must be no bonds (except those marked as intermolecular in the Bond Data dialog) or
polyhedra interconnecting molecules. For more information on locating and manipulating
groups, see Dealing with Molecules, Groups and Fragments, and the Locate Groups
dialog (Transform menu).
3.5.3

Protein Attributes of Atom

Dialog Box: Protein Attributes of Atom [ Revise Atom: Basic Tab] [
Generated Atom Data]
This dialog is used only when the atom data are obtained from a Protein Data Bank
(PDB) file. It gives the parameters which are specific to protein structures - none of these
parameters are set in ATOMS. See the PDB literature for explanation.
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Select Color

Dialog Box: Select Color [various dialogs].
This dialog allows color selection from the current 16-color palette, and also allows
selection of a custom color. The Custom button calls up a system standard color-picking
dialog.
The red, green and blue values are given below each color box, to the right of the radio
button. These values are on a scale of 0-255, as used by Windows.
It is usually best to use one of the 16 colors in the palette, because 1) the 256-color or 8bit display palette is derived from these colors, and shaded atoms, bonds and polyhedra
will be forced to one of these colors anyway at plot time; and 2) display and output are
usually more satisfactory when simple colors, such as those in the default palette, are
used.
The default colors selectable in this dialog may be changed in the Palette dialog (Settings
menu).

4

Reference
Topics here are of general interest or may be referred to in several dialogs.

4.1

Atom Parameter Files

Atom Parameter Files (Free-Form or.inp)
This type of ASCII or text file may be used in either the Input Atoms dialog in the Input1
menu, or the the Import option in the File menu (Import Free-Form), to read in atomic
coordinates alone, or to supply complete structure information. ATOMS itself does not
write.inp files, but they are written by the program CRYSCON (Shape Software) which
can be used to perform various types of crystallographic conversions, such as
sub/supercell, change of origin, change of symmetry, etc. Listings of atomic coordinates
from almost any source can be used as the basis of a free-form file.
All or part of the parameters for each input atom, namely label, fractional coordinates,
type, radius and display colors and pattern numbers, can be read in. You can also supply
default values for some parameters, so that the parameters neither need to be present on
every line of the file, nor need to supplied through the dialog.
Except for the TITL line, keywords and actual values to be read in should be separated
by spaces or commas, and there should be no spaces within keywords or values. There is
no need for alignment by column.
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The input file may contain two overall types of lines; General and crystallographic
information lines; and actual data or atomic parameter lines.
General and crystallographic information lines. These lines should all precede the
atomic parameter lines. Each line consists of a keyword followed by one or more values
or character constants. The keyword should start in the first column and be followed by
at least one space before the actual values. Where more than one value is called for, they
are separated by spaces. All of these lines are optional - when a free-form file is used for
import (File menu), if any lines are absent, default values will be supplied. When a freeform file is read through the Input Atoms dialog in the Input1 menu, current values are
kept if the corresponding line is absent.
TITL line. Up to 76 characters (may contain spaces).
CELL line. The unit-cell lengths in Angstroms and the interaxial angles in degrees (6
floating-point values). If the atomic coordinates are Cartesian, the axes should be 1.0 and
the angles 90.0.
SPGP line. The Hermann-Maughin or standard International symbol for the space group.
There should be no spaces in the symbol, although there may be underscores (which are
ignored when the symbol is interpreted.
HALL line. The Hall symbol for the space group. There should be no spaces in the
symbol, although there may be underscores (which are ignored when the symbol is
interpreted. If this line comes after the SPGP line (or that line is absent), the Hall symbol
will be used in the Space Group Symmetry option.
SYMM lines. These give symmetry operators in "xyz" form, that is in the form in which
the coordinates of the general position are listed in the International Tables for X-Ray
Crystallography. Fractions must be given as integers separated by a slash ("1/2", "2/3"),
rather than decimals ("0.5", "0.333"). The x, y and z positions must be separated by
commas and there should be no spaces in the operator. There should be one line for each
operator. If the space group is centrosymmetric, only half the operators need be given, if
the origin is on a center of inversion. If the origin is not on a center, all operators must
be given and the space group should be denoted non-centric in the LATT line. If these
lines come after the SPGP and HALL lines (if present), the Custom Symmetry option will
be used.
LATT line. This gives the Bravais lattice type (single capital character), followed by a
space and 0 if the space group is centrosymmetric or 1 if it is non-centric.
FORM lines. These lines contain the three indices and the central distance for each form.
When the file is read in, you will have the option of using these forms in the Enter Forms
boundary option.
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FACTOR line. A single (floating-point) factor which multiplies all the fractional or
atomic coordinates.
Atomic parameter lines:
The file should have all the information for each atom, except for temperature factors, on
a single line with a maximum of 80 characters per line, and the values must be in fields,
which are set off or delineated with either spaces or commas. There can be no spaces or
commas within fields. The names of fields are given in the following in capitals, but in the
actual input they may be lower case; all letters are converted to upper case when the line
is read in.
DEFAULT lines supply values to the parameters, such as colors, which are not read in
for each atom. If default values are not entered in this way, default values are obtained
from the separate ELEMENTS file, using the chemical symbol of the atom which is
assumed to be in the first two characters of the atom label. See the further description of
DEFAULT lines and the ELEMENTS file below.
FIELDS lines. These lines set up the ATOMS input parameters which are to be read
from the file, and the order in which they are to be read.. This is followed by the
keywords giving the order of the fields. The allowed keywords are as follows (INTEGER
fields may not contain a decimal point):
1) LAB - (6 characters maximum). Any label for the input atom may be used, but the
label normally begins with the chemical symbol for the element. The first two characters
may be used to determine default values for some of the parameters, as described below.
The characters may be upper or lower case, but they are all converted to upper case after
input. This is a required field.
2) COO - This actually denotes three floating-point fields giving the fractional atomic
coordinates for crystals, or the absolute coordinates for molecules. After input, the
coordinates are multiplied by the number in the FACTOR line, if this line is present.
These are required fields.
3) TYP - This is the type which is used in locating bonds and polyhedra. INTEGER
4) RAD - This is the radius used when the atom is plotted as a sphere. FLOATINGPOINT
5) RMC - This is the color for the atom rim or edge, in terms of three RGB components
0-255. 3 INTEGERS
6) FLC - This is the color for the atom fill, in terms of three RGB components 0-255. 3
INTEGERS
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7) RMP - This is the pattern number or gray shade used in black-and-white display or
output. This number is used only for wide lines (see Line Widths). INTEGER
8) FLP - This is the b/w pattern number for fills. This is used only if shading is off or the
initial pattern number option (Shading) is on. INTEGER
9) PEN - This is the pen number used for atom outlines in pen plots. INTEGER
10) TFB - Temperature factors in B or bij (beta) form, types 0 (anisotropic) or 6
(isotropic) in ORTEP. If this keyword is present, the temperature factor(s) are present
on a second line for each atom, in up to six fields The order is 11, 22, 33, 12, 13, 23. If
the second value is absent or zero, the temperature factor will be read as isotropic. Note
that ATOMS will save temperature factors only if at least one atom has non-zero for the
first value or b11.
11) TFU - Temperature factors in U or uij form, for anisotropic type 8 in ORTEP.
Similar to TFB. Isotropic U values will be converted to B values (type 6 in ORTEP).
12) VEC - Atomic vectors, e.g. for magnetic spins or vibrational displacements. If this
keyword is present, the vector coefficients are present on a second line, in four fields.
The first three are the relative components in the structure axes, and the fourth is the
length. The length may be in any units, as a scale factor is always applied (see the
Atomic Vectors dialog). Vectors and temperature factors may not both be present.
13) DUM - This designates a field (character, integer or floating-point) that exists in the
input data line, but should be ignored by ATOMS.
Note that the actual atom data lines do not contain any keywords. The keywords in the
FIELDS lines set up the sequence of parameters in each data line.
An example FIELDS line:
FIELDS DUM LAB COO TYP RAD
Some corresponding data lines:
1 C1 0.1234 0.2345 0.3456 6 1.2
2 H2 0.4321 0.5432 0.6543 1 0.1
Here the first field, which is simply a sequence number, must be ignored by ATOMS, and
is designated with a DUM.
Here is an example of some lines copied from an (old) ATOMS.STR file (spinel):
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FIELDS DUM LAB TYP COO RAD
1 MG1 12 .12500 .12500 .12500 .000
2 AL2 13 .50000 .50000 .50000 .000
3 O3

8 .26200 .26200 .26200 .000

There should normally be a FIELDS line at the beginning of the atomic parameter lines,
but additional FIELDS lines can be inserted at any point to redefine the fields. If there is
no FIELDS line, the fields are by default; LAB and COO.
In the actual data lines, fields denoted INTEGER above should not be more than 6
characters; the COO and RAD fields (floating-point) should not be more than 20
characters.
DEFAULT line. This is used to set particular default values for fields other than LAB or
COO. DEFAULT must be the first 7 characters. Then the default values are indicated
with the name of the field connected with an equals sign (with no intervening spaces) to
an appropriate value. Example default line:
DEFAULT TYP=1 RAD=0.95 FLC=15
There are twelve possible input fields for each input atom, or each line in the file, plus the
placeholder DUM field. The LAB and COO fields are required for each atom and must be
read in from the file; the other fields are optional. If the latest FIELDS line does not
define a field for a particular parameter, then the value of the missing parameter is
determined by reading the first two characters of the label (LAB field) and taking the
correspoding value from the ELEMENTS file, as discussed in the next section. However,
values given in the latest DEFAULT line take precedence over any values read in or
derived from the ELEMENTS file. You can turn off defaults, thereby accepting the
values on the input atom line or the values in the ELEMENTS file, with a line containing
the word DEFAULT and no other keywords.
ELEMENTS files. These files may contain a line for each possible type of input atom.
Either of two files may be used: ELEMENTS.COV, with covalent radii, and
ELEMENTS.ION, with ionic radii - the choice between the two is made in the
Preferences dialog in the Settings menu.
The ELEMENTS files may be modified to change the default parameters. The first field
in each line is the atomic number or other designated type number. The second field, or
SYM field, consisting of two characters in single quotes, is usually the normal elemental
symbol. The remaining fields give the default values for the RMC, FLC, RMP, FLP and
PEN parameters. If all fields for each input data line are either read in with one of the
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fields in the FIELDS line, or given values with a DEFAULT line, the ELEMENTS file is
not used. If one or more parameters are missing, then the first two characters of the LAB
are matched with the elemental symbol in the ELEMENTS file. If the TYPE has not been
read in or specified with a DEFAULT line, it is taken to be the atomic number, and other
missing parameters are given values from the proper field in the ELEMENTS file.
4.2

central distance

Central distance. The central distance for a face or form (set of symmetry-equivalent
faces) is the perpendicular distance in Angstroms from the center of the structure
coordinates to the face in question. Generally, the larger the central distance the less
prominent (smaller) the face is.
4.3

Colors, Palettes and Dot Patterns

Color Models.
ATOMS is designed to give the best quality display and output for the most common
types of screen display, printers and plotters. However, because these devices vary
widely in their capabilities for displaying color, it may be necessary to understand several
different color models. The models are best discussed in terms of the number of bits
used to represent each pixel in a raster or bit-mapped display or output.
1-bit or black-and-white. This is used for two-color or black-and-white printing and files
destined to be printed. Each pixel is either off (white) or on (black). For filled areas
dot-patterns with varying percentages of black dots simulate shades of gray. Every input
atom, bond or polyhedron has a black-and-white pattern number for rim and fill. For
raster files, ATOMS supplies the patterns in two series, coarse and fine (see below). For
printer output in Windows, you can select either the ATOMS patterns or the screendriver patterns; for Macintosh the ATOMS patterns are always used. Direct PostScript
output uses the patterns supplied by the output device.
The dot pattern is used for lines only if wide lines (Line Widths dialog in the Input2
Menu) are selected; if lines are one-dot width, they are black. If atoms, bonds or
polyhedra are not shaded, that is given variable coloring depending on presumed
illumination, then the pattern number can be used without modification as a means of
distinguishing different atoms, etc. Generally, if shading is used, it is best to treat all
atoms, bonds and polyhedra alike, that is show a white color (no dithering) at maximum
illumination. However, it is possible to assign an initial shade to each type of atom.
(Shading dialog in the Input2 menu).
8-bit or 256 color. This may be used by older types of screen displays, and it is often
advantageous for non-3D drawings in raster files. The 256 colors in these displays (in
Windows minus 20 colors set aside for system use) may each be set to any admixture of
red, green and blue. ATOMS sets up a 256-color palette designed for displaying shaded
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atoms, bonds and polyhedra. It is based on 16 principal colors, which can be defined in
the Palette dialog in the Settings menu. See below (Palettes) for further information on
palettes.
15-, 16, 24- or 32-bit or RGB color. This is becoming standard for screen displays, and
it is used for Postscript color output and for 16- and 24-bit raster files. One-third of the
available bits are used to represent each of the color components red, green and blue.
For 24- or 32-bit screen displays, there are virtually no restrictions on colors, and any
colors and shadings thereof can be rendered faithfully.
In non-3D display modes, for the most part RGB color does not greatly improve the
quality of ATOMS drawings over 8-bit color. However, it does remove restrictions in
two areas: (1) Any number of separate colors are valid for shaded atoms, bonds and
polyhedra, rather than only 15 colors for 16 or fewer shading zones, or 7 colors for 32
zones (see under palettes below); (2) when front-back fading (Shading dialog in the
Input2 menu) is in effect, the atoms etc. in the rear of the drawing are not restricted to a
few of the darker zones in a shading series, as in 8-bit color.
When generating raster files of color images in non-3D modes, it may advantageous to
use use 8-bit (256-color) rather than RGB (15-bit through 32-bit) color because the files
tend to be much smaller. This is because of the smaller number of bits in the pixels, but
also because the run-length encoding used in some file types does not compress RGB
files well.
The 3D mode does not use the ATOMS 256-color palette on 8-bit displays, in either
Windows or Macintosh. Windows uses a special palette for this mode and the Macintosh
must use the system color table. This often results in dithering, so RGB color should
generally be used for 3D modes.
Printing. The choice between 4-bit (standard VGA), 8-bit (256-color) and 15-32-bit
display may may a great difference in the appearance on screen, but hard-copy devices
such as printers actually use only a very limited number of colors (typically cyan,
magenta, yellow and black, although some inkjet printers may use more by mixing inks),
simulating more complex colors with dithering. Some degradation of color quality from
screen to printed image is to be expected. If color match of the printed output is very
poor, check the settings for the printer in the Print dialog.
Palettes.
Although Windows and Macintosh programs can specify colors made up of any
admixture of red, green and blue components, it is generally a good idea to use simple
colors whenever possible, to increase the chances of faithful reproduction on a variety of
display and output devices.
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16-Color Palettes. ATOMS uses a Main Palette composed of 16 colors for two reasons:
to aid in the consistent selection of simple colors; and to form a basis for the 256-color
palette used for 8-bit displays or other devices. The first eight colors in the default Main
palette are black, white, red, green and blue, and then the binary combinations of red,
green and blue which are cyan, magenta (violet) and yellow. The second eight colors are
two shades of gray, then the binary combinations of red, green, blue, cyan, magenta and
yellow (these six have no universally-recognized names). The colors in this palette are
the same as those in the Alternate palette which is used in the DOS versions of ATOMS,
but in a different order.
The RGB values in both the 16-color palettes can be changed with dialogs in the Settings
menu. You can also save and re-read palette files.
256-Color Palettes. The palettes which are used in 256-color screen-display modes are
primarily designed for shading. There are two distinct palettes; the first has 15 principal
colors, each with 16 gradations from full intensity to almost black, and is used whenever
the number of atom shading zones (Shading dialog in the Input2 menu) is 16 or fewer;
the second has only 7 principal colors, each with 32 gradations from full intensity to
almost black, and is used when the number of atom shading zones is 32.
The first or "16-zone" palette is made up as follows. The first 15 colors (0-14) start with
full-intensity color number 1 (white), and grade with decreasing intensity to near black;
the second 15 colors (15-29) start with full intensity color number 2, grading to near
black, and so on. When shading is in effect, ATOMS finds the nearest color in the 16color palette to the color selected in the input for the atoms, bond or polyhedron. Any
shading zone of an atom, bond or polyhedron receiving full illumination is given this fullintensity color and shaded parts are given colors in the series of 15 colors derived from
that principal color. The palette defined in this way actually contains only 225 colors.
In the second or "32-zone" palette, the first 31 colors (0-30) grade from full-intensity
color 1 to near black, the next 31 from full-intensity color 2 to near black and so on,
through color number 7 and its derivatives. When shading is in effect, ATOMS again
"forces" the color to one of those in the 16-color palette, but the choices this time are
only colors 0-7. As the colors are arranged in the default palette, this results in changing
colors 8-15 to 0-7 respectively. Actually, colors 0-7 can be regarded as "simplified" or
more basic versions of colors 8-15. The above shaded colors add up to only 217, so
colors 8-15 are also added to the palette to be usable for lines and unshaded fills.
Again, if shading is in effect and you are using more than 16 shading zones (Shading
dialog in the Input2 menu), any fill colors for atoms, stick bonds or polyhedra in the
range 8-15 will be automatically "downgraded" to colors 0-7.
All these complexities and restrictions pertain only to 8-bit or 256-color display or raster
files. For standard VGA (4-bit) display in Windows, the RGB values are sent to the
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display driver, which determines in its own way what combination of pixels to mix to
represent a given color. This is likewise true for printer and PostScript output. The RGB
values are also sent directly to 16-, 24- and 32- bit screen displays, which can presumably
render any color without dithering.
Dot Patterns for Black-and-White Display and Output.
The dot-patterns which are the "colors'' for atom, bond and polyhedron fills and wide
lines in black-and-white printer output (if ATOMS patterns are selected in preference to
those supplied by the printer driver in Windows), and which are also used for shading in
black-and-white raster files, are shown in the diagram below. The patterns comprise two
series of dot-patterns of increasing density with shade numbers 0-15; the choice between
them is made in the Print or Raster File dialogs (File menu).
The fine series is recommended for 9-pin or other low resolution dot-matrix plotting, for
very small drawings done at high resolution, or for raster files which will be shown on a
low-resolution screen. The coarse series contains patterns more like the half-tone
screening used in printing. It is appropriate for gray tones and shading in high-resolution
dot-matrix plotting. Actually, for shading with 32 zones, there are 32 patterns in the
coarse series, only half of which are shown in Figure IV-1. The fine series has only 16
unique patterns even if the number of shading zones is 32, although this could be changed
in the SCRPTR file (Direct Modification...).
ATOMS has the ability to use macrosopic hachure patterns on both polyhedra and atoms.
In many cases it may be more appropriate to use these patterns to differentiate atoms and
polyhedra than to use grey shades.
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Colors/Patterns/Pens for Input

In color display or output, lines may be drawn with different colors, and atoms, stick
bonds and polyhedra may be filled with different colors (except in pen plots, in which
atoms, stick bonds and polyhedra are always blank or white). In black-and-white display
or output, various dot-patterns, simulating shades of gray, are normally used for fills, and
for lines if they are wide enough.
This section discusses the common aspects of color/shade input for lines and fills, as
occurs in many input dialogs in ATOMS. Depending on the type of display and output
involved, any of three different sets of colors or patterns/shades may be used.
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(a) For color screen displays, printer, Raster, Metafile or PICT output, actual colors are
used. The RGB components, which are numbers ranging from zero to 255 can be
directly entered in the edit boxes, but the color is most easily and reliably selected with
the Select...Color buttons. These bring up the Select Color dialog, presenting the colors
of the current main palette. If the color is being selected for a fill, and if shading for the
object in question (atom, stick bond or polyhedron) is selected in the Shading dialog in
the Input2 menu, the color chosen here is that at maximum (perpendicular) illumination.
If front-to-back fading has been selected in the Shading dialog in the Input2 menu, the
chosen color is that for the foremost atom.
For 16-, 24- or 32-bit color screen displays you have complete freedom to choose
colors. For 8- or 4-bit color the fill colors of shaded atoms, bonds and polyhedra may be
forced at plot time to one of a limited number of allowed colors. For 8-bit color the
number of colors allowed depends on the number of atom shading zones selected in the
Shading dialog in the Input2 menu. See the general section
Colors, Palettes and DotPatterns for further information on palettes for the 8-bit color
mode.
For best results on a wide range of display and output devices, chose the simplest colors,
which are firstly colors 0-7 in the default main palette, and secondly colors 8-15
(b) For black-and-white screen displays and printer, raster or metafile output, either true
grays or dot patterns of various densities are used. The codes for these shades or
patterns range from 0 for white to 15 for solid black.
The selected pattern is used for fills if shading is not in effect. If shading is in effect,
selected in the Shading dialog in the Input2 menu, the actual fill patterns shown may
either start at white for maximum illumination, or at the pattern number selected here
depending on the setting of the Use initial patterns checkbox in the Shading dialog.
The selected pattern is used for lines only if the width of the line is greater than one dot.
The width of various types of lines is set in the Line Widths dialog in the Input2 menu.
Note that rendering of gray-scale for lines in black-and-white printed output is
determined by the printer driver, not ATOMS. Many printer drivers do not support gray
lines and pattern numbers other than 15 may give either white or black lines.
(c) For pen-plotters the number requested refers to the pen number used in drawing the
lines. For atoms, stick bonds and polyhedra, this refers to the outlines; there are no fills
in pen plots (the interiors of atoms, stick bonds and polyhedra are always blank). These
numbers are not used if the single-pen mode is selected in the Pen Plotter Settings dialog
in the Settings menu.
When changing the red, green and blue values directly in the edit boxes which appear in
many dialogs in ATOMS, the rectangle showing the actual color does not change until
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the focus shifts from the current edit field, that is until the mouse is clicked in another
place in the dialog.
4.5

Coordinate Systems

Three types of coordinate system are used frequently in ATOMS: the observer Cartesian
system; the natural structure system; and a Clinographic system.
The observer system is fixed with respect to the display screen or paper of dot-matrix or
pen-plotter copy. The origin is at the center of the screen or paper, and the x axis points
directly toward the observer. The y axis points to the observer's right and the z axis
vertically, both in the plane of the screen or paper.
The atomic coordinates and the parameters of crystal faces if present are given in terms of
the natural structure axis system, although in the case of molecules this may itself be a
Cartesian system. Once all the atoms and faces have been generated, their coordinates are
converted to Cartesian coordinates. Except for crystals using rhombohedral axes, the
natural c axis is originally placed parallel to the observer z axis, and the natural b axis is
aligned in the y-z plane (or in crystallographic terminology the a* axis is parallel to x). If
rhombohedral crystal axes are chosen, the three-fold symmetry axis is parallel to z, and
the the vertical plane containing the first rhombohedral axis is aligned in the x-z plane.
This conversion defines the "original'' orientation of the structure. After the location of
atoms and faces, and before the initial display, the orientation may optionally be modified
by the rotations in the Initial Orientation dialog in the Input2 menu, by the alignment of a
Slice of a crystal, and by clinographic rotation, defined in the next paragraph.
Clinographic Viewing. One of the standard methods of drawing crystals is clinographic
projection, in which the crystal is in effect viewed from above and slightly to the right of
the a axis, or to be more precise, in towards the center along the vector [621] referred to
cubic or Cartesian axes. If the option for clinographic viewing is chosen, after the faces,
atoms etc. are found, the structure and its associated Cartesian system are rotated -18.4
degrees on the z axis, then 9.5 degrees on the y axis.
After the drawing appears, additional rotations may be made either on (1) specified
vectors in the natural structure system; (2) the observer Cartesian axes; or (3) if
clinographic viewing is on, the rotated Cartesian axes, or clinographic system. The
clinographic system does not rotate with the crystal; it is always related to the observer
system by the two rotations given above.
If clinographic viewing is not on, the clinographic and observer systems have the same
orientation, and if the natural structure system is Cartesian or cubic all three systems have
the same orientation.
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Summary of axial systems:
1) Observer Cartesian system. Reference system, fixed with respect to the display screen
or paper.
2) Natural or structure system. Fixed with respect to the atomic structure. Atom
coordinates are initially given in this system. The axes are the unit-cell edges in the case
of crystals. Axes may have unequal lengths and may be at angles of other than 90
degrees.
3) Clinographic system. Only applies when clinographic projection or viewing is on.
Axes are those of the observer Cartesian system, but rotated in a certain manner to avoid
a straight-on view of the structure.
If Perspective viewing is not selected, the drawing is a direct projection in the x axis
direction (observer system). If perspective viewing is selected, the atoms are projected
onto the y-z plane from a point on the x- axis at the specified distance in the positive
direction (toward the observer).
In ATOMS, a, b and c (or A, B and C) refer to the natural structure axes. The three axes
may sometimes have these names although it is conventional in some systems to use a1,
a2 and a3 if the axes are equal by symmetry. The letters x, y and z usually refer to the
observer Cartesian axes. If it is necessary to refer to the clinographic system, this is
mentioned explicitly. The fractional atomic coordinates are also referred to as x, y and z,
but these are usually identified explicitly.
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Dealing with Molecules, Groups and Fragments in Crystals

Atoms has capabilities to deal with several types of atomic groups, which may be roughly
separated into three classes.
1) True Molecules
It is often useful to be able to identify true molecules in crystals. A "true" molecule has
strong bonds linking all atoms within it, does not have strong bonds linking its atoms to
other molecules or groups, and is limited to a constant number of atoms, i.e. it is not a
polymer.
True molecules which are not to be combined with other structures are most easily dealt
with initially using one of the special Molecules in Crystals Boundary Options. These
boundary options will identify all molecules in the structure regardless of whether or not
they cross the formal unit-cell boundaries, and fill out a specified volume using simple
translation or crystal faces or a sphere as boundary surfaces, these boundaries being
applied to the centers of the molecules. Individual molecules can be identified with the
cursor and highlighted or hidden completely (i.e. marked as non-plotting).
Atoms within molecules can be connected to each other with bonds or with polyhedra.
Input bond specifications can be marked as inter-molecular, meaning that they will not be
used in the molecule search.
Molecules located with these boundary options cannot be deleted, translated or rotated.
Colors, etc. cannot be changed for molecules as a whole as opposed to individual input
atoms. For these reasons, and because the molecule-locating algorithm is time
consuming, it is often advantageous to use the Generated to Input conversion (Transform
Menu). In this conversion, the symmetry and lattice translations are essentially lost, but
the molecules can be optionally converted to fragments, which can then be duplicated,
translated, rotated and deleted independently. Molecules which have been marked as
non-plotting may be optionally deleted during the conversion.
2) Polymer groups
Many crystal structures have polymer units which are continuously bonded in one, two or
even three directions (lattice directions). It is often useful to be able to isolate these units,
which requires a different approach from true molecules.
Polymer groups in crystals cannot be identified in the Molecules in Crystal Boundary
options because the bonding is continuous. To deal with such groups, it is first necessary
to define boundaries for the drawing using one of the boundary options which apply to
individual atoms, not molecules. Then bonded groups can be located individuallyin
either of two ways: with the Find button in the Generated Atom Data dialog which
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comes up when you click on an atom in the display; or with the Locate Groups option in
the Transform menu. In either case the units identified are limited to the current
generated atoms, i.e. those within the current boundaries, whereas the special boundary
options in 1) above locate complete molecules regardless of the boundaries. That is to
say, in 2) groups may be truncated (which is necessary in the case of polymers) whereas
in 1) molecules always maintain their integrity.
Groups identified in this way are not permanent - the groupings disappear when the
structure is saved in a file, although if some groups have been hidden, the individual atom
numbers will be saved in the list of non-plotting atoms. Having made the desired
identification of groups, it may thus be advantageous to use the Generated to Input
conversion (Transform Menu), converting groups to fragments which are then saved in
the data (.str) file.
3) Structure fragments
ATOMS can combine portions of completely separate crystals and/or molecules (termed
fragments). This is most commonly used for epitaxy (crystal on crystal or molecule on
crystal), but can also be used for combining molecules, for example to depict chemical
reactions. These fragments can be duplicated, translated, rotated and deleted
independently.
Fragments can exist only in the Input=Generated boundary/operating mode, which is
attained only by going through the Generated to Input transformation (Transform Menu).
As explained above, molecules or polymer groups can be converted to fragments, so
fragments can represent 1) molecules, as identified with one of the Molecules in Crystal
boundary options; 2) polymer (or molecular) groups, as identified with the Find button in
the Generated Atom Data dialog (after clicking on an atom) or with the Locate Groups
option in the Transform menu; 3) completely distinct structures, obtained by reading from
files or by one of the other options in the Multiple Structures options in the Transform
menu.
---------------------It is not possible to identify groups or molecules when in the Input=Generated mode and
more than one fragment is present. However, all the atoms can be combined into one
fragment with the Consolidate option in the Locate Groups dialog (Transform Menu),
and you can then start over with identification of molecules or groups. Of course all
molecules or groups will have to be identified individually.
Molecules, groups and fragments do not have to contain more than one atom, nor do they
have to be electrically neutral. Furthermore, the atoms of fragments are not necessarily
connected by bonding. For example, in structures with cations and anion radicals, for
example CaCO3, using the Molecules in Crystal boundary options will result in each Ca
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atom, as well as each CaCO3 group, being identified as a molecule. The
Generated to Input transformation would (optionally) convert each of these molecules to
a fragment. On the other hand, if you calculate a CaCO3 crystal using one of the
boundary options for individual atoms, then identify each CO3 group (but not Ca atoms)
and finally use the Generated to Input transformation, all the Ca atoms will be grouped in
one fragment.

4.7

Deleting Atoms and Atom Labels

In ATOMS normal operating mode, there are two types of atoms, input atoms and
generated atoms. The input atoms are usually entered and removed in the the
Input Atoms dialog. The symmetry and lattice translations, if present, are used to derive
the generated atoms from the input atoms; it is the generated atoms which are actually
viewed in a drawing. There are basically two ways of removing specific generated atoms
from the drawing.
If only a few atoms are to be deleted, they can be marked as non-plotting. Clicking with
the mouse on or near the location of an atom brings up either the Generated Atom Data
dialog or the Atoms at Cursor dialog, in which selecting an atom brings up the first
dialog. Unchecking the Plot Atom box will mark the atom as non-plotting. You must
replot to actually cause the atom to be removed from the drawing. When the structure
file is closed, a list is made of the non-plotting atoms, which will be saved and used the
next time the structure is calculated. Starting with V4.0, the lists of deleted atoms and
atom labels use a code containing the unit-cell, the symmetry operator etc., rather than an
arbitrary generated-atom sequence number, so that changing the boundary conditions will
not usually make the list invalid (although some deleted atoms or labels may no longer be
within the boundaries). However, changing the symmetry will make the list invalid.
When molecules or fragments are present, the atoms in the entire group can be marked as
plotting or non-plotting.
All atoms marked as non-plotting can be restored, and a specific range of generated
atoms can be either restored or marked non-plotting, with the Atom/Bond Plot States
dialog in the Input2 menu.
If many generated atoms are to be deleted, it may be better to change to the special
Input=generated operating mode. This is done with the Generated to Input command in
the Transform menu. In this operating mode, all symmetry and boundary conditions are
removed, and generated atoms are exactly equivalent to input atoms. The individual
atoms can be removed in the Input Atoms dialog. You can click on atoms on the screen
and use the Generated Atom Data dialog to get the number, then delete them in the
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Input Atoms dialog. Or, you can mark atoms for deletion by unchecking the Plot atom
box as above, then do the Generated to Input command. This command gives you an
opportunity to delete atoms which are marked as non-plotting. It can be repeated as
many times as necessary, just for the purpose of deleting atoms in this way.
Deleting angle labels. Angle labels are automatically applied to all groups meeting the
specifications in the Angle Labels dialog (Display menu). Individual angles can be
deleted (actually, marked as non-plotting) by clicking on the three atoms in succession
(outer-central-outer) and unchecking the Angle box which appears in the
Generated Atom Data dialog.
4.8

Direct Modification of Files

If you modify any data or setup file, be sure never to use tabs.
Data Files. The files written for each structure are of the standard ASCII type. Direct
modification of these files is no longer recommended. However, occasion may arise for
repairing a damaged file, which can be done with any word- or text-processor or other
program which handles ASCII files.
SCRPTR Setup File. There are now only two types of data in the SCRPTR file which
should be modified; the dot-patterns and the SHELX commands-to-be-ignored.
There are two sets of 32 dot-patterns (fine and coarse), each consisting of 32 lines of 8
numbers each. Each number can range from 0 to 255, with a binary 1 bit representing a
black dot and 0 representing white (or color in the case of 4-bit raster files). Note that
earlier versions of ATOMS may have had either 14 (V1.0) or 16 patterns in each series.
The fine series, which is first, contains duplicate lines so that there are only 16 patterns
for shading, even if the number of shading zones is greater than 16. These patterns could
be modified to give 32 distinct shades, although it is doubtful if this would greatly
improve the quality of the image.
Patterns can also be modified to give striations, hachures or other patterns for
distinguishing unshaded atoms. For example, the sequence "1 1 1 1 1 1 1 1" will give
vertical striations, and the sequence "255 0 0 0 0 0 0 0" will give horizontal striations.
Such patterns should not be used when shading is in effect. ATOMS now has the ability
to show macrosopic hachure patterns on polyhedra and atoms, so pixel-scale patterns are
probably unnecessary.
The patterns in the SCRPTR file are only used for raster-file output, and for standard
printer output (when ATOMS patterns are selected in Windows); they are not used for
the screen.
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At the end of the SCRPTR file is a list SHELX commands of four (or fewer) characters
each, which are to be ignored by ATOMS when importing SHELX files. The list has ten
commands per line, and is preceeded by the number of commands. If you add commands,
be sure to change the number.
Although the data for the two 16-color palettes is also in the SCRPTR file, it is easiest to
modify palettes with the Main Palette and Conversion Palette dialogs in the Settings
menu, or to prepare files to be read in with these dialogs.
ELEMENTS files. These files, ELEMENTS.ION and ELEMENTS.COV supply default
types (atomic numbers by default), radii and colors for input atoms read in from an ASCII
file. See the next section for information on modification.
SCATFAC.DAT file. This file contains scattering factor data for powder and precession
diffraction. The data are by default those for neutral atoms from the International Tables
for X-Ray Crystallography (1974, Vol. 4). The ATOMS type numbers of input atoms are
keyed to the entries in this table in order of the entries (not by element name). Other
values using the same exponential form, for example different valence states, may be
substituted. The coefficients are separated by blank spaces and are not confined to
particular columns.
The first nine coefficients in each line are the X-ray scattering factor coefficients and the
last number is the neutron scattering factor or length.
By default, number 99 in this file is used for deuterium (symbol "D") and number 98 is
tritium (symbol "T"). These differ from hydrogen only in the neutron scattering factor.
The atomic type numbers, modulo 100, are used as indices to this table. For example 6,
106, 206 etc will all reference the sixth entry (carbon). Thus entries beyond 100 will be
ignored. Any special or temporary entries should generally be placed in numbers 93 to
97.
If you modify any data or setup file, be sure never to use tabs.
4.9

Drawing Crystal and Unit-cell Edges

Drawing Crystal and Unit-cell Edges and Faces
Non-3D Drawing Modes. In the Standard, Skeletal and Thermal Ellipsoid drawing
modes of atoms, all objects in the atomic structure itself, namely atoms, bond and
polyhedra, are sorted with respect to distance from the eye (perspective projection) or
height in the x -coordinate (orthogonal projection). Then the objects are drawn in order
from back to front. Instead of constructing three-dimensional objects and then projecting
onto the plane of the drawing, it is possible in many cases to use simplified two-
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dimensional objects (e.g. circle instead of sphere). When objects are actually in bonding
relationship the interpenetrations are solved analytically, but this is done only for certain
cases where the geometry is very restricted; atom-atom, bond-atom where the bond
connects that atom with another; and atom-polyhedron in the case where the atom is a
ligand of the polyhedron. For the atomic structure itself, there is no need to solve for
interpenetration of, for example, a bond with atoms which are not connected by that
bond, or a polyhedron with bonds other than those to its ligands, because such
geometries do not exist.
However, for the lines or cylinders which are used to represent the edges of the boundary
polyhedron, or the edges of the unit cell, there are no such restrictions on interpenetration
geometry; such lines or cylinders may interpenetrate with atoms, bond and polyhedra in
any way.
For pen plots and pen-plot files, which use strictly vector methods of drawing, it is not
possible to superimpose objects while drawing from back to front, and it is necessary to
solve analytically for overlay relationships as well as the same limited interpenetration
relationships mentioned in the first paragraph. However, this process is made much faster
by the process of sorting and drawing from back to front.
For these reasons, the drawing of lines representing the boundary or other crystal shape
(Crystal Forms for Display) in the Standard, Skeletal and Thermal Ellipsoid drawing
modes assumes that there is no interpenetration between these lines and atoms, bond or
polyhedra. The lines representing edges which would be hidden if the crystal shape were
opaque ("back" edges) are drawn before the structure; and the lines representing visible
edges ("front" edges) are all drawn after the structure.
Since it is normally necessary to show a volume of a crystal greater than one unit cell,
similar assumptions cannot be made for the special drawing in the Unit-Cell option in the
Input2 menu. The unit-cell edges in this option are thus all drawn after the structure.
They are intended to show the translational relationships of the structure, not to delimit
some particular volume.
These simplifications are primarily intended to cut down on plotting time; they may be
removed in the future as processors become faster.
In the Anaglyph drawing mode, which at this time only draws a skeletal view in a single
color for each eye, there is no need to sort or to solve for intersections or overlays in any
way.
3D Mode. The 3D drawing mode uses a completely different drawing method. Fully
three-dimensional objects are drawn in any order, but the height (x-coordinate in the
system used by ATOMS) of each pixel is compared with the value in a depth buffer and
the color which is already in that pixel is replaced by the color belonging to the new
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object only if the new object is closer to the eye at that point (i.e. if the new object
overlies all other objects at that point). In this drawing mode there is absolutely no
restriction on interpenetration relations - they are drawn correctly as a matter of course.
Thus unit cells are drawn in correct 3-dimensional position, not in front of the structure.
Crystal edges are also always drawn in correct position, and interpenetrations are exact.
Crystal and unit-cell faces, that is actual surfaces, may also be drawn in the 3D mode.
Usually this is most useful if the faces are transparent or translucent. However, full
transparency may not be supported by the system software and/or hardware. Absolutely
correct transparency would require drawing from back to front, and would again
encounter some of the problems discussed above for non-3D drawing modes.
4.10

ELEMENTS Files

These files provide a table of standard or default parameters for input atoms, namely
atomic display radii, type numbers and colors. The key to the elements in the table is
through the two-character symbol, normally the standard elemental symbol, which is
matched to the first two or one characters in the label for the input atom.
The radii may be used when reading in atom parameters from an ASCII file in the
Input Atoms dialog (see also Atom Parameter Files), or when importing a data file
(Import Files popup of the File menu(Startup) or File menu(Graphics)). Note that when
generating bonds automatically (Generate Bonds dialog), by default a different table of
radii is used (from the RADII file), although the atom display radii can optionally be
used.
The single ELEMENTS.DAT in early versions of ATOMS has been superceded by the
ionic and covalent equivalents, ELEMENTS.ION and ELEMENTS.COV. One or the
other of these is used, depending on the setting in the Preferences dialog in the Settings
menu, or in the dialogs for import files. The default versions of these files now contain
full ionic and covalent radii, and when importing a file or reading atomic coordinates the
radii values are multiplied by the Factor in the Preferences dialog in the Settings menu.
The first field in each line is the atomic number or other designated type number. The
second field, or SYM field, consisting of two characters in single quotes, is usually the
normal elemental symbol. The remaining fields give the default values for the rim color
and the fill color (RGB components 0-255, three numbers for each color), the rim and fill
b/w shades (one integer for each, 0-15 for white-black) and pen number. These fields
are the same as the RMC, FLC, RMP, FLP and PEN parameters as described in
Atom Parameter Files. All these fields are required, in the given order. There is a limit of
150 entries (lines) in the ELEMENTS files.
Modifying the ELEMENTS files. The ELEMENTS files may be modified with a word
processor to assign any desired default values to the parameters. It may also be necessary
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to do some editing to avoid problems in interpreting the LAB field in terms of elemental
symbols, or to change the elemental symbols from English to other language versions.
Atomic numbers or types may be duplicated; for example you can have a line with
number 53 and symbol I and also one with symbol J.
ATOMS first attempts to match the first two characters in the LAB field with twocharacter SYMBOLs in the ELEMENTS file. If no match is found, then it tries onecharacter symbols. For example, it will test the first two characters in the LAB against
CA, CD, CL, etc., and only then will it test the first character against C (or C). Thus a
carbon atom designated CALPHA would be read as calcium unless the CA line is
removed from the ELEMENTS file. The label "C-ALPH" would avoid this problem.
If you only work with a limited number of atom types, it would be best to prepare a
shortened version of the ELEMENTS file, to avoid possible conflicts and to shorten
search times.
If no match is found in the ELEMENTS file for the first two characters of a LAB field,
the values from the first entry in the file are used. Thus if you want to assign the same
default values to all atoms, regardless of the LAB field, you can put these values in a
single line and remove all others.
You can use appropriate values for the radius to set up for polyhedral or wire frame
models. For example, if all Si and O atoms in a silicate are part of silicate tetrahedra, the
radii for Si and O could be set to 0.0, which insures that the atoms which are not part of
complete polyhedra are not plotted. Likewise for wire-frame models the radii can be set
to -1.0, so that only bonds are plotted.
The Factor edit field in the Atomic Radii group in the Preferences dialog (Settings
menu) multiplies the radii. For ball-and-stick models a factor of about 0.5 is appropriate,
and for interpenetration (space-filling) models a factor considerably larger than one may
be required.. Also, you can multiply all radii by a given factor with the Atoms - Global
dialog in the Input1 menu.
Blanks in the SYMBOL field in the ELEMENTS file are ignored.
ELEMENTS.ION uses ionic radius values for the most common ionization state (rare
gases use Van der Waals radii, and minimum values of 0.05 are used for atoms which are
central atoms of radicals). The radii are mostly from the tabulation of Shannon and
Prewitt. Note that V4.0 and later of ATOMS uses full ionic radii, while previous versions
had values of 50% for the radii. ELEMENTS.COV has full values of covalent radii,
mostly from Pauling.
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File Types

ATOMS uses several different types of auxiliary files, with different extensions.
Structure data files (.str). These hold the information on individual structures. The
Open, Save and Save As commands in the File menu of the Graphics window pertain to
these files.
Internal files. These are for ATOMS internal use and should not normally be modified
by the user (but see section IV-8 of instructions for special cases). SCRPTR is the main
start-up file which saves current settings. DEFAULTS saves default display variables for
use with the New command. PPLOT contains data on pen plotters. CPATOMS.HLP
[Windows] or ATOMS HELP [Macintosh] is the help file, which is in condensed format
and not modifiable by the user. CIFDIC.SHT is the (shortened) dictionary file used when
importing CIF files.
Space-group file. The file HALL.DAT contains space-group information.
Scattering factor file. The file SCATFAC.DAT contains the X-ray scattering factor data
for neutral atoms in the exponential form as given in the International Tables, Vol. 4, for
use in the Powder and Precession diffraction options (Display menu). This file may be
modified to use other scattering factors (e.g. for ionized atoms). The scattering factors
are keyed by sequence number as read from this file to the atom type. There is a
maximum of 100 scattering factors.
Cartesian symmetry files (.sym). These contain Cartesian point-symmetry matrices
generated by the auxiliary program SYMGRP.
Palette files (.pal). These contain RGB values for two 16-color palettes which (a) form
the basis for 8-bit (256-color) palettes; and (b) are used to convert PC-DOS color
numbers to RGB values. They can be modified, read and written with the Palettes
commands in the Settings menu.
Atom parameter input files (.inp). These are files supplied by the user, containing at
least the atom labels and coordinates, and optionally other parameters. They are read in
through the Input Atoms dialog in the Input1 menu, not the Open command in the
File menu (Startup) or File menu (Graphics).
Atom parameter default file (ELEMENTS.ION or ELEMENTS.COV). This contains
default atom types, radii and colors for use when reading in atom parameters from.inp
files. It can be modified by the user to give the desired parameters. By default,
ELEMENTS.ION contains standard ionic radii and ELEMENTS.COV contains standard
covalent radii.
Radius values for bonds. The RADII file supplies values for generating input bonds. It
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also has index values for each element, which optionally may be used avoid superfluous
or impossible bonds. The values currently used are 1 for cations, -1 for anions, 0 for
"non-metals", and 3 for inert (rare gases). At the time of generating input bonds, the
values for the two candidates (input atoms) are added together, and pairs with absolute
values greater than 1 are rejected.
Imported data files. These include the following. These files types are sometimes given
arbitrary extensions, but any filename can be opened. (1) CCDC FDAT files (.fdt). (2)
SHELX refinement input files (.ins). (3) CIF - Crystallographic Information Files (.cif).
(4) DBWS/LHPM Rietveld refinement files (.dbw and.lhp). (5)
Inorganic Crystal Structure Database (ICSD) files (.ret and.cry). (6) ORTEP data files
(.ort). (7) XTLVIEW structure display files (.xtl). (8) VIBRAT motion files (.mot). (9)
Protein Data Bank files (.pdb). (10) RIETAN Rietveld files (.xyz). (11) GSAS Los
Alamos program system files (.exp). (12) American Mineralogist structure database files
(.amc). (13) FULLPROF refinement files (.pcr). (13) Free-form (.inp) files.
Text output files (.atd). These contain the input to and/or results of the ATOMS
calculations. The file infile.ATD contains output of the atom-locating calculation on the
structure file infile.STR, such as atom locations, atoms in bonds and polyhedra, bond
length and angles. INPUT.ATD lists the input data. GENATOMS.ATD lists the
Cartesian coordinates of all the generated atoms in their current orientations.
FACES.ATD lists attributes of the current boundary and/or display crystal faces.
TOTALS.ATD gives totals of various types and the current maxima for these values.
BONDS.ATD gives bonds and angles around each or all input atoms. These files may all
appear in a Text window, and are saved independently of the ATOMS structure data
files.
Graphics output files. ATOMS can write graphics output files of various types:
encapsulated PostScript files (.eps); HPGL vector files (.pgl), 3D VRML files and
---- Windows only ---raster files (.bmp,.pcx,.tif,.png); and Windows metafiles (.wmf or.emf).
---- Macintosh only ---PICT files (.pic) in either Picture (metafile) or bitmap format and.png raster files.
---- End Windows/Mac only ---File Locations
ATOMS expects to find certain files in the "home" directory, which is the directory
containing the ATOMS program file (CPATOMS.EXE for Windows). These files are
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SCRPTR, DEFAULTS, PPLOT, SPCGRP.DAT, CPATOMS.HLP, ELEMENTS,
HALL.DAT, CIFDIC.SHT, RADII, SCATFAC.DAT and palette (.PAL) files.
If you are using Cartesian symmetry files (.sym), they should be in the same directory
("data" directory) as the structure file. The data directory is reset whenever you read or
write a structure file (.str). Most output files, including EPS, raster, HPGL, metafiles and
calculation output files (infile.atd), will be written to the data directory. However, the
data files (.atd) from the List... options in the File menu are written to the home
directory, to avoid cluttering the disks. To save these files permanently, use Save As to
give them new names in the directory of your choice.
When reading files, the extensions are not mandatory, and you can always use a different
extension when saving a file, or specify "all files" when browsing or searching for a file.
---- Macintosh only ---File and Creator Types
Most output and data text files have file creator 'ATOM' and file type 'TEXT'. The main
ATOMS data files (.STR) have file type 'ATDT', to prevent accidental damage by editing
with a word processor. However, you can can change the file type to 'TEXT' with a
utility program if necessary. Only files with creator 'ATOM' and extension.STR will be
opened as data files by ATOMS when they are double-clicked.
Files from previous versions of ATOMS may have different creator and file types.
---- End Macintosh only ---4.12

Frames

With printed and pen-plot output, you have a choice of using the full page, or confining
the output to a frame. For Raster Files and Metafiles or PICT files (File menu) output
always goes to a frame.
If you are using the Universal or Maximize Each View scale modes (Scaling dialog in
the Input2 menu), the image is scaled to fit in the frame. If you are using the Fixed scale
mode, the image is clipped to the frame.
In printed and pen-plot output, the frame can be positioned on the page; the offset gives
the displacement of the upper left corner of the frame from the upper left corner of the
page.
In some cases, you can choose the units for the size and offset of the window; either
inches, centimeters or dots (pixels), and you may also be able to specify the nominal dots
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per inch or centimeter. The units setting is independent of the overall choice of inches or
centimeters in the Preferences dialog in the Settings menu.
4.13

Lighting Equation

In the 3D drawing mode the material properties of objects determine the way the objects
interact with the light sources. The color observed at a given point is a resultant of the
light source(s) (3D Lighting) and the Material properties; that is, the RGB coefficients of
the Ambient, Diffuse and Specular components of the light source(s) are multiplied by
the specified colors of the objects, and by the material coefficients in this dialog, then the
results are limited to the range 0.0-1.0.
Itotal = Ke C
+ Ia Ka C
+ Sum(i) [ ( NdotVi ) Ii Kd C ]
+ Sum(i) [ ( NdotSi )^ns Ii Ks ]

;emissive
;ambient
;diffuse
;specular

Where
Itotal is the total intensity as an RGB triplet at any point on an object;
Ia is the intensity (RGB triplet) of the ambient light source (3D Lighting dialog);
Ii is the incident intensity (RGB triplet) at the object of directional or positional light
source i (3D Lighting dialog);
C is the assigned color (RGB triplet) of the object (Input Atoms, Bonds, Polyhedra
dialogs);
Ke is the emissive material coefficient of the object (3D Material Properties dialog);
Ka is the ambient material coefficient of the object (3D Material Properties dialog);
Ks is the specular material coefficient of the object (3D Material Properties dialog);
ns is the specular exponent or shininess coefficient of the object (3D Material Properties
dialog);
N (a vector) is the normal to the surface at the point in question;
Vi (a vector) is the direction of the incident directional or positional light i at the point;
S (a vector) is the bisector of the angle between the light-surface vector (or Vi) and the
eye-surface vector;
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"dot" signifies the vector dot product.
The incident intensity from a light source is itself subject to attenuation (3D Lighting
dialog);
Ii = Ii(0) / (Kc + Kl d + Kq d^2 )
Where d is the distance of the point in question from the (positional) light and Kc, Kl and
Kq are the constant, linear and quadratic attenuation coefficents respectively. Constant
attenuation is essentially a brightness coefficient. Values larger than 1.0 simply darken
the scene. Values smaller than 1.0 may add a white component and/or increase the
specular contribution. Linear and quadratic attenuation apply only to Positional lights.
Ambient light has no direction or origin and is considered to bathe all objects uniformly.
Having a significant ambient component causes non-illuminated parts of objects to be
other than black. It thus "softens" the illumination in a somewhat similar way to the
Darkest Shade and Darkness Angle parameters (Shading dialog) in the Standard
display mode.
Diffuse color is usually the main component of the appearance of objects. The intensity
of the color is dependent on the angle between the light ray and the normal to the surface
in question.
Specular reflection only occurs when the normal to the surface in question is close to
bisecting the angle between the incident light and the vector from the point on the surface
to the eye. It produces bright highlights on a curved surface. The larger the Specular
material coefficient, the smaller will be the bright specular highlight on a curved surface.
The shininess coefficient has a maximum of 128 because of computational restrictions,
but values on the order of 5-30 are usually realistic. In ATOMS, specular reflection is
always white, that is it does not depend on the color of the object, only the color of the
light source(s). For directional lights, specular reflection may not work well for polyhedra
because faces at certain angles will give a solid white appearance.
Emission is similar to ambient, except that there is no dependence on the color of any
light source. A high value of emission makes an object look like is is glowing.
This equation ignores translucency, which causes colors objects lying at different depths
to be blended.
4.14

Space- and Point-Group Orientation

Proper generation of atoms by symmetry requires that atom coordinates be consistent
with the orientation of symmetry elements. That is, the people who publish or otherwise
report atom coordinates have to assume a particular geometric relationship between the
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symmetry elements and the coordinate axes in terms of which the atomic positions are
given. In some point and space groups there is only one reasonable choice for the mutual
orientation of coordinate axes and symmetry, but in some groups there may be two or
more possibilities and ambiguity may arise.
Crystals. The preferred symmetry option for crystals is normally Space-group, which
reads the symmetry operations from a selection of those in the Tables. The main part of
the Tables themselves (section 4.3 of Volume I, pre-1983 or Chapter 6 of Volume A,
post-1983) lists only some of the possible orientations of space-group symmetry for
monoclinic and orthorhombic crystals, but the alternate orientations can be generated by
ATOMS, as described in the detailed instructions for the Space-group option. The
alternate settings are listed in Table 6.2.1 of Volume 1 or Table 4.3.1 of Volume A of the
Tables.
A consistent orientation of symmetry elements with respect to axes is not always used for
space groups in the International Tables for X-ray Crystallography. As an example of
alternate orientations, consider the point group C3v. The two simplest orientations for
the vertical mirror planes are either parallel to the a1 and a2 axes, or in between, rotated
30 degrees. These two orientations are embodied in the two space groups P31m-C 3v2
(no. 157) and P3m-C3v1 (no. 156). If the same orientation were used for both, one of
them would have a C-centered Bravais lattice, the avoidance of which the compilers of
the Tables apparently considered more important than consistent axial orientation.
It is important to realize that these different possibilities exist, especially when using face
or form indices from textbooks or the literature; it may be necessary to transform the
indices to conform with the orientation used in the structure description.
Molecules. Using the Point Group symmetry option, which derives the symmetry
operations from space-group listings in the Tables, unavoidably makes certain
assumptions about orientation. In monoclinic symmetry (point groups 2-C2, m-Cs, and
2/m-C2h) the unique axis is taken to be parallel to c or z, rather than b or y (as in
crystals). In the orthorhombic point group mm2-C2v the two-fold axis is assumed to be
parallel to c. If the atomic coordinates for the molecule are given in terms of a nonstandard setting, an alternate to manual rotation of the coordinates before input is to use
the Space-group option, specifying a space group in the point group of interest which has
the alternate orientation. Some examples of alternate settings related by 30 and 45 degree
rotations on the c axis are given in the section on the Space-group option.
4.15

Special Considerations for Molecules and Polymers

While ATOMS can deal equally as well with molecules as crystals, the input contains
some options which are extraneous for molecules. The following sections give some
guidelines for dealing with molecules and polymers. This is intended only for molecules
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which are input as single entities with absolute coordinates, not for molecules which are
part of a crystal structure, which can be isolated with the Locate Groups command
(Transform menu), the Find button in the Generated Atom Data dialog, or the special
boundary options for molecules in crystals..
1. Coordinate Axes for Molecules.
The type of axial system specified in the Title/Axes dialog (Input1 menu) may depend on
the symmetry of the molecule. Except for cases in which one 3-fold or 6-fold axis is
present, i.e. trigonal or hexagonal symmetry, there is no reason not to use Cartesian
reference axes. The symmetry may then be specified using the Point-group symmetry
option if the molecule is in a standard orientation, or the Space-group or Custom options
if it is not. All these options use symmetry operations which are of the type used for
crystals.
However, if a molecule has either a 3-fold or a 6-fold axis the full symmetry can be
specified by means of crystallographic symmetry operations only if hexagonal structure
axes are used. Both trigonal and hexagonal crystal systems by default use "hexagonal
axes'', that is a1 and a2 axes at right angles to the c axis, and 120 degrees from one
another. Trigonal crystals may also use rhombohedral axes, which are not applicable to
molecules. Cartesian coordinates may be transformed to hexagonal coordinates, and viceversa, with the following sets of equations (angles in degrees).
xh
yh
xc
yc

=
=
=
=

(1/a) xc sin120 + (1/a) y c cos120
(1/a) xc cos120 + (1/a) y c
(a) xh sin120
(a) xh cos120 + (a) yh

where a is the length of the hexagonal a axes (or ratio of lengths hexagonal over
Cartesian if the Cartesian axes are not of length one). These equations assume that the
two c or z axes are parallel and that the a2, b or y axes are parallel.
The alternative is to use Cartesian axes and select the Cartesian symmetry option: this
requires the preexistence of a file containing the symmetry matrices; see section IV-8.
With this option the symmetry elements may have any desired orientation with respect to
the coordinate axes.
2. Boundary Options for Molecules and Polymers.
For an isolated molecule, the boundary option will normally be No boundaries — this
simply accepts all atoms in the original input and those generated by point-group
symmetry — no translations (lattice vectors) are applied. Again, if you want to locate a
molecule in a crystal structure, see the Locate Groups command in the Transform menu,
the Find button in the Generated Atom Data dialog, or the special boundary options for
molecules in crystals.
For a polymer, there are two possible choices. The simplest is to use the Translation
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Limits option. This takes all the atoms in the central cell and those generated by
translation within the given limits in the directions of the selected lattice vectors (axes).
For a one-dimensional (chain) polymer, two of the translations should be disabled and for
a two-dimensional (sheet) polymer, three should be disabled. This is certainly the best
choice for a one-dimensional polymer.
The other choice is to use the Enter Forms option, and manually disable one or two
lattice translations. This allows for showing different parts of two-dimensional polymers.
For example, consider a trigonal or hexagonal sheet; the Translation Limits option
allows for showing only a rhombic slice of the sheet. Suppose that the polymer extends in
the a and b (x and y) directions; then it can be limited by vertical faces such as (100),
(010), etc. to give a slice with hexagonal or trigonal symmetry. Translation in the c (z)
axis direction should be disabled.
The above choices again assume that the input is actually for a molecule, and not a
crystal. For viewing molecules in crystals, the procedure is different. First, you can
import several types of crystallographic files for structures containing molecules using the
Isolate Molecules in Crystal boundary option (Input1 menu). The FreeForm (.inp) import option can be used to read in almost any type of atomic-coordinate
information. You can also use the Locate Groups option in the Transform menu to
isolate individual molecules or polymers.
3. Symmetry for Molecules and Polymers.
Symmetry of molecules is normally described in terms of point groups. The point group
symmetry can be provided as crystallographic symmetry operations, or in the form of
Cartesian symmetry matrices.
3.1. Crystallographic symmetry operations.
ATOMS can automatically provide the symmetry for the 32 point groups which are also
crystal classes, i.e. contain no non-crystallographic symmetry elements such as 5-fold
axes. Provided that the orientation of the symmetry elements with respect to the
coordinate axes is standard, it is only necessary to give the Schoenflies or International
(Hermann-Maughin) symbol for the point group in the Point-group symmetry option.
Certain alternate orientations, related to the "standard'' ones by a rotation of 45 or 30
degrees on the c or z axis, can be attained by using the Space-group symmetry option. If
the orientation is not attainable by either of these methods, appropriate symmetry
operations can be entered with the Custom symmetry option.
There is no provision in ATOMS for strictly one-dimensional, two-dimensional or spiral
symmetry elements, such as might occur in polymers. Nevertheless, most if not all of the
symmetry in polymers may be included with judicious use of space groups, combined
with disabling of repetition by translation in one or two dimensions. The space groups
which are applicable are those which have no screw axes or glide planes with translation
in a non-polymer direction. For example, an ideal silicate chain polymer is completely
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described by space group no. 28 Pma2-C2v4, with the chain running in the a (x) direction
and the translations in the b and c directions disabled.
3.2 Cartesian Symmetry Matrices.
This symmetry option is necessary for non-crystallographic point symmetry, that is
symmetry groups containing n-fold axes with n equal to 5 or higher than 6. It can also be
used for trigonal and hexagonal symmetry if you want to use Cartesian atomic
coordinates. Some symmetry files are provided, namely for the two icosahedral groups
and the pentagonal groups; in other cases the Cartesian matrices must be generated
before running ATOMS, by using the program SYMGRP, which generates self-consistent
point symmetry groups in any orientation.
4.16

Standard PostScript Typefaces

Standard PostScript Typefaces (Font Families)
The names of the fonts should be entered exactly as given, with no embedded spaces. If
your printer does not recognize a font string, it will probably default to Courier.
Times Roman Family
Standard:
Slanted:
Bold:
Bold Slanted:

Times-Roman
Times-Italic
Times-Bold
Times-BoldItalic

Helvetica (Swiss) Family
Standard:
Slanted:
Bold:
Bold Slanted:

Helvetica
Helvetica-Oblique
Helvetica-Bold
Helvetica-BoldOblique

Courier Family
Standard:
Slanted:
Bold:
Bold Slanted:
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Starting ATOMS - Command-Line Processing

Starting ATOMS from DOS command line with data file or import file
---- Windows only ---ATOMS for Windows can be started from the DOS command line, or other situations
where command lines are used. If the name of an ATOMS data file (extension.STR) or
an import file is also given, this file will be read in. For example
WXATOMS MYFILE.STR
will start ATOMS and open the ATOMS data file MYFILE.STR.
WXATOMS MYFILE.INS
will import the SHELX input file MYFILE.INS.
ATOMS distinguishes among the different kinds of files by using the file extension (the
last three characters in the name, following the dot). It tests first for the ATOMS data
file extension.STR, then tests for the extensions for the import file types in the order in
which the file types are listed in the File/Import menu (with one exception). The default
extensions are as follows:
.INP
.FDT
.INS
.CIF
.DBW
.LHP
.RET
.CRY
.CRY
.XTL
.PDB
.XYZ
.EXP
.AMC
.PCR
.MOT

Free-form Input
CCDC FDAT file
SHELX input file
CIF Crystallograpic Information File
DBWS Rietveld file
LHPM Rietveld file
ICSD RETRIEVE file
ICSD CAN/SND file
ICSD Original CRYSTIN file (must be changed; see below)
Xtlview file
Protein Data Base file
RIETAN Rietveld file
GSAS (Los Alamos) Rietveld file
American Mineralogist structure database
FULLPROF refinement file
VIBRATZ atomic motion file

In order to read Original CRYSTIN ICSD files with the command line, the.CRY
extension (or that of CAN/SND files) must be changed within ATOMS, as both file types
normally use the same extension.
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The extensions, which should always be three characters, can be changed in the dialogs
for the individual file types, accessed through the Import item in the File menu (Startup)
or File menu (Graphics). The options for importing are also set in these dialogs. Thus to
set the file extension and other options, start up ATOMS in Windows and select
File/Import and the file type of interest. The extension and options will be saved if you
click OK in these dialogs – it is not necessary to actually read a file (that is, you can click
Cancel in the File Open dialog).
Note that you must give sufficient information about the PATH so that the ATOMS
program file (CPATOMS.EXE) and the data file to be read can be located. If this
information in not in the current DOS PATH, and the files are not both in the current
directory, path information must be given in the names. For example:
C:\ATOMS60\WXATOMS.EXE

5

C:\ATOMS60\SAMPLES\DDRANE.STR

Tutorials
In addition to the examples selected for tutorials, the subfolder SAMPLES contains some other
examples. All example files have the suffix.STR; check the file EXAMPLES.DOC for comments
on the examples, including the tutorials.
To start any of the tutorials elect the New command from the File menu. This will step through
most of the dialogs in the Input1 menu and also the Input2 menu if desired. Input for each of
these dialogs is discussed below. After each of these main dialogs has been completed by clicking
on the OK button, the Enter New Data Set dialog comes up. This gives you the choice to
Continue, Abort or Revise the last category of input. This dialog will not be mentioned again,
but keep in mind that it comes up after each of the main dialogs described below.
In the input for atoms, polyhedra, bonds etc., there are edit boxes for the pen number. Pen
numbers will not be discussed, since for multi-pen plotters the color depends on which pens are
placed in each position in the holder.
Note that when you are editing individual entries in the Input Atoms, Polyhedra or Bonds dialog,
you can continue to edit items in the list with the Revise button; input of these lists is finished
when you click on OK. When in the Atom Data, Polyhedron Data or Bond Data dialogs which
are called up by the Revise or Add buttons, you can step through the list forwards or backwards
with the Next and Last buttons. When you are editing the last item in each list, the Next button
becomes the New button. The same things hold true for editing boundary or display forms.
You can get Help for any dialog with the Help button.
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Tutorial 1 - Glutaric Acid

This illustrates basic atom and bond input and interpenetrating atoms (space-filling
representation). The coordinates and radii were improvised from an illustration in a magazine ad,
and are not absolutely realistic.
Dialog - Title/Structure Axes. In the Title field, enter "Glutaric Acid". In the Structure axes
combo box, select "unit Cartesian".
Dialog - Symmetry Option. Select Point group from Table.
Sub-Dialog - Symmetry - Point Group from Table. Select the group mm2 - C2v.
Dialog - Boundary Option. Select No Boundaries (molecule). This brings up a dialog which
simply confirms the choice
Dialog - Crystal Forms for Display. In the Display forms group of radio buttons, select None.
Dialog - Input Atoms. Click on the Add Atoms button.
Sub-Dialog - Revise Atom. We will first enter three carbon atoms. For all these atoms, the Type
will be 6 (the atomic number) and the Radius will 0.75. The colors can be selected as desired;
however black (RGB components 0, 0, 0) is recommended for rims, and dark gray (85, 85, 85) for
fills. These colors can be selected by filling in the RBG fields directly, or by clicking on the
Select...Color buttons, and choosing from the 16 colors presented there. For Black-and-white
pattern numbers, 15 is recommendedfor rims and 2 for fills. All these fields can be entered
once, and they will be copied to the next atom.
The fields which will change between atoms are the Label, and the coordinates (x, y and z). For
the first atom, fill in the fields from the values given for atom number 1 below. Then, if you have
filled in the remainder of the fields as described in the previous paragraph, click on the New
button. For the second atom, all the fields will be the same; replace the values for Label, x, y and
z for atom 2) below. In like manner continue on to the third carbon atom. Note that these are
absolute coordinates, in Angstroms.
Carbon atoms:
1)
C1
0.0
2)
C2
0.0
3)
C3
0.0

0.0
0.943
1.886

0.0
0.333
0.0

Next come three hydrogen atoms. Click on New after the last carbon atom. Set the Type to 1,
and the Radius to 0.4. The rim color and patterns can be left as black, but the fill color and
pattern should be changed, for example to green (0, 255, 0) and 8. Again, for each new atom you
can change only the Label and coordinates x, y and z to the values given below.
Hydrogen atoms:
4)
H1
0.52

0.0

-0.233
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5)
6)

H2
H3

0.52
0.0

0.943
2.4
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0.566
-1.1

Next come two oxygen atoms. Set the Type to 8, and the Radius to.75. The fill color and pattern
can be changed to red (255, 0, 0) and 5.
Oxygen atoms:
7)
O1
0.0
8)
O2
0.0

2.794
1.794

0.419
-0.996

When finished with atom 8), click on OK.
Back in the Input Atoms dialog, check the list. If there are any mistakes, you can correct them
by selecting the atom and clicking on the Revise button.
Dialog - Polyhedra. No polyhedra will be used, so just click on OK.
Dialog - Bonds. Click on the Add Bonds button.
Sub-Dialog - Bond Data. We will add four bonds. Since the atoms will be interpenetrating, the
bond radius, colors and patterns will not be used, and there is no need to set these fields. The Min
distance field can be set to 0.4 or any small number, and the Max. distance field can be set to
1.2. Set the fields listed below, clicking on New to go from bond 1) to 2) and so on.

1)
2)
3)
4)

Atom type 1
6
6
6
8

Atom type 2
6
8
1
1

(C-C)
(C-O)
(C-H)
(O-H)

Back in the Bonds dialog, correct any mistaken entries. Click on OK when done.
Dialog - End of Mandatory Input. At this point you have the choice of continuing with the
dialogs in the Input2 menu, or accepting default values for the parameters in those dialogs. If a
structure file was in memory when you started the New input, you can also accept the parameters
used in that structure (the current values). Let us continue, to insure that the result is the same as
the sample file GLUT.STR.
Dialog - Crystal Edges. A crystal shape is inappropriate for this molecule, so select Atoms only
from the Display group.
Dialog - Perspective Viewing. Do not check the box; perspective viewing adds little to this
molecule.
Dialog - Stereopairs. You can check the Stereopairs on box if you like, although you may need
a special viewer to see the screen image in 3D.
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Dialog - Rims. Check all the boxes. Unshaded color drawings and all black-and-white drawings
look best with rims, and shaded drawings in color usually look better without rims.
Dialog - Line Widths. Click on the Set All to 0 button - this will result in widths of one dot in
screen display and raster output. Be sure that the Use Individual check boxes are off.
Dialog - Shading. Uncheck the boxes Shading for atoms, Shading for bonds and Shading for
polyhedra. You can switch later to shading.
Dialog - Background Color. A light or medium gray, such as (170, 170, 170) usually works
best on the screen.
Dialog - Axes/Unit Cell. In the Display group, select Neither.
Dialog - Thermal Ellipsoid Parameters. Click on Cancel to skip this dialog.
Dialog - Initial Orientation. Set the Initial Cartesian rotations (x, y and z) all to zero. Check
the Clinographic viewing box.
Dialog - Scaling. Set the Scale mode to Maximize size for each view.
Dialog - Centering/Displacement. Select Automatic Centering.
Dialog - Calculation Output. In the combo box Output, select "No Output".
After the last dialog has been completed, you are asked if you want to save the file. Then a
message box appears saying "New input completed - calculate now?". Click on Yes, and the
drawing should appear quickly.
You can compare the results of this input process with the file GLUT.STR in the SAMPLES
subfolder. If there are differences, you can print out the input parameters in either or both files
with the List Input command in the File menu (Listings sub-menu).
You can experiment with shading, using the Shading dialog in the Input2 menu. The shaded
drawing will look better if atom rims are turned off in the Rims dialog in the Input2 menu. Note,
however, that if you are using a 256-color display adapter, and if you use 32 shading zones, the
carbon atoms become solid black. As explained in section IV-2, the second 8 colors in the 16color palette are not valid for 32 shading zones. You can use the Atoms - Global dialog in the
Input1 menu to change the fill color for all type 6 atoms to one of the colors in the upper half of
the Choose Color dialog.

5.2

Tutorial 2 - Diopside

This is a typical silicate crystal. Unless the unit cell is very small, ball-and-stick display is too
complicated for most silicates, and showing the SiO 4 groups as polyhedra is usually more
satisfactory. The atomic radii used for Mg and Ca are approximately half the ionic radii, which
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works fairly well as a general practice.
Select the New command from the File menu. See the start of the Tutorials section for general
comments.
Dialog - Title/Structure Axes. In the Title field, enter "Diopside". In the Structure axes combo
box, select "monoclinic". For the a, b and c axes, enter 9.746, 8.899 and 5.251, and for beta enter
105.63.
Dialog - Symmetry Option. Select Space group from Table.
Sub-Dialog - Symmetry - Space Group from Table. Enter "C2/c" in the H-M Symbol field,
and make sure that the radio button for this option is checked. Or, you can select this space group
in the list box, clicking on the Select button, and it makes no difference which option (H-M, Hall
or Number) is selected.
Dialog - Boundary Option. Select Enter Forms.
Sub-Dialog - Boundary - Enter Forms. Set the Symmetry for boundary forms to Center only.
At the bottom of the dialog, Use individual atom distances should be unchecked and all the
Lattice translation boxes should be checked. Now click on the Add Forms button.
Sub-Sub-Dialog - Add/Revise Form. For each form, enter the indices shown below in the h, k
and l edit boxes, and the distance in the Central distance box. When finished with each, click on
the New Form button to go to the next. When done, click on OK.

1)
2)
3)

h
1
0
0

k
0
1
0

l
0
0
1

distance
4.0
7.0
11.0

Back in the Boundary - Enter Forms dialog, check the list and correct the entries if necessary
with the Revise button. When done, click on OK.
Dialog - Crystal Forms for Display. In the Display forms group of radio buttons, select Same
as boundary.
Dialog - Input Atoms. Click on the Add Atoms button.
Sub-Dialog - Revise Atom.
Atom 1) is silicon. The Label should be Si, the Type should be 14 (the atomic number) and the
Radius 0.15 - silicon atoms will not appear by themselves unless skeletal or transparent polyhedra
are selected for the 3D display mode. The colors and pattern numbers can be ignored for this
reason. The x, y and z coordinates are 0.2862, 0.0933, and 0.2293. When done, click on the
New button.
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Atom 2) is magnesium - Mg and Ca atoms will be shown as spheres. The Label should be Mg,
the Type should be 12 (the atomic number) and the Radius 0.36. The x, y and z coordinates are
0.0, 0.9082 and 0.25. The colors can be selected as desired; however black (RGB components 0,
0, 0) is recommended for rims, and red (255, 0, 0) for the fill. For Black-and-white pattern
numbers, 15 is recommendedfor rims and 6 for fills. When done, click on the New button.
Atom 3) is calcium. The Label should be Ca, the Type should be 20 (the atomic number) and the
Radius 0.56. The x, y and z coordinates are 0.0, 0.3015 and 0.25. The colors can be selected as
desired; however black (RGB components 0, 0, 0) is recommendedfor rims, and blue (0, 0, 255)
for the fill. For Black-and-white pattern numbers, 15 is recommendedfor rims and 4 for fills.
When done, click on the New button.
Now enter three oxygen atoms. For all these atoms, the Type will be 8 (the atomic number) and
the Radius will be 0.0 - oxygen atoms only appear as corners of polyhedra, and if they are to be
shown as spheres they can be given a uniform radius. The rim color can be black and the fill
color cyan (0, 255, 255). For Black-and-white pattern numbers, 15 is recommendedfor rims
and 1 for fills.
The fields which will change between atoms are the Label, and the coordinates (x, y and z). For
the first atom, fill in the fields from the values given for atom number 1 below. Then, if you have
filled in the remainder of the fields as described in the previous paragraph, click on the New
button. For the second atom, all the fields will be the same; replace the values for Label, x, y and
z for atom 2) below. In like manner continue on to the third carbon atom.
Oxygen atoms:
4)
O1
0.1156 0.0873 0.1422
5)
O2
0.3611 0.25
0.3180
6)
O3
0.3503 0.0176 -0.0047
When finished with atom 6), click on OK.
Back in the Input Atoms dialog, check the list. If there are any mistakes, you can correct them
by selecting the atom and clicking on the Revise button.
Dialog - Polyhedra. Click on Add Polyhedra.
Dialog - Polyhedron Data. The only polyhedron will be the silicate tetrahedron, although is is
also possible to do Mg octahedra. The Coordination number is four, the Maximum bond
distance can be 1.8, the Central type (Si) is 14 and there is only one Ligand type, 8 for oxygen;
put the number eight in the first Ligand type box and be sure the other 6 boxes are empty. The
rim color should be black, and the fill color can be yellow (255, 255, 0). Rim pattern should be
15 (black) and fill pattern can be 2. Click on OK when finished.
Back in the Polyhedra dialog, in the Show ligands as spheres group, select the Use single
radius radio button, with radius 0.2.
Click on OK if the single polyhedron entry is correct.
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Dialog - Bonds. Click on the Add Bonds button.
Sub-Dialog - Bond Data. We will add two bonds. The Atom types, Max. distance and rim
color are given below. The Radius should be set to 0.0 for single-line bonds, which will use the
rim color and pattern number - the fill color and pattern are ignored. Rim pattern number should
be 15. The Min distance field can be set to 0.4 or any small number.
For bond 1), Mg-0, the two types are 12 and 8; the maximum distance is 2.3; and rim color can be
blue (0, 0, 255). After entering the values for bond 1), click on New to go to 2). For bond 2), Ca0, the two types are 20 and 8; the maximum distance is 3.0; and rim color can be magenta (255, 0,
255). Click on OK when finished with bond 2)
Back in the Bonds dialog, correct any mistaken entries. Click on OK when done.
Dialog - End of Mandatory Input. At this point you have the choice of continuing with the
dialogs in the Input2 menu, or accepting default values for the parameters in those dialogs. If a
structure file was in memory when you started the New input, you can also accept the parameters
used in that structure (the current values). Let us continue, to insure that the result is the same as
the sample file DIOPSIDE.STR.
Dialog - Crystal Edges. You can select either Both or Atoms only from the Display group. Set
the dash length to 0.2 and the dash ratio to 0.45. colors can be yellow (255,255,0) for front edges
and blue (0,0,255) for back edges. Pattern numbers for both front and back edges should be 15.
Dialog - Perspective Viewing. Check the box and set the Perspective distance to 50.0.
Dialog - Stereopairs. You can check the box if you like, although you may need a special viewer
to see the screen image in 3D.
Dialog - Rims. Check all the boxes. Unshaded drawings look best with rims, and shaded
drawings in color usually look better without rims.
Dialog - Line Widths. Click on the Set All to 0 button - this will result in widths of one dot in
screen display and raster output. Be sure that the Use Individual check boxes are off.
Dialog - Shading. Uncheck the boxes Shading for atoms, Shading for bonds and Shading for
polyhedra. You can switch later to shading.
Dialog - Background Color. A light or medium gray, such as (170, 170, 170) usually works
best on the screen.
Dialog - Axes/Unit Cell. In the Display group, select Neither.
Dialog - Thermal Ellipsoid Parameters. Click on Cancel to skip this dialog.
Dialog - Initial Orientation. We want to look almost directly down the c axis, so set the Initial
Cartesian rotations (x, y and z) to 0.0, 92.5 and 0.0. Uncheck the Clinographic viewing box.
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Dialog - Scaling. Set the Scale mode to Maximize size for each view.
Dialog - Centering/Displacement. Select Automatic Centering.
Dialog - Calculation Output. In the Output combo box, select "No Output".
After the last dialog has been completed, a message box appears saying "New input completed calculate now?". Click on Yes, and the drawing should appear quickly.
You can compare the results of this input process with the file DIOPSIDE.STR in the \SAMPLES
subdirectory. If there are differences, you can print out the input parameters in either or both files
with the List Input command in the File menu (Listings sub-menu).

5.3

Tutorial 3 - Dodecahedrane

This is a hypothetical cyclic saturated hydrocarbon molecule with carbon atoms at the 20 corners
of a pentagonal dodecahedron (Icosahedral symmetry, group I), and one hydrogen bonded to each
carbon. It illustrates the input of non-crystallographic symmetry using.SYM files, and the use of
stick bonds. This drawing will also be done with shading and perspective viewing. See
SYMGRP for the generation of the I.SYM file, which in this case is present in both the
SAMPLES and the SYMGRP subfolders. Since the Cartesian symmetry file must be in the same
directory as the data file, be sure you are in one of these two directories, or move the I.SYM file to
the directory you are in. You can switch ATOMS to the SAMPLES subfolder by reading in a file
from there. You can also go through the New input until you reach the message box "New input
completed - calculate now?". If you click on No, you can use Save As in the File menu to save
the current file to the SAMPLES subfolder. Then select Calculate from the File menu.
Select the New command from the File menu. See the start of the Tutorials section for general
comments.
Dialog - Title/Structure Axes. In the Title field, enter "Dodecahedrane". In the Structure axes
combo box, select "unit Cartesian".
Dialog - Symmetry Option. Select Cartesian Matrices.
Sub-Dialog - Symmetry - Cartesian Matrices. In the File name box, enter I.SYM.
Dialog - Boundary Option. Select No Boundaries (molecule). This brings up a dialog which
simply confirms the choice
Dialog - Crystal Forms for Display. In the Display group of radio buttons, select None.
Dialog - Input Atoms. Click on the Add Atoms button.
Sub-Dialog - Revise Atom. We will enter only one carbon atom. The Type should be 6 (the
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atomic number) and the Radius 0.35. The x, y and z coordinates are 0.0, 0.0 and 1.4. The colors
can be selected as desired; however black (0, 0, 0) is recommended for rims, and magenta (255, 0,
255) for fills. For Black-and-white pattern numbers, 15 is recommendedfor rims and 2 for
fills. The Pen number can be 1, or if you will not be using a pen plotter, just ignore this field.
Click on the New button to enter the hydrogen atom. Set the Type to 1, and the Radius to 0.2.
The x, y and z coordinates are 0.0, 0.0 and 2.2. The rim color and patterns can be left as black,
but the fill color and pattern should be changed, for example to cyan (0, 255, 255) and 4. The
Label should be "H" and the x, y and z coordinates 0.0, 0.0 and 2.2.
Back in the Input Atoms dialog, check the list. If there are any mistakes, you can correct them
by selecting the atom and clicking on the Revise button.
Dialog - Polyhedra. No polyhedra will be used, so just click on OK.
Dialog - Bonds. Click on the Add Bonds button.
Sub-Dialog - Bond Data. We will add 2 bonds. For C-C bonds, both Atom type 1 and Atom
type 2 are 6. The Min. distance field can be set to 0.4 or any small number, and the Max.
distance field can be set to 1.4. Set the Radius to 0.1. The rim color should be black and the rim
pattern number 15. Fill color and pattern can be selected to taste, for example red (255, 0, 0) and
6.
For C-H bonds, Atom type 1 is 6 and Atom type 2 is 1. The Min. Distance field can be set to
0.4 or any small number, and the Max. Distance field can be set to 1.0. Set the Radius to 0.06.
The rim color should be black and the rim pattern number 15. File color and pattern can be
selected to taste, for example blue (0, 0, 255) and 6.
Back in the Bonds dialog, correct any mistaken entries. Click on OK when done.
Dialog - End of Mandatory Input. At this point you have the choice of continuing with the
dialogs in the Input2 menu, or accepting default values for the parameters in those dialogs. If a
structure file was in memory when you started the New input, you can also accept the parameters
used in that structure (the current values). Let us continue, to insure that the result is the same as
the sample file DDRANE.STR.
Dialog - Crystal Edges. Select Atoms only from the Display group.
Dialog - Perspective Viewing. Check the box; and set the perspective distance to 7.5.
Dialog - Stereopairs. You can check the box if you like, although you may need a special viewer
to see the screen image in 3D.
Dialog - Rims. Uncheck all the boxes. Shaded drawings in color usually look better without
rims.
Dialog - Line Widths. Click on the Set All to 0 button, although rims will not be used. Be sure
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that the Use Individual check boxes are off.
Dialog - Shading. Check the boxes Shading for atoms and Shading for bonds. Set the Number
of zones to 32. The Illumination vector can be 3.0, -1.0, 1.0 (this vector will be normalized to
length one after leaving the dialog). Set the Darkest shade to 0.0 and the Darkness angle to 110.
You can check Front-back fading if desired, and set the Fading factor to 0.15. This factor
should be smaller than the Factor for complete fading shown at the bottom of the dialog;
however, this factor is not computed until the structure is calculated.
Dialog - Background Color. A light or medium gray, such as (170, 170, 170) usually works
best on the screen.
Dialog - Axes/Unit Cell. In the Display group, select Neither.
Dialog - Thermal Ellipsoid Parameters. Click on Cancel to skip this dialog.
Dialog - Initial Orientation. Set the Initial Cartesian rotations (x, y and z) all to zero. Check
the Clinographic viewing box.
Dialog - Scaling. Set the Scale mode to Maximize size for each view.
Dialog - Centering/Displacement. Select Automatic Centering.
Dialog - Calculation Output. In the combo box Output, select "No Output".
After the last dialog has been completed, a message box appears saying "New input completed calculate now?". Click on Yes, and the drawing should appear quickly.
You can compare the results of this input process with the file DDRANE.STR in the SAMPLES
subfolder. If there are differences, you can print out the input parameters in either or both files
with the List Input command in the File menu (Listings sub-menu).
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-..BMP files
.EXP files
.INP files
.INS Files
.MOT files
.PCX files
.PNG files
.TIF files
.VBR files
.WRL files

55
35
29
30
36
55
55
55
36
60

-33D Display mode 125
3D files 60
3D Fog 115
3D General 113
3D Light Sources 114
3D Material Properties 115
3D Polyhedra 117

-AAbout command 158
Add/Revise Form 78
Align Face or Vector 143
American Mineralogist data file 35
Anaglyph drawing mode 126
Angle Labels 132
angles 84
angles - deleting 179
Atom and Bond Plot States 120
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atom data - temperature factor 85
atom identification 159
Atom Labels 130
Atom Parameter Files 164
atom parameters - defaults 183
atom revision - basic 87
atom revision - global 96
Atomic Vectors 97
atoms - deleting 179
Atoms - Global - Variables Tab 96
Atoms - Global - Which Atoms Tab 96
atoms - input 87
atoms - marking 134
Atoms (Input) 84
Atoms at Cursor 159
ATOMS Menus and Dialogs 23
axes - crystal or structure 62
axes - display 107

-BBackground Color 107
bitmap files 55
bitmap files - PICT 57
blank border (pen plot) 54
bond angles 84, 119
Bond Data 93
bond distances 84
Bond Labels 131
bond lengths 119
Bonds 93
bonds - deleting 179
bonds - generating from radii 94
Boundary - Enter Forms 77
Boundary - Locate Molecules in Crystal
81
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Boundary - None 80
Boundary - Slice 79
Boundary - Sphere 81
Boundary - Translation Limits
Boundary - Unit Cell 75
Boundary Option 74

81

-CCalculate Command 49
Calculation Output 119
Cartesian Symmetry 71
Cavities Display Mode 99
Cavity Parameters 99
CCDC FDAT File 29
center of fragment - reset 153
Centering/Displacement 120
central distance 169
central distance for individual atoms 86
CIF File 31
clay minerals 153
Clinographic Viewing 143
clinographic viewing - initial 117
Clinographic Viewing Command 134
Clipboard/PICT 57
Close Command (Graphics) 48
Close command (Text) 156
color - background 107
Color Command 130
Colors/Patterns/Pens 173
Command-Line Processing 194
Continuous Rotation 145
Coordinate Systems 175
Coordination of Atoms 84
Copy command 157
crystal axes - display 107

Crystal Edges and Faces 102
crystal edges and faces - drawing
Crystal Forms for Display 83
Current Orientation 144
Cursor Mode 129
custom symmetry 72
Cut command 157

181

-Ddarkest shade 106
darkness angle 106
Data Sets... in Import File 29
DBWS Rietveld File 32
Dealing with Molecules Groups and
Fragments in Crystals 177
default atom parameters 183
deleting (hiding) atoms 120
Deleting Atoms and Atom Labels 179
Dialog Bar - Fragments 138
Dialog Bar - Left 135
Dialog Bar - Right 137
diffraction - powder 139
diffraction - precession 140
Direct Postscript Output 53
displacement 120
displacements - unit cell 109
Display Menu 121
Display Mode Sub-Menu 122
Display of Crystal Axes 107
Display of Unit Cell 109
Drawing Crystal and Unit-cell Edges
181

-Eedges - crystal

83, 102
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edges (atom bond and polyhedron rims)
105
Edit menu commands 156
ELEMENTS Files 183
ellipsoid display mode 124
Ellipsoid Parameters 110
Encapusated PostScript (EPS) files 53
End of Mandatory Input 26
Entering New Data Set 26
EPS files 53
Exit command 61
Expand Layers 153
Export Atom Data (Molecular) File 48

-Fface - align on 143
faces - crystal 83, 102
fading - 3D drawing 115
fading - front-back 106
File Menu (Graphics) 45
File Menu (Startup) 24
File menu (Text Window) 155
File Types 185
fog - 3D drawing 115
font for text windows 154
forms - adding or revising 83
forms - boundary option 77
forms - crystal - for display 83
fragment - reset center 153
fragment - revision 151
fragment - rotate 152
fragment - translate 152
fragments - multiple 149
fragments in crystals 177
Frames 187
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Free-Form (.inp) File 29
FULLPROF File 35

-GGenerate Bonds 94
Generated Atom Data 159
Generated to Input 146
global atom revision 96
Graphics Window 22
Graphics Window Menu Bar
grid - scale 134
groups - locating or isolating
groups in crystals 177
Groups Located 149
GSAS (.EXP) files 35

44
147

-HHelp menu commands 158
hiding and restoring atoms 120
HPGL files 54
Hydrogen Bond Specifications 95

-IICSD File 32
Identifying (Picking) Atoms 158
illumination vector 106
Import File Button 136
Import File Dialog 27
import files - multiple data sets 29
Import Files Submenu 26
Initial Orientation 117
input atoms 87
input data - listing 53
input=generated 146
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Input1 Menu
Input2 Menu

61
101

-Llabels - atoms 130
labels - bond 131
labels - magnetic 70
lables - angle 132
lattice translations - disabling 77
LHPM Rietveld File 32
light sources - 3D drawing 114
Lighting Equation 188
line properties - 3D 113
Line Widths 105
List Input Data 53
Locate Groups 147

-MMagnetic Labels 70
margins - Macintosh 156
Mark Atoms 134
material properties - 3D 115
Metafiles 58
modes - vibrational 98
molecular files - exporting 48
molecules - locating or isolating 147
molecules in crystal boundary option 81
molecules in crystals 177
mouse - identifying atoms 159
mouse mode 129
movie - rotation 145
multiple data sets in import files 29
Multiple Structures 149

-NNBOND 110
NDASH 110
NDOT 110
New Command 25
NLINE 110
NPLANE 110

-Ooffset - slice 79, 86
Open command 47
orientation - initial 117
ORTEP display mode 124
ORTEP file 34
ORTEP parameters 110
output - calculation 119

-PPage Setup dialog box 37, 156
Palette 44
Paste command 157
patterns 173
PDB Files 34
pen numbers 173
Pen Plot 54
Pen Plotter Settings 41
Pen-Plotter Commands and Parameters
42
Perspective 103
picking atoms 159
PICT files 57
plot codes 159
plot states - atoms and bonds 120
Point-Group Symmetry 71
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Polyhedra 89
polyhedra properties - 3D 117
Polyhedron Data 91
polymers - isolating 147
PostScript files 53
Postscript printing 53
PostScript Settings 40
PostScript Transfer Function 41
PostScript typefaces - standard 193
POV-Ray File Output 60
Powder Diffraction 139
Powder Diffractogram Window 22
Precession Pattern 140
Precession Pattern Window 22
Preferences - Constants Tab 39
Preferences - Operation Tab 37
Print command (Text) 156
Print Graphics Image 49
Protein Attributes of Atom 163
Protein Data Bank (PDB) files 34

-QQuit command

61

-RRaster (Bitmap) Files 55
Read Structure Fragment from File 150
Remove Rotations 144
Replot Command 129
Reset Rotation Center of Fragment 153
Revise Atom - Basic Tab 87
Revise Atom - Central Distances Tab
86
Revise Atom - Slice Offset Tab 86
Revise Atom - Vector Tab 86
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Revise Structure Fragment 151
Rims 105
Rotate on Cartesian Axes 142
Rotate on Structure Vector 142
Rotate Structure Fragment 152
rotation - continuous 145
rotation - initial 117
rotation - stereopair 143
Rotation Menu (Graphics Window)
Rotation Movie 145
rotations - removing 144
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-SSave As command (Graphics) 47
Save As command (Text) 155
Save command (Graphics) 47
Save command (Text) 155
Save Defaults Command 44
Save Graphics Window 59
SCAL2 110
Scale Grid 134
Scaling 118
screen preview - PostScript 40
screen shot 59
Select Color 164
Settings Menu (Graphics Window) 37,
154
shades - input 173
Shading 106
SHELX .INS Files 30
Shubnikov settings 66
Skeletal Display Mode 123
slice boundary option 79
slice offset - individual atom 86
Space-Group Symmetry - Basic Tab 63
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Space-Group Symmetry - Shubnikov Tab
66
sphere boundary option 81
Standard Display Mode 123
Standard PostScript Typefaces 193
Starting ATOMS - Command-Line
Processing 194
Startup Menu Bar 24
Startup Window 21
Stereopair Rotation 143
Stereopairs 104
structure axes 62
structure fragment - resent center 153
structure fragment - revision 151
structure fragment - rotate 152
structure fragment - translate 152
structure fragments - multiple 149
Symmetry 63
Symmetry - Cartesian 71
Symmetry - Custom 72
Symmetry - Point Group 71
Symmetry - Space Group 63
systematic absences 79

-TTAPER 110
Temperature Factor Tab 85
Text Window 23
Text Window Menu Bar 154
text windows - font 154
Thermal Ellipsoid Display Mode 124
thickness - slice 79
Title/Axes 62
transfer function - PostScript 41

Transform Menu (Graphics Window)
146
Translate Structure Fragment 152
translation limits boundary option 81
Types of Windows 20

-UUndo command 157
unit-cell - drawing 181
unit-cell boundary option 75
Unit-Cell Displacements 109

-Vvector - align on 143
vector - illumination 106
vectors - Individual atoms 86
VIBRAT (.MOT or .VBR) files
Vibrational Modes 98
video - rotation 145
VRML Files 60

36

-WWindow menu 154
windows - types 20
Windows metafiles 58

-XXTLVIEW file

34

-Zzones - shading

106
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